Step-by-Step Tutorials

- A

o

-
>

~

’

A M A

et o -_q.,_ Q; _
p A VRO

It’s time to jump into the database fast lane! By the time you finish the lessons in this tutorial you’ll have a
solid foundation in the basic techniques you’ll need to use Panorama effectively.

This tutorial is divided into three lessons. Each lesson builds on the previous lessons and introduces more
advanced topics. In “Lesson 1: Building Your First Mailing List Database” on page 2 you’ll learn how to cre-
ate and set up a simple mailing list database. In “Lesson 2: Building and Organizing a Checkbook™ on
page 82 you’ll not only build a simple checkbook register file but also learn several techniques for organizing
and summarizing the checkbook data. In “Lesson 3: Building an Invoice Database” on page 169 you’ll create
a simple invoice for creating and tracking orders. Finally, in “Lesson 4: Building a Price List” on page 186
you’ll create a price list and link it to the invoice database. Each lesson should take from 30 minutes to an
hour to complete. The lessons are designed so you can easily follow along and actually build each database as
you read. There are plenty of illustrations to show what the screen will look like at each step, so you don't
need to worry about getting lost.

Before you begin, you’ll need to install Panorama on your computer. If you haven’t done so already, see
“Installing the Software” on page 97. It’s not necessary to activate Panorama to complete the operations in
this tutorial. If you haven’t purchased Panorama yet you can try out the tutorials before you decide that you
want to purchase Panorama (see “Using Panorama’s “Demo Mode””” on page 113).

| hear the bell—class is about to begin. It’s time to get started with your new Panorama career! | hope you
have as much fun learning Panorama as we had creating it for you.

Sincerely,

Jim Rea, President

P.S. This tutorial teaches you how to work with Panorama. It assumes, however, you already are familiar with
your computer and operating system. You should be able to point, click, and drag selections, and be able to
make selections from menus, use scroll bars, and edit text. If you are not familiar with these skills, you should
review the tutorial information supplied with your computer.
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Lesson 1: Building Your First Mailing List Database

A mailing list for storing names and addresses is one of the most basic database applications, and is very sim-
ple to create with Panorama. Start by launching Panorama and the New Database Wizard.
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On Windows systems you can do this with the Start menu.
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Your new mailing list database will have seven fields — First, Last, Address, City, State, Zip and Phone. (See
“Fields” on page 375 for a complete explanation of fields.) Type in the name of each field into the wizard,
with each name on a separate line (press the Return key to advance to the next line).

e6o

New Database Wizard

Fields

Notes/Instructions

/mLine Itern () Fields: :]

First
Last
Address
Clity
State
Zip
Phone

type in field names

( Import Text File... )

N
A
v
Make New Database )

New Database Wizard

To create a new database, simply enter the names of the fields you want to creats
in the box to the left, one field per line. You can start with the blank form shown
here, or start by selecting a pre-built template from Template menu (at the top
of this window). After the fields names are entered press the Make New
Database button.

Importing a TextFile

To create a new database from a tab or comma delimited text file, press the
Import Text File button and select the file. The first line of the file will appear
in the box to the left - one field per line. If the first line of the text file contains
the field names, just press the Make New Database button to create the
database and import the data. If the first line contains data, simply replace each
data item with the name you want to use for the field. Don't add or remove any
lines. You can also add suffixes for numeric fields, default values and calculations
(see below).

Adjusting Field Widths

then press this button to create the database

When you press the Make New Database button the wizard will create a new database for you. The database
Is displayed using a row and column format called the data sheet. The new database contains one blank
record (line) and seven fields (columns).

@06 Untitled
Address City State Zip Phone 12
v
4
v
1 visible/1 total || «/» Jair
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Entering Data Into Your New Database

The new database is ready to use immediately — you can just start typing to enter data. For example, to enter
the name Bob simply start by pressing the key. A small pop-up window will appear over the current cell.
This pop-up window is called the Input Box and is used for all data entry in the data sheet(see “The Input
Box” on page 438).

OE8 XS Untitled

First Last Address City State Zip Phone £

Complete the entry of the name by pressing [2][2]. Notice that Panorama automatically capitalized the first
letter of the name. We’ll show you how to turn this feature on and off later (see “Automatic Capitalization™
on page 447 if you can’t wait).

~Yara Untitled

Address City State Zip Phone

When you’ve finished with the first name press the Tab key to move on to the last name.

™ OO Untitled

First Last Address City State Zip Phone

Bob || | m

Continue typing and pressing the Tab key until you get to the phone number. When you tab into the Phone
field you’ll notice that Panorama automatically types in the ( for you.

Untitled
City State Zip Phone

1414 Rimrock Road MY

Las Yegas
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The New Database Wizard has set up an Input Pattern to make typing the phone number easier (see “Input

Patterns” on page 455). All you have to type is the numbers, for example [Z] o] 21« ][] =] 2] E]. Pan-

orama will type in the punctuation for you.

& OO Untitled

Address City State Zip Phone 1

1414 Rimrock Road Las Vegas NV 89104 |(702) 487-902 m

Panorama types in (, ), space and - for you

Once you’ve finished entering the phone number you have a choice to make. Press the Tab key if you want to
add another line and continue editing data.

® 00 Untitled
.| First Last Address City State Zip Phone £
v
a=| Bob Smith 1414 Rimrock Road  Las Vegas NV~ 89104 (702) 487-90:

Press Return or Enter if you are done with data entry for the moment.

®0 6 Untitled |
Address City State Zip Phone 14

v

1414 Rimrock Road Las Vegas NV 89104 [WeAElrgclors -

Making Corrections

It’s easy to change the contents of any cell. Start by double clicking on the cell. This opens the Input Box,
allowing you to type in a new value or to make corrections.

Untitled
Address City State Zip Phone £

rock Road

Las Vegas NV B9104 (702) 487-9023 m

double click to edit cell

Press the Enter key or click on another cell when you are finished. (You can also press the Tab key if you want
to skip to next cell and edit it too.)
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Editing a Multi-Line Cell

If you need more room to enter your data, you can expand the size of the Input Box. For example, you might
need to expand the Input Box to enter an address with more than one line. To expand the Input Box, move the
arrow to the lower right hand corner of the box. When the mouse reaches the corner, the arrow will flip over
so that it is pointed down instead of up.

™ O N Untitled

Last Address City State Zip Phone 12

Smith | 1414 Rimrock Road Las Vegas NV B9104 (702) 487-9023 m

mouse “flips over” in lower right hand corner

When you see the arrow flip over, press the mouse and drag the corner of the box to the size you want.

® OO Untitled
Address City State Zip Phone |12

1414 Rimrock Rodd as NV B9104 (702) 487-9023 m

When you release the mouse the Input Box will expand to the new size.

OESEA) Untitled

Address City State Zip Phone 15

1414 Rimrock Road “is NV B9104 (702) 487-9023 01

Now that the Input Box has been expanded you can use the Return key to add additional lines to the data
cell. You can add as many lines as you like.

™ OO Untitled

Address City State Zip Phone 15

v

(1414 Rimrock Road “Bs NV 89104 (702) 487-9023 m
Apt 4-§




When you are finished editing the address press the Enter key. The Input Box closes and now you can only
see the first line of the data. (If you want to see more than one line of data in a cell that is not being edited you
must use a form, see “Displaying and Editing Text” on page 715).

®@0 6 Untitled
Last Address City State Zip Phone 12
)
Smith 1414 Rimrock Road Las Vegas NV B9104 (702) 487-9023 m

only first line of text is visible in data sheet
If you double click to edit the data cell again Panorama will remember the new size of the Input Box.

Untitled
Address City State Zip Phone 15

[14714 Rimrock Road “bs NV B9104 (702) 487-9023 0
Apt 4-G

You can adjust the size of the Input Box any time it is open.

™ OO Untitled

24| Last Address City State Zip Phone 14
m v

oc| Smith [1474 Rimrock Road  |Las Vegas NV  B9104 (702) 487-9023 0
Apt 4-G
L&)

.
— .
.
.
.
— .
: .~

If the Input Box is less than one inch high it won’t have a scroll bar.

® 00 Untitled
Last Address City State Zip Phone 1£
v
Smith | 1414 Rimrock Road | Las Vegas NV B9104 (702) 487-9023 m
Apt 4-G
o

To learn more about expanding the Input Box see “Expanding the Input Box™ on page 439
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Saving Your Work

To permanently store your new database choose the Save command from the File menu. Using the dialog,
choose the folder you want to save the database in. Type in the name of the file and check the Save Window
Positions option (see “Saving Window Positions” on page 260). When everything is set up press the Save but-
ton.

type in name of file select folder you want to save file in

\ —

Save As: My Mailing List /

' < Pj fﬁ-‘ I]]]j fu Tutorial M

@ Network |4 |y Date Modified
=4 Jaguar 2
=4 Classic

=i Panther

=) Alaska

L\ Fire Jaguar

£Z\ Fire Panther

L1 Fire Classic

£l Fire Alaska
__iSightWeb ... &
_| CocoaGest... &

[ Desktop

| Operations

A Applications -
4 jimrea = ’.

s Narumantc

>
I

@ Panorama () Text Only ( Set

1 Automatic save after 20  minutes
| Keep backup copy (.b) of database
W Save window positions __ No windows

(' New Folder ) ( Cancel ) - Save )
%4

tell Panorama to save window positions
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If you are using a Windows PC the dialog looks a little bit different but the procedure is exactly the same.

select folder you want to save file in

Save As
Save in: QISBASICSAMPLEFILES LI gl gze-

Chart of Accounts.pan a Payables.pan
Checkbook.pan

E stimates.pan

Expense Log.pan

Flow Chart.pan

FormSize.pan

Type in name of file

/

Save as type: |Panorama Database File {*. pan} ﬂ Cancel I

File name: My New Database Save I

[ Automatic save after W minutes
[~ Keep backup [.bak) copy of database

IQVB ‘Window Positions [~ No windows

tell Panorama to save window positions

After the file is saved the name of the window will change from Untitled to the name of the file, in this case
My Mailing List.

e o6 My Mailing List
;] gl Last Address City State Zip Phone

Smith (1414 Rimrock Road  JEEERYENEE NV B9104 (702) 487-9023 m

lpf

1 visible/1 total | «i» (=) sy
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Importing Data Into the Mailing List

Panorama Handbook

If you already have data in another program (FileMaker, Access, Excel,etc.) you can transfer that data to Pan-
orama by exporting it into a text file (tab or comma delimited) and then importing it into Panorama. Pan-
orama includes some text files with sample data, so we’ll import one of those files now. Start by choosing Text
Import Wizard from the Utilities submenu of the Wizards menu. The wizard opens and lists the fields in your
database on the right hand side.

name of database data will be imported into

e on Text Import\(/izard
Text File D*base File Options
My Mailing List # Append [ Replace

Field 4> Sample Data Formula Sample Data

«bB»

e

w3
| ¢, |

fields in database
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The next step is to select the text file that contains the data to be imported. Choose Select Text File from the
Import menu. Then locate the 200 Sample People.txt file in the Utilities folder and press the Choose or Open
button.

Choose a File

(«/»] [Elm) [ Utilities 4
- Network If | Date Modified |
= Jaguar v =) 2k Sample People.txt 10/21/00
& Classic B 200 sauple People.txt 10/21/00
= Panther @] Arrange Windows 11/8/02

=4 Alaska ‘a] Disk Permissions 7/14/04

L\ Fire Jaguar @ Open Database 7/30/04
&l Fire Panther @) Platform Converter 712104
 Efl Fire Classic ®| Summary & Outline Wizard 11/8/02
‘ ig F're Alaska ” ’i] Text Export Wizard 5/29/04

s'-' iSightWeb ... & '@ Text Import Wizard 7{30/04
| LJ Cocoatest... & il VCard Wizard 6/18/04
| {3 Desktop
|3 Operations
- 4A Applications
- jimrea |

'y Documents 4
& Movies |y

( New Folder ) ( Cancel ) € €hoose )
¥
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Once the file is selected the wizard will display the fields in the first line of the text file. The text file contains
15 fields, including name, address, phone, fax, email and birthday (not shown).

/ name of text file being imported

e o N Text Import Wizard
Text Eile Database File Options
200 Sample’People.txt My Mailing List # Append [ Replace
Field > Sample Data Field Formula Sample Data

wln R
Lyl Barbara

W3

= X
o) r
- Q
-+ n
T -+

ZEHE Mo ldenhauer

(3 C 10

Memphis Consultants Inc
(= 155 Elm Ter
Canandaigua

W

AREY 14425

(716) 848-5619

(716) 840-2322
barbara389fcreative.net
s

| \ 7

—

first line of data in text file

™~
o

Before you can import the data you must assign the fields in the text file to fields in the database. Start by
dragging Barbara to the First field.

e o n Text Import Wizard
Text File Database File Options
200 Sample People txt My Mailing List # Append [ Replace
Field 4> Sample Data Formula Sample Data

s.
Lyl Barbara

(333

:

LN Mo ldenhauer

When you release the mouse the wizard will assign the second field from the text file to the First field.

e OO Text Import Wizard
Text File Database File Options
200 Sample People txt My Mailing List @ Append () Replace
Field > Sample Data ormula Sample Data
AN Ms. 4 @ Barbara
Lyl Barbara ) §
M e E—

second field of text file assigned
to this database field
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Drag each of the text fields you want to import onto the corresponding database field. You can check your
work by looking at the Sample Data column.

8e6o0o

Text Import Wizard

Text File
200 Sample People txt

Database File
My Mailing List

Options
# Append (| Replace

Field 4> Sample Data Formula Sample Data
Ms. . 29 Barbara

8 Earbara - v ast wdn Mo ldenhauer
o DA 155 Elm Ter

RN Mo ldenhauer - ¥ " « O Canandaigua

«S» : «]B@» NY

«Br Al RSP wl1n 14425
Memphis Consultants ine |-’ «12n {716} 848-5619

PRy 155 Elm Ter <
Canandaigua -° .-
e
GAREN 14425 0
{?16) 848-5619 -~
{716) 848-2322
barbara389fcreative .net
L

.

v

IF.‘est in the database the fext is being imporied into. Drag ilems from the lefl fo assign impord fields o database fields. l Y

Once all of the fields are set up choose Import Data from the Import menu.

File Edit Database Templates Special Wizards
e O Select Text File...

Import Wizard
LN 'ga.ga\ba'-se ‘E'i"?-u v

200 Sampl My Mailing List
o< . Formua S
» M_s. W2 __B_ar‘bara_
@ Barbara e Mo Ldenhau

The wizard will import the data from the text file into the database.

¥

Imported 200 records from 200 Sample

People.txt.

o)




Panorama Handbook

Your database now contains 201 records — the single record you typed in plus the 200 records imported by
the Text Import Wizard. The total number of records is displayed in the lower left hand corner of the window.

® O 6 My Mailing List
Lo First Last Address City State Zip Phone 2
taa 3
Moldenhauer 155 Elm Ter Canandaigua NY 14425 (716) B40-56°
| ' Karen Bryant 3595 E S5Th Blvd. Garden City GA 31408 (912) 52B-06¢
—- Deborah  Waolf B503 E. Glenbrook Ave Eureka CA 85503 (707) 448B-96;
Timonthy Dobbins 639 E Clayton Ln Jenison Ml 49428 (616) B33-51:
201 Kelly Gage 677 S. Charlotte Lane Bloomfield NJ 07003 (201) 947-64°
_* | Marilyn Pratt 34423 E. Hunt Rt Montrose NY 10548 (914) 810-70¢
Theresa  Tracy 777 W Stewart Way  Sargent Bluff A S1054 (712) S47-56°
i Charles Lowe 938 West Laura Trail Winter Park FL 32793 (407) S44-B7«
1 Michelle Stern 10773 E. Pioneer Dr  Cincinnati OH 45207 (513) 407-55¢
| Kathy Root 32104 S 18Th Pkwy St George urt B4770 (BO1) 61 1—922';
| George McMahon 720 S.E. Florence Ter Brooklyn NY 11204 (718) 488-57: 3
= T T NOTANS S AAL P M- oy = i “Ara A (A mrsm mare
201 visiberz0t total ) [] « > €9 NI

total number of records in the entire database

Before you go any further you should use the Save command (in the File menu) to save the new data in the
database. Since you have already saved this file once and given it a name, Panorama will quickly save the file
without asking you for the name and location again.

Since we’re done with the Text Import Wizard for the moment, click on it’'s window to bring it forward and
then close the window.

Q e N Text Import Wizard
w— Y
Text File Database File Options
200 Sample People . txt My Mailing List # Append [ Replace

To learn more about the Text Import Wizard see “Using the Text Import Wizard” on page 285.

Adjusting Column Widths, Font and Size

To adjust the width of a column in the data sheet move the mouse anywhere over the column name. When
the mouse is over the name it will turn into a double left/right arrow.

mouse turns into double left/right arrow

® O 6 My Mailing List
| First Last Address City State Zip Phone £
v
Moldenhauer 155 Elm Ter Canandaigua NY 14425 (716) B40-56°
Karen Bryant 3585 E 5Th Blvd. Garden City GA 31408 (912) S2B-06:
Deborah Wolf 8503 E. Glenbrook Ave Eureka CA 95503 (707) 44B-96.
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To adjust the column width press and drag to the left or right.

e O 6 My Mailing List
| First tast  ----- Address - - B> City State Zip Phone r
o : v
| Barbara g’\doldenhauer 155 Elm Ter Canandaigua NY 14425 (716) B40-56
— Karen 3ryant 3595 E STh Blvd. Garden City GA 31408 (912) 52B-06¢
— | Deborah ?Volf B503 E. Glenbrook Ave Eureka CA 85503 (707) 448-96;
=4 Timonthy Dobbins 639 E Clayton Ln Jenison Ml 49428 (616) B33-51:
—| Kelly 5age 677 S. Charlotte Lane Bloomfield NJ 07003 (201) 947-64°
| Marilyn dratt 34423 E. Hunt Rt Montrose NY 10548 (914) B10-70¢
Theresa  Tracy 777 W Stewart Way:  Sargent Bluff A S1054 (712) S47-56°
Charles Lowe 938 West Laura Trzil Winter Park FL 32793 (407) S44-87«
Michelle $tern 10773 E. Pioneer Dr. Cincinnati OH 45207 (513) 407-55¢
Kathy Root 32104 S 18Th Pkwy St George urt B4770 (BO1) 61 1-922‘;
George g\chahon 720 S.E. Florence Tvr Brooklyn NY 11204 (718) 488-577
201 visible/201 total = - AARISRRRTT

When you release the mouse the column width will be adjusted.

Q O 6 My Mailing List
| First Last Address City State | Zi 4
» v
Barbara 155 Eim Ter Canandaigua NY 1@
Karen Bryant 3595 E STh Blvd. Garden City GA 3
— | Deborah  Waolf 8503 E. Glenbrook Ave Eureka CA :
=4 Timonthy Dobbins 639 E Clayton Ln Jenison Mi 4%
—| Kelly Gage 677 S. Charlotte Lane Bloomfield NJ o
| Marilyn Pratt 34423 E. Hunt Rt Montrose NY 1¢
Theresa  Tracy 777 W Stewart Way  Sargent Bluff A S
Charles Lowe 938 West Laura Trail Winter Park FL 3¢
Michelle stern 10773 E. Pioneer Dr  Cincinnati OH 4%
Kathy Root 32104 S 18Th Pkwy St George uTt B<,
George McMahon 720 S.E. Florence Ter Brooklyn NY L e
201 visibles201 total [ 4 » cemRe s Rm TR i e IS

You can use this technique to adjust the widths of as many columns as you like (see “Changing the Width of
a Field” on page 379).

e O 6 My Mailing List |
Last Address City State Zip Phone s 4
v
Moldenhauer 155 Elm Ter Canandaigua NY 14425 JIYRICIR:EIo=1ER0e) m
Bryant 3595 E 5Th Blvd. Garden City GA 31408 (912) 52B-0659
Wolf 8503 E. Glenbrook Ave Eureka CA 95503 (707) 44B-9673
Dobbins 639 E Clayton Ln Jenison MI 49428 (616) B33-5134
Gage 677 S. Charlotte Lane Bloomfield NJ 07003 (201) 947-6456
Pratt 34423 E. Hunt Rt Montrose NY 10548 (914) B810-7069
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Use the Text menu to change the font and size of the text displayed in the data sheet.

Fields IEI Search Sort Math Setup Wizards

Font

Bryant
Wolf
Dobbins
Gage
Pratt
Tracy
Lowe
Stern
Root
McMahon

o Lol

10773 E.
32104 S

sible /201 total

T TS TN et e | e

State Zip
daigua NY  14¢
nCity GA 31¢

CA 95t

MI 49¢
field NJ  0O7C
DSe NY 10t
t Bluff A S1¢C
FPark FL 327
ati OH  45¢
rge Ut B47
yn NY 11z

~ar

When you change the size of the text Panorama changes with width of each column proportionally, so that
you do not need to adjust the widths of the columns.

My Mailing List

06

| First

] Barbara
2= | Karen
1 Deborah
.| Timonthy
| Kelly
1 Marilyn
Theresa
Charles
Michelle
Kathy
George
Anthony
Judith
Robert
Alfred

Last

Moldenhauer
Bryant
Wolf
Dobbins
Gage
Pratt
Tracy
Lowe
Stern
Root
McMahon
Goldman
Lerner
Nielsen
Coats

Address

155 Elm Ter
2595 E STh Blvd.

8503 E. Glenbrook Ave

639 E Clayton Ln

677 S. Charlotte Lane

34423 E. Hunt Rt

TIT W Stewart Way
938 West Laura Trail
10773 E. Pioneer Dr
32104 S 18Th Pkwy
T20 SE. Florence Ter
29710 5N Bay Place

City

Canandaigua
Garden City
Eureka
Jenison
Bloomfield
Montrose
Sargent Bluff
Winter Park
Cincinnati
St George
Brooklyn
Pensacola

S966 W Millwood Stree Beaumont

565 N Capital Ln

802 N Jackson Lane
| Edward  Kramer 44944 SE, Beacon Ave Corvallis
201 visible /201 total

N I B RE

De Leon
YWest Islip

State Zip

NY 14425
GA 31408
CA 95503
Ml 49428
NJ 07003
NY 10548
14 51054
FL 32793
OH 45207
ut 84770
NY 11204
FL 32514
T 77704
TX 76444
NY 11795
OR 97333

Phone

[(716) 840-5619

(912) 528-0659
(707) 448-9673
(616) 833-5134
(201) 947-6456
(914) 810-7069
(712) 547-5613
(407) 544-8747
(513) 407-5547
(801) 611-9225
(718) 488-9771
(904) 968-3152
(409) 875-3648
(817) 419-0219
(516) 707-3192

(541) 912-7577

Use the Save command (File menu) to save the new configuration.

>
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Sorting the Database

Now that the database is filled with sample data you can try out Panorama’s commands for organizing data.

To sort by zip code start by clicking anywhere in the Zip column.

® O 6 My Mailing List
! First Last Address City State Zip Phone | A
v

Barbara Moldenhauer 155 Elm Ter Canandaigua  NY 14425 (716) 840-5619 .
Karen Bryant 3595 E STh Blvd. Garden City GA 31408 (912) 528-0659 m'
Deborah Wolf 8503 E. Glenbrook Ave Eureka CA 95503 (707) 448-9673
Timonthy  Dobbins 639 E Clayton Ln Jenison Ml 49428 (616) 833-51324
Kelly Gage 677 S. Charlotte Lane  Bloomfield N [EAEEE (201) 947-6456
Marilyn Pratt 34423 E. Hunt Rt Montrose NY 105 (914) 810-7069
Theresa Tracy TI7 W Stewart Way Sargent Bluff |4 S10 (712) 547-5613

click anywhere in this column

Now choose Sort Up from the Sort menu.

File Edit View Fields Text Searchi Math Setup Wizards

© 6

A Sort Up

| First

@

w=u| Barbara
Karen
Deborah
Tirmonthy
& | Kelly

1 Marilyn
Theresa
Ly | Charles
=1 Michelle
Kathy
George
| Anthony
! Judith
| Robert
, Alfred
| Edward
_ Betty
; Ronald
! Marilyn
l Gerald
Alan
Rhonda
Albert

| | 9

Last
"‘Mdl&éﬁhauer i 155 Elm ;l;er

Bryant
Waolf
Dobbins
Gage
Pratt
Tracy
Lowe
Stern
Root

McMahon
Goldman

Lerner
Nielsen
Coats
Kramer
Curry
Kuhn
Holmes
Palmer
Hoflin
Barr
Ireland

| I

Address

3595 E STh Blvd,
8503 E. Glenbrook
639 E Clayton Ln
677 S. Charlotte L
34423 E. Hunt Rt
TI7 W Stewart Way
938 West Laura Trz
10773 E. Pioneer Dt
32104 S 18Th Pkw
720 SE.Florence T
29710 S.W Bay Plat
5966 W Millwood S
S65 N Capital Ln
808 N Jackson Lan
44944 S E. Beacon
120 8. Hall Street
11753 E Timber Rd
342 W Stuart Cir
259 E. Baker P|
427 E Poplar Ln
285 S, Custer Cir
&90 N. Clarendon Dy

A4 :.,l-

201 visible /201 total

[l <i»(

2 U

Sort Up Within :

Sort Down
Sort Down Within

Group Up
Group Down
Group

Sort by Color
Group by Color

Qutline Level...

Remove Summaries...
Remove Detail...

Toggle Summary Level

PR
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Panorama will sort the database as soon as you release the mouse. Notice that the zip code you originally
clicked on is still highlighted. If you want to see the first zip code you’ll need to use the vertical scroll bar to
move to the top of the database.

®O6 My Mailing List
Lo | First Last Address City State Zip Phone a
)| Ronald Kuhn 11753 E Timber Rd. Eastport ME 04631 | (207) 339-1356 :
Kristin McFarland 3010 North Au Place  Waterbury VT 0S676 | (802) 624-7185
Nicole ‘Weber 7340 S. Harvey St. Yindham CT 06280 | (203) S00-8620 m
Gerald Gilman 476 N.%. Clinton Pkwy MNorwalk CT 06851 | (203) 735-5038 '
Kelly Gage 677 S. Charlotte Lane  Bloomfield NJ (201) 947-6456
YWilliarm Mester 869 E Kellogg Ln Orangs NJ 07050 | (201) 790-8724
Henry Nichalson 21929 E Emerald Place Newark NJ 07105 | (201) 276-9221
Phyllis Wagner 23091 SE. American P Paterson NJ 07509 | (201) 248-6513
1 Janice Lebaily 851 NE, Linwood Ln Palisades Park NJ 07650 | (201) 631-5593
Grace Day 2421 North Rock Pkwy Fair Haven NJ 07704 | (201) 960-9540
Joseph Hartley 41730 % Bethany Blvd Colts Neck NJ 07722 | (208) 726-1158
Herbert Schob 7658 S Cove Rd Sea Bright NJ 07760 | (201) 738-8741
Harold Swan 656 North Beverly Looj Sea Grit NJ 08750 | (201) 248-7440
Marilyn Connors 6955 South Industrial ¢ New York MY 10027 | (212) 496-7932
Brian Robbins 610 E. 7Th Ter Staten Island NY 10312 | (718) S70-2020
Ralph Waldron 415 N Belmont Way Bronx MY 10458 | (212) 966-8160
Marilyn Pratt 34423 E. Hunt Rt Montrose NY 10548 | (914) 810-7069
Phyllis Bengston 366 SE, Trenton Dy, DOssining MY 10562 | (212) 517-3722
Douglas Ponce 43131 M. 33Rd Ave Pound Ridge NY 10576 | (914) 611-3249
George McMahon 720 SE.Florence Ter Brooklyn MY 11204 | (718) 488-9771
Fred Albrecht 146 % Sutton Loop Merrick NY 11566 | (516) 636-0746 s
Carl Mackay 35079 MNorth Duncan St Sea Cliff MY 11579 (S16) 629-1468 R
Evelyn Oliver 40214 W Lamar Apt YWoodrnere NY 11598 7 (516) 901-9831 v
! OO B! laatiman | o= L SRS G P L 14920 ‘ N WO TAAN
if </ »>¢ /

Sorting By Two or More Fields

You can sort by as many fields as you like. In this example you will sort by cities within states. The first step
Is to sort by states. To do this click anywhere in the State field and choose Sort Up from the Sort menu.

® O 6 My Mailing List
I | First Last Address City State Zip Phone |4
& ¢ v
m Ronald Kuhn 11753 E Timber Rd.  Eastport ME 04631 (207) 339-1356 -
Kristin McFarland 3010 North AuPlace  ‘Waterbury VT 05676 (302)624-7185
1 Nicole Weber 7240 S. Harvey St. Windhamn 06280 (203) S00-8620 m
| Gerald Gilman 476 N.W. Clinton Pkwy MNorwalk CT A 06851 (203) 735-5038
Kelly Gage 677 S. Charlotte Lane Bloomfield NJ | 07002 (201) 947-6456
= William Mester 869 E Kellogg Ln Orange NJ | 07050 (201) 790-8724

click anywhere in State field...  then Sort Up
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Now the database is sorted by state, but the cities within each state are still out of order. For example, Hialeah
should be the first state within Florida (FL) and Atlanta should be the first city within Georgia (GA).

® OO My Mailing List
| First Last Address City State Zip Phone £
| Kathleen  Bills 7930 E. Brown 5t Colusa CA 95932 (216)582-2423 Z
W= | Christine  Benjamin 601 W Chester Lane  Grand Lake CO_ 80447 (970) 823-0165
1 Nicole “Weber 7340 S. Harvey St. Yindham 06280 (203) S00-8620
Gerald Gilman 476 N.W. Clinton Pkwy Norwalk CT 06851 (203) 735-5038
. Margaret Poulsen 9144 W, Dupont Rd YWashington DC 20010 (202) 908-7836
= Pamela “Walsh 313 East Bryant Cir.  Newark DE 19702 (203) 951-1493 mP
Jerome Frank 551 N. 42Nd Ct Mewark DE 19713 (302) 633-7506
| Christina Gutierrez 45151 §. Marion Ave Saint Augustine FL 32084 (904) 954-2188
= Anthony Goldman 29710 S Bay Place  Pensacola FL 32514 (904) 968-3152
Bewverly Reilly 464 S E. Jones Cir, Reddick FL 22686 (352) 888-4646
Charles Lowe 938 West Laura Trail Winter Park FL 32793  (407) 544-3747
Doris cawistowsky 4893 North Smith Stre Orlando FL 22861 (407) 865-4111
Lenoard Byrd 574 S. Lakeview Circle Melbourne FL 22904 (407) 255-1502
Allen Reese 24328 North Camden S Hialeah FL 23015 (305) 792-9606
Theresa  Dunn 7425 N.W. Warner Ave Miami FL 33151 (305)616-2883
Deborah  Ragsdale 113 ErieLn Miami FL 33152 (809)212-0788
Anna McKinney 876 East Johnson Ln Lakeland FL 33809 (813) 934-4566
Catherine Maclean 536 North Manning Dr. Ocala FL 24422 (904) 803-3997
Eleanor Carlson 201 East Clark Trail  Lithoma GA 30058 (404) 760-6826
Daniel Mason 6086 M.E. Augusta Apt Tucker GA 30024 (404) 724-6523
Craig Berlin 8727 N Bristol Ave Atlanta GA 30309 (404) 765-2383 -
Karen Bryant Z595 E STh Blvd, Garden City GA 314028 (912) 528-0659 N
Andrew Ackerman 899 E, Deer Cir Waipahu HI 96797 (808) 557-7523 v
Th . A A amanh Ad, Derama A PLES A =4 A (40N EAD Eq4™
201 visible/201 total || « ' » ¢ é )y

To sort the cities within the states first click anywhere in the City field, then choose Sort Up Within from the
Sort menu. Be sure to choose Sort Up Within, not Sort Up.

® O 6 My Mailing List
First Last Address City State Zip Phone _ ‘
v
Kathleen  Bills 7930 E. Brown St Colusa CA 95932 (916) 582-2423 .
Christine  Benjamin 601 W Chester Lane Grand Lake CO 80447 (970)323-0165
Nicole Weber 7340 S. Harvey St. +] CT 06280 (203)500-8620
Gerald Gilman 476 N.Y. Clinton Pkwy Norwa CT 06851 (203) 735-5033

Margaret  Poulsen 9144 % . Dupont Rd Washington DC 20010 (202) 908-7836 ~

click anywhere in the City field...  then Sort Up Within
1

Sort Up #EU

Sort Down
Sort Down Within
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The database is still sorted by state, but now the cities are sorted within each state as well.

®O6 My Mailing List
L | First Last Address City State Zip Phone - [
==uw| Christine Benjamin 601 W Chester Lane  Grand Lake CO 80447 (370)823-0165 b4
Gerald Gilman 476 N.W. Clinton Pkwy Norwalk T 06851 (203) 735-5038
Nicaole ‘Weber 7340 S. Harvey St. CT 06280 (203)S00-8620
Margaret  Poulsen 9144 W, Dupont Rd “Washington DC 20010 (202) 908-7336
Pamela YWalsh 313 East Bryant Cir.  Newark %E 19702 (908) 951-1493
1 Jerome Frank 551 N. 42Nd Ct Newark E 19713 (302) 633-7506 m
Allen Reese 24328 North Camden S Hialeah FL 33015 (305) 792-9606
Anna McKinney 876 East JohnsonLn  Lakeland FL 33809 (213) 934-4566
= Lenoard Byrd 574 S. Lakeview Circle Melbourne FL 32904 (407) 255-1502
Theresa Dunn T425 NN, Warner Ave Miami FL 33151 (305) 616-2883
Deborah Ragsdale 113 Erie Ln Miami FL 33152 (809) 812-0738
Catherine Maclean 536 North Manning Dr. Ocala FL 34432 (904) 803-3997
Doris Zawistowsky 4893 North Smith Stre Orlando FL 32861 (407) 865-4111
anthony  Goldman 297105 Bay Place Pensacola FL 22514 (904) 968-3152
Beverly Reilly 464 S.E. Jones Cir, Reddick FL 32686 (352) 883-4646
Christina  Gutierrez 45151 §. Marion &ve Saint AugustingFL 22024 (904) 954-2188
Charles Lowe 938 West Laura Trail  Winter Park  VFL 32793 (407) 544-3747
Craig Berlin 8727 N Bristol Ave Atlanta GA 30309 (404) 765-2383
. Karen Bryant 3595 E STh Blvd. Garden City GA 31408 (212) 528-0659
Eleanor Carlson 201 East Clark Trail  Lithoma GA 30052 (404) 760-6326
Daniel Mason 6086 N.E. Augusta Apt Tucker VGA 30084 (404) 724-6523 -
Andrew Ackerman 899 E. Deer Cir “Waipahu HI 96797 (808) 557-7523 By
Derrick Berg 8275 E Morris St Carter Lake 14 S1510 (402) 637-8209 v
Th T. R A A amank Adal Ceama -t MEE A E4NEd (40N EAD EQ47T
201 vigible /201 total | RELE 8 y4|{> i

You can use Sort Up Within as many times as you wish in your database. For example, you could now sort
the last names within each city. To learn more about sorting see “Sorting” on page 487.

Finding a Person

To search for someone’s last name in the database you first need to click somewhere in the Last column.

® O 6 My Mailing List

I~ | First Last Address City State Zip Phone -
& § v
m Christine  Benjamin 601 % Chester Lane Grand Lake CO 20447 (970)823-0165 -~

Gerald m 2l 476 N.W. Clinton Pkwy Norwalk CT 06851 (203) 735-5038

1 Nicole ‘Weber 7340 S. Harvey St. W indham CT 06280 (203)500-2620

| Margaret Poulsen 9144 V. Dupont Rd YWashington DC 20010 (202) 908-72836
Pamela “Walsh 313 East Bryant Cir.  Newark DE 19702 (_908_) 951-1493 ”m

Now choose the Find/Select command from the Search menu.

Find/Select...
Formula Find/R:lect...
Select All 3EA
Find Next #G
Change...
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Type some or all of the name you wish to find into the dialog. In this case we what to search for Gutierrez so
we will enter the first few letters of the name. (The more of the name you type in the less chance there will be
for a false match with someone else.)

(1) enter some or all of name you want to find
(2) press Find button

Find/Sele¢t Data

é Find %F ) (Select %S ) (\s}@ct Within 3L ) (Select Additional %M )
" Last 4] | Contains %) Gutieq

and | Last e %)

and | Last o )

and | Last e %)

and | Last e %)

and | Last e %)

When you press the Find button Panorama will locate Ms. Gutierrez.

®O 6 My Mailing List
L | First Last Address City State Zip Phone |A
v=i| Christine Benjamin 601 W Chester Lane  Grand Lake CO 80447 (970)823-0165 :
-| Gerald Gilman 476 N.W. Clinton Pkwy Norwalk CT 06851 (203)735-5038
1 Nicole Weber 7340 S. Harvey St. Windham CT 06280 (203)S00-8620
Margaret  Poulsen 9144 . Dupont Rd “Washington DC 20010 (202) 908-7336
Pamela YWalsh 313 East Bryant Cir.  Newark DE 19702 (208)951-1493
Jerome Frank 551 N. 42Nd Ct Newark DE 19713 (302) 633-7506
Allen Reese 24328 North Camden S Hialeah FL 33015 (305) 792-9606 w,
Anna McKinney 876 East JohnsonLn  Lakeland FL 33809 (813) 934-4566
Lenoard Byrd 574 S. Lakeview Circle Melbourne FL 32904 (407) 255-1502
Theresa  Dunn T425 M., Warner Ave Miami FL 23151 (305) 616-2883
Deborah  Ragsdale 113 Erie Ln Miami FL 33152 (309)3812-07388
Catherine Maclean 536 North Manning Dr. Ocala FL 34482 (904) 803-3997
Doris Zawistowsky 4893 North Smith Stre Orlando FL 32861 (407) 865-4111
anthony  Goldman 29710 S Bay Place  Pensacola FL 32514 (904) 968-3152
Beverly Reill 464 S.E. Jones Cir, Reddick FL 32686 (352) 888-4646
Christina m 45151 8. Marion &ve  Saint Augustine FL 22084 (904) 954-21388
Charles Lowe 938 West Laura Trail  Winter Park  FL 32793 (407) 544-8747
Craig Berlin 8727 M Bristol Ave Atlanta GA 30309 (404) 765-2383
Karen Bryant 3595 E STh Blvd. Garden City  GA 314028 (212) 528-0659
Eleanor Carlson 201 East Clark Trail  Lithoma GA 30052 (404) 760-6826
Daniel Mason 60286 N.E. Augusta Apt Tucker GA 30084 (404) 724-6523 -
Andreaw Ackerman 899 E. Deer Cir “Waipahu HI 96797 (808) 557-7523 »
Derrick  Berg 8275 E Morris St Carter Lake |A 51510 (402) 837-8209
Tl min T R A (Ches amendk Aol sramamd OIS A E4NEd (T4 E47 EC47T
. 201 wisible/201 total  fI| « 1 » ( V>
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Finding Multiple People

Suppose you want to look up someone who’s first name is Alan, but you’re not sure what the last name is.
Start by clicking anywhere in the First column.

® O 6 My Mailing List
| First Last Address City State Zip Phone y
a§ v
m Christine  Benjamin 601 % Chester Lane Grand Lake CO 80447 (970)823-0165 .
o | Gerald Gilman 476 N.4. Clinton Pkwy Norwalk CT 06851 (203) 735-5038
'_rl ‘Weber 7340 S. Harvey St. “windham CT 06280 (203)S00-8620
K | Margaret” Poulsen 9144 . Dupont Rd Washington DC 20010 (202) 908-7236
, | Pamela Walsh 313 East Bryant Cir.  Newark DE 19702 (908) 951-1493
1 Jerome Frank 551 N. 42Nd Ct Newark DE 19713 (302) 633-7506 m

Now choose the Find/Select command and type in the name Alan.

Find/Select Data

( Find 3€F ) (Select SCS) ( Select Within SﬁL) (Select Additional 3@M>

" First $) | Contains $ ] Alan|

and | First | $)

When you press the Find button Panorama will find the first person named Alan in the database.

® O 6 My Mailing List
First Last Address City State Zip Phone y
v
Harrison 93 Morton Ter San Diego CA 92123 (619) 783-1965
Sandra Cain 3975 S.W 15t Parkway San Diego CA 92154 (619) 297-5327
— | Edward Hasson 429 W Harvey Cir San Gabriel CA 921776 (818)990-1793
If this isn’t the Alan you were looking for choose Find Next from the Search menu.
Search
Find/Select... #F
Formula Find/Select...
Select All A
Find Next
Change...
Panorama will skip to the next Alan in the database.
My Mailing List
Last Address City State Zip Phone .1
v
Harrison 93 Morton Ter San Diego CA 92123 (619) 783-1965 -
Cain 2975 S.W 15t Parkway San Diego CA 92154 (619) 297-5327
Hasson 429 W Harvey Cir San Gabriel CA 921776 (818)990-1793
Naylor 7825 N Somerset Stre¢ SanLeandro CA 94577 (415) 343-9476
Rodriguez 675 E Shasta Trail San Pedro CA 90733 (213)334-2554 m
Dorfrman 274 South 215t Dr. Santa Rosa CA 95405 (707) 910-4598
Schultz 25307 West Fairmount Sebastopol CA 95472 (707)406-2284
Lissner 9997 N Adams Rd Spring Valley CA 91977 (619) 736-7622
Shipley 400 N Dupont Trail Stockton CA 95209 (209) 210-8495

You can continue using the Find/Next command until you have located every Alan in the database.
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Using the Live Clairvoyance™ Wizard

Searching is one of the most important functions of any database program, so Panorama has more than one
technique for searching. The Live Clairvoyance™ wizard searches your database as you type. To use this wiz-
ard select it from the Wizard menu and type in the word or phrase you are looking for.

® O ) Live Clairvoyance:My Mailing List

alan Q x

;earch: AllFi eEIis

Alan, Harrison, 93 Morton Ter, San Diego, CA,
Alan, Lissner, 9997 N Adarms Rd, Spring Valley,
Alan, Dewitt, 1642 S, Loma Rd, Harahan, LA,
Alan, Frye, 151 S Berry Street, Beaurmont, TX,
Alan, Hoflin, 427 E Poplar Ln, Falls Church, VA,

S matches from 201 visible/201) total 7
T m——

As you type in each letter the wizard shows you the records that match. In this case there are five records
with the name Alan. To see more information about one of these matches simply double click on the line in
the wizard. The wizard will locate the corresponding record in the database itself.

® O ) Live Clairvoyance:My Mailing List

: alan Q x

ééarch: AllFi ei drs

Alan, Harrison, 93 Morton Ter, San Diego, CA,
Alan, Lissner, 9997 N Adams Rd, Spring Valley,
Alan, Dewitt, 1642 S, Loma Rd, Harahan, LA,
Alan, gr e, 151 S Berry Street, Beaumont, TX,
Alan, Woflp, 427 E Poplar Ln, Falls Church, VA,

® O My Mailing List
First Last Address City State Zip Phone v ‘
v
na '-‘rye 151 S Berry Street Beaurnont T 77706 (409) 401-0921 P
Daniel Barker 371 W. Primrose Pl Buda TH 78610 (512) 887-2741
Steven Michael 7185 Jackson Rd Conroe TH 77301 (409) 951-1982

m

For more information on the Live Clairvoyance wizard see “The Live Clairvoyance™ Wizard” on page 507.
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Selecting Instead Of Finding

A third way to locate every person named Alan is to select the information (see “Finding vs. Selecting” on
page 495). To do this click in the First column and choose the Find/Select command, but press the Select but-

ton instead of the Find button.

Find/Select Data

( Find 38F ) Bﬁecti%s) ( Select Within SCL) (Select Additional 38M)

“First '#) | Contains $) ‘Alan|

|

and | First %J ( 3’

Most of the database will disappear. In fact, only the records containing the first name Alan will remain visi-
ble (selected). Everything else is temporarily invisible. Panorama displays the number of selected records in
the lower left hand corner of the window. In this case five records contain the first name Alan. We say that
these five records are the selected records. The other 196 records are invisible (unselected).

®O6 My Mailing List
I | First Last Address City State Zip
=b| XN Harvison 93 Morton Ter San Diego CA 92123
Q= | Alan Lissner 9997 N Adams Rd Spring Valley Ca& 91977
1 Alan Dewitt 1642 5. Loma Rd Harahan LA 70123
S Alan Frye 151 S Berry Street Beaumont T 77706
& | Alan Hoflin 427 E Poplar Ln Falls Church VA& 22042

five selected records contain the name Alan

S visible /301 total |« »

Phone

(619) 783-1965
(619) 736-7622
(504) 674-1130
(409) 401-0921
(703) 5547251

)4

e
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Using the Sounds Like Option

If you don’t know exactly how something is spelled you can try using Panorama’s sounds like option. To use
this option open the Find/Select dialog and use the middle pop-up menu to select Sounds Like. (Shortcut:
You can open the Find/Select dialog by clicking on the number of records in the lower left hand corner.)

(" Find 88F ) [ Select 35 ( Select Within %L ) ( Select Additional %M )

" First '#]  Contains Alan
(E = Not Contains
S il e Begins With
and [ First '#]  Ends With
and | First 4] Equal
p— Not Equal
and | First ) Less Than
and | First 4]  Greater Than
Less/Equal
Greater/Equal
Sounds Like
Match
MatchExact
" —

Here’s what the dialog looks like after you make this selection.

Find/Select Data

( Find 3F ) (Select SCS) ( Select Within SGL) (Select Additional SGM)
" First '4) [ Sounds Like 4] Alan| 1

and | First ey | %)
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Panorama nowv selects six records instead of five, because the name Allen “sounds like” Alan.

®@06 My Mailing List
| First Last Address City State Zip Phone |A
s - ! : ! ! ! ! -
ot Harrison 93 Morton Ter San Diego CA 92123 (619)783-1965
D= | Alan Lissner 9997 N Adams Rd Spring Yalley CA 21977 (819) 736-7622
- Allen Reese 24328 Morth Camden S Hialeah FL 23015 (305) 792-9606
Alan Dewitt 1642 S. Loma Rd Harahan LA 70123 (S04)674-1130
Alan Frye 151 S Berry Street Beaumont T¥ 77706 (409) 401-0321 w’
Alan Hoflin 427 E Poplar Ln Falls Church WY& 22042 (703) 554-7251
A
v
6 visible/201 total | «i» BRSSP

The sounds like option isn’t perfect, but it can find most similar sounds and spellings. You must, however,
know the first letter of the word or name you are looking for. For example, the sounds like option will never
think that the name Ellen sounds like Alan because the two names start with different letters.

Making More Complex Selections

The Find/Select dialog make more complex selections based on multiple criteria. For example, suppose you
want to select all people with zip codes from 50000 to 69999. Start by clicking on the Zip field, then open the
Find/Select dialog. Use the pop-up menus to fill in the first two lines of the dialog, like this.

Find/Select Data

(" Find 3F ) (‘Select %S ) ( Select Within 3L ) ( Select Additional %M )
" Zip '4#) [ Greater/Equal  |#) 50000
and [ Zip '#) [ Less/Equal +) 69999 |
and | Zip e ( E
and | Zip e $)
and | Zip o [ $)
and | Zip e B
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When you press the Select button Panorama will select only the records in the requested zip code range, in
this case 20 records.

®O6 My Mailing List
| First Last Address City State Zip Phone £
Derrick  Berg 8275 E Morris St Carter Lake |4 (402) 637-8209 X
.| Theresa Tracy TT7 W Stewart Way Sargent Bluff |& 51054 (712)547-5613
1 Derrick Viola 584 East Pico Circle  Champaign IL 61824 (217) 623-0547
Kelly Nichals 271 S.Salem Ln Niles IL 60648 (312) 772-9278
Williarm Hoffrnan 10010 SE. Crestview | Topeka KS 66612 (213)975-3619
Linda Nielsen 474 N. Campus Ct Wichita KS 67207 (316)397-4863
David Tito 46 N.E. Williams Lane  Center City MN 55012 (612) 455-9835
| Evelyn Kohn 39261 S Elmwood Pkvw: Owatonna MW SS060 (S07) 731-2800 m
=| Fred Dahl 40670 . Cardinal Pkw Owatonna MN 55060 (S507) 587-2532
Phyllis Fleming 46161 5. Chestnut Ave Plymouth MN 55442 (612) 754-4897
Catherine Gregory 4493 East Fair Drive Saint Paul MN 55114 (612) 771-1074
Louise Gonzalez 22350 N. Stevenson Pk Saint Paul MN 55127 (612) 214-6322
Henry Lewy 14447 E Irving St South Saint Par MN  SS075 (612) 238-9944
Jdames Cooper 523 North Village Cir  Washington MO 63090 (314)593-7974
Stacey Perkins 20143 Bishop Place Elsie MNE 69134 (402) 526-2658
Charles “Wall 7306 Y. Bethany St.  Papillion NE 68128 (402) 374-5630
Fred Dunham 241 S Plummer Way  Emery SD 57332 (605) 295-8348
Angela Sherwood 31060 South Berkshire Madison Wl 53702 (808) 292-8235
Jason Hale 21240 YWest Colemnan A4 Madison W1 53716 (000) S64-6283
Lorraine  Ponce 897 W, CotatiCircle  Wauwatosa Wl 53213 (414) 310-9096
A
v
20 visible /201 total |« /> ; )4\ >

Panorama can also make complex selections based on a formula. To do this use the Formula Find/Select com-
mand in the Search menu.

Search

Find/Select...
Formula Find{Select...
Select All
Find Next

Here is the formula for selecting zip codes in the range from 50000 to 69999.

Find/Select Using Formula

( Find )( Select )( Select Within )( Select Additional )

Zip »= "S0000" and Zip <= "69999"

Here is a formula that will select unusually long last names (more than 10 characters).

Find/Select Using Formula

C Find )( Select )( Select Within )( Select Additional )

length(Last) > 10
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When you press the Select button Panorama will select the five people in this database with extra-long last
names.

® O 6 My Mailing List
I First Last Address City State Zip Phone ‘
& Q v
= | Raymond JRENGEEREGE 30953 S.% Poplar Blvd Los Angeles CA 90035 (213)724-2175 .
Doris cawistowsky 4893 North Smith Stre Orlando FL 22861 (407) 865-4111
Barbara Moldenhauer 155 Elm Ter Canandaigua  NY 14425 (716) 840-5619
Ronald Zawistowsky 32438 N.W. Russell Av Columbia Statis OH 440228 (216) 557-6111 m

Craig Moldenhauer 624 E Culkin Dr. Treuose P& 19101 (215) 420-4750

To learn more about selecting with a formula see “Formula Find/Select” on page 515 and “True/False For-
mulas” on page 1393.

Selecting All Records

To make all of the invisible data re-appear choose Select All from the Search menu.

Find/Select... 3&EF
Formula Find/Select...

Select All A
Find Next #G6
Change...

Panorama will display all of the data in the database again.

®O6 My Mailing List
L | First Last Address City State Zip Phone S
J Donald 16376 E Evans Rt Fairbanks AK 99707 (907) 442-7203 I
Henry Burger 25063 S Leith Ave  Conway AR 72032 (S01) 216-1936 m
Derrick Bryan 526 W Mohawk Court  Fayetteville AR 72703 (501) 937-3922
Michelle  Hutchinson 939 S Bonner Drive Little Rock AR 72223 (S01) 8399-3962
: MNorman Brazelton 2958 S. Portage Blvd Chandler AZ 85244 (602)680-0751
—| Renée Lindsay 242 SE. Utica Trail Flagstaff AZ 86002 (802) 991-5127
Herbert Matthews 14244 N Valencia Rt  Higley AZ 85236 (602) 635-3865
Richard Comminges 838 E. Hill Ct Peoria AZ 85321 (802) 698-0222
1 Betty Curry 120 S. Hall Strest Phoenix AZ 85015 (602) 741-0954
Phillip Wong 3765 SE. 16Th Street Riviera A2 86442 (802) 699-9255
Sharon Blair 28071 S Cordova Bl Acton CA 93510 (305)901-9201
Harry Kowalski 33153 N Waverly Blvd Arcata CA 95518 (707) 218-8647
Harry Gonzalez 937 E. Frederick Ln Arcata CA 95519 (707)3897-5532
Evelyn Lawler 572 S.W Sequoia Cir  Berkeley CA 94701 (415) 670-5367
Chery| Scholl 440 N.W. Baker Pl Beverly Hills CA 90211 (310) 828-9677
Leonard Phelps 746 East Tremont Trai California City CA 93505 (805) 985-4299
Kathleen  Eills 7930 E. Brown St Colusa CA 95932 (916)582-2423
John Chick 318 E. Atlantic Cir CoronaDelMar CA 92625 (714) 773-32814
Deborah Wolf 8503 E. Glenbrook Ave Eureka CA 95503 (707)448-9673
Linda Bischoff 955 N. Harbor Cir. Fresno CA 93747 (209)452-1355
Darlene Sirpson 37054 South Greene Ap Industry CA 91746 (318) 247-5475 -
Melissa Wheeler 47677 W Burnside D La Mesa CA 91942 (619) 464-9001 »
Raymond  Hendrickson 30953 S.% Poplar Blvd Los Angeles CA 90035 (213)724-2175 v
o i P 4 T Madelie e Pl o hALLEL AL FIl1d A NAOTE (448N 227 70650
201 vizible /201 total | RRL y<i»
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Adding A Database To Your List Of Favorites

You can use Panorama’s Favorite Databases wizard to help organize your databases and keep then accessi-
ble at your fingertips. To open this wizard choose Favorite Databases from the Wizards menu. The wizard
displays a list of favorite databases on the left. If you click once on a database the wizard will show you infor-
mation about that database. (Clicking twice opens the database itself.)

e o N Favorite Databases

'Q ) WiName Folder (Info

| Favorites (72 visible/ 72 totsl) | lafe | Lostion | Fields | Forms | Procedures |

Q] Action Menu Styles 4 Folder: General A

@ AriAl Rasorh Charts v Crested: Thu, Jan 14, 1988 @ 7.06 AM v

: P \Modified: Mon, Jul 5, 200¢ @ 5.:38 PM m

@) Books Size: 77,966 bytes (439 records) ol

:@ Button Math Authors : ProVUE Development 4
v

a Catalog — —

. Description

@ Checkbook — . . —

= — . This database list holels in Colovado. The el

;@ Colorado Hotels example shows how %o use Flash Ard o display ™

@ Conference Registration locations on @ map. This database has been

‘@C o around for almost two decades - cheok out the

1 AL, orices! (Colorado natives will also wax

@ Corporate Checkbook nostalgic for the days when the entive stale

' Correspondence Method 1 1 was.in.the.S03. ares.code.} -

:@ Correspondence Method 2 v vl

| Doxible click & open database, control-click for context mend, | 2
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To add your new database to the list of favorites, find the database in the Finder and drag it onto the Favorite
Databases window.

- Tutorial ()
- CHS NS Favorite Databases
My Mailing List-. < — —
~4Q €)' Winame [JFolder [Jinfo
Favorites (72 visible/ 72 totsl} | Info | Locstion Fields Forms | Provedures ‘
@ Action Menu Styles 4 Folder: General "N
@ Anm;érRe Sk Chaicts v (Crested: Thu, Jan 14, 1988 @ 7.06 PM v
P Modified: Mon, Jul 5, 200¢ @ 5:38 PM
W®Boocks A W Size: 77,966 bytes (433 records) k
@ Button Math | k iAut‘hors I ProVUE Developrment 4
T | v
Q Catalog I_B == :
leserjotion
@ Checkbook e wo : T -
R —— | This database list hotels in Colorade. The 2
) Colorado Hotels | example shows how # use Flash Art # display
@ Conference Registration ! locations on & map. This database has been
@C _ | around for almost two decades - check out the
PSS |orices! (Colorado natives will slso wax
@ Corporate Checkbook [ nostalgic for the days when the entive state
@ Correspondence Method 1 ‘: | was in the 303 sres code.} g
@ Correspondence Method 2 v v
| Double click to open datsbase, control-click for context meny. | »

The wizard will add your new database to the list of favorites.

® O N Favorite Databases

Q Q) W Name (JFolder (JInfo
Favorites {1 visible! 72 fotal} ]; infe j Location ] Fields [Forms 1 Procedures
B My Mailing List Folder : Tutorisl

Created: Wed, Sep 22, 2004 @ 5:31 PM
Modified : Wed, Sep 22, 2004 @ 5:32 PM
Size: 2,310 bytes (201 records)

«ar )

Description
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An alternate method for adding the database is to use the Add Favorite command in the Edit menu, then
choose the database from the dialog.

Choose a File

‘< /v [Em’ [ Tutorial 44
@» Network A4 | Name & Date Modified ;
=4 Jaguar ¥ ] My Mailing List Yesterday
& Classic M
=) Panther
=4 Alaska

L\ Fire Jaguar

EZ| Fire Panther
L) Fire Classic
I Fire Alaska <
__liSightweb ... &
__ CocoaGest... &

{3y Desktop
|7 Operations -
A Applications

A jimrea

'y Documents A
g Movies v

BB BB BB, B, -, -

( New Folder) ( Cancel ) (—eheose')
e —"
Once you have added your new file to the Favorites Wizard choose the Save command in the File menu and

your database is permanently added to the list of favorites (see “Removing a Favorite” on page 241 if you
later want to remove this favorite).

Closing a Database

To close a database click on it (to bring it’s window to the front). If the database has only one window you can
close it by clicking on the window’s close box. If the database has more than one window you can close each
window individually or you can select the Close File command from the File menu. Close the My Mailing
List database now.

Logon...

Open File... #0
Save 3#S
Save All

Save As...

Save A Copy As...
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If the database has been modified since the last time it was saved Panorama will ask you if you want to save
the changes. Press the Save button to save the changes.

Do you want to save changes made to
“My Mailing List”?

Don’t Save Cancel || Save ||

The database is now closed, and the memory it was using is available for use with other databases. See “Mon-
itoring Memory Usage” on page 314 to learn how to oversee Panorama’s memory usage.

Re-Opening a Favorite File

To re-open a favorite file, start by choosing the Favorite Databases wizard from the Wizards menu. Type mail
into the search area at the top of the window to find your database.

®0O0 Favorite Databases
e S\
w &' WIName [JFolder (JInfo
Favorites (# visible/ 73 fotal} info  Location Fields Forms @ Procedures
QJ Mail Merge Method 1 Qriginal file has been moved or deleded! .
6] Mail Merge Method 2 é
@) Mail Merge Method 3 ,
@) My Mailing List 4
Description
Double click the database name to open it.
® O N Favorite Databases
Q. mail &' WIName [Folder (JiInfo
Favorites (& visible! 73 total} infe  Location Fields Forms  Procedures
@] Mail Merge Method 1 Folder : Tutorial .
. Crested: Wed, Sep 22, 200¢ @ 5:31 PM v
) Mail Merge Method 2 Modified: Wed, Sep 22, 2004 @ 5.:32 PM m
@) Mail Merge Method 3 Size: 2,310 bytes (201 records) .
B My Mailing List :
k v

® O 6 My Mailing List
[ | First Last Address City State Zip Phone 1
v
Donald 16376 E Evans Rt Fairbanks AK 99707 (907) 442-7203
Henry Burger 25063 SN Leith Ave Conway AR 72032 (S01)216-1936 m
Derrick Bryan 526 W Mohawk Court  Fayetteville AR 72703 (S01)937-3922
Michelle Hutchinson 939 S Bonner Drive Little Rock AR 72223 (501) 899-8962
Norman Brazelton 2958 S. Portage Blvd Chandler AZ 85244 (602) £630-0751
Renée Lindsay 2438 S.E. Utica Trail Flagstaff AZ 86002 (602) 991-5127

To learn more about this wizard see “The Favorite Databases Wizard” on page 237. Tip: If you hold down the
Control key (Mac) or double click with the right mouse button (Windows PC) Panorama will automatically
close the Favorite Databases window after it opens the selected database.
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Transferring Data with VCards

In this section we’ll export a VCard to Apple’s Address Book application. A properly configured Panorama
database can exchange data with any VCard compatible application. In this case, the New Database wizard
has done the configuration for us (see “*“Generic” Fields” on page 398 to learn how to do this configuration
yourself). The first step is to click on the record we want to transfer, in this case Christina Gutierrez.

® O 6 My Mailing List
First Last Address City State Zip Phone ‘
v
Beverly  Reill 464 SE. Jones Cir.  Reddick FL 32686 (352)888-4646
Christina m 45151 S. Marion Ave Saint Augustine FL 32084 (904) 954-3188
[ Charles Lowe 938 West Laura Trail ‘Winter Park FL 32793  (407) S44-8747

Open the VVCard Wizard, which you’ll find in the Utility submenu of the Wizard menu. The wizard displays
the name, address and phone number of the currently selected person.

® O ) VCard Wizard:My Mailing List
\. Christina Gutierrez

@ 45151 S, Marion Ave
Saint Augustine, FL 32084

(¥ Voice (904) 954-8188

To transfer Ms. Gutierrez to the Address Book, drag the tiny book icon onto the Address Book window.

- ® O ™ VCard Wizard:My Mailing List
\! Christina Gutierrez

@ 45151 S. Marion Ave
Saint Augustine, FL 32084. .

| Address Book

® Voice (904) 954-8188 'Q

-, Apple Computer Inc.

...
\ ..

| e

.

: |

| "»‘

(&

[Orag this info Fo any vCard complisnt database or spolication, ] Al ’ MY-APPLE
main -8{)‘)- .

|
H; !IE]JOhﬂ Kuttel * home page hitp:/www.apple.com

| Mr. Francis Phelps
X Jim Rea work 1 Infinite Loop
| | | Steven E Saltman | | Cupertino CA 85014
) ‘ 3 United States

| Jeff Sessions
l || Mr. Joe Smith Jr.
1 | |John Wilson |

.
'
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The Address Book program will ask you to confirm that you want to add this person.

Press OK to add her to the Address Book.

Adding 1 new card

Em i&& Apple Computer
Directories || Eric Bolden
) Last Import __| Beverly Bright

| | Ron Furnare

|| John Kuttel
|| Mr. Francis Phelp}

Christina Gutierrez

other (904) 954-8188

work 45151 S. Marion Ave

Saint Augustine FL 32084

Drag the other way to transfer from the Address Book to your database.

O O O VCard Wizard:My Mailing List

 Christina Gutierrez

L3
@ 45151 S. Marion Ave "\
Saint Ayauctina Fi_22024

|| Eric Bolden
| | Beverly Bright
|- | Ron Furnare

) Last Import

o |\ | Nancy Hess
b John Kuttel

i@ Apple Computer

| Anthony Goldma
E_J Christina Gutierr

John Kuttel

home (714) B46-1378

work 16893 Algonguin St
Huntington Beach CA 92649-3810
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John Kuttel is automatically added to the database.

My Mailing List

| First Last Address City State Zip Phone
m Jason Hale 21240 West Colernan & Madison Wl 53716 (000) S64-6283
m Lorrame Ponce 897 W. Cotati Circle  Wauwatosa Wl 53213 (414) 310-9096

McLean

39096 S.W Cameron Ple Chas

16893 Algonqum St Hunt mgton Bea CA

(304) 823-2415

92649~ (?1 4) 846-1 3?8

Tal»

l';ll Kuttel
La

The VCard wizard can also import and export groups of VCards at once. For more informations see “Using

Generic Fields with the VCard Wizard” on page 404.

Displaying a Map

Don’t close the VCard wizard yet. It’s now displaying the information for John Kuttel, who was just added to

the database.

' ® O M VCard Wizard:My Mailing List
\. John Kuttel

@ 16893 Algonguin St
Huntington Beach, CA 92649-3810

(@ Home (714) 846-1378

To see a map of Mr. Kuttel’s
browser.

Map of 16893 Algonquin St Huntisgton Beach, CA by Miplsest

PO =
“«. » l@--’h{ huo um nup:un! (mlnumlmxnadp'(c_‘llry-u%w(u-I“’)!ok&)nhqumb!v‘.kﬂy-' -fq Geag's

e

 Mews s Keferenie s D{h&n&h l‘blﬁu- Tech Kews v Free 2iF Code Loshay mmm Mmh-cd‘m WA 2008

MepQuesl Find £t
Search by Address,
ezt Calggsey of
Daalsgss tame

) @ ~MAPQUEST.-

m DeRLCTIONS s | U | Satuncs | Modds | Jostiar

Expedin: Discount Hotals CAHLTZ Riscount Hotels
Pt Oaais 3t Oyver 10,000 Matels ina poce Opniaes & Spociu Deale
38vE LD 10 30% O Boted ol Dapediy DO FOte Batdrd et OREITEY
www Lepadacam waw QROITE cam

Cheap Hotels

Campgary Prices, Vaw Protos & borst
Lowe Miles Cudrdnleed = 40k haw
www totelscam

a A Rae LhN

* 16893 Algorquin St Huntington Beach, CA 926459-3310, US ot Offars - Flight Huntington Seach Offers:
Qeats ! Moreh 18] sesen )
Street Map feing | Eiiel | Doveniadg 1o 004 § New Map

in:
1zt Desle 3t Quer 20,000 Hatals
Save wp to 0% oo hatels at Baxpecia
wew Espeda.com

Guanees LonesT Rates o
OIIsaver Motals Dse Now'
waw ORRITE com

Zave Up 22 2% on Rooomy! Lew
Sates Goasasteed « Bock Orfine dew
www heteli com

Hotels For Lass

137 50vi0gE 0N MoTe

et $4207 10 Ked -~ poak Tocay
W raveisaty.com

Great Zean, tpacau wars
Bock resereatiom omdse.
www WeotfirSuteliztels com

Toua Capa 81

{
mnmlc- M’“ Syer gt

|

location, click on the globe icon. The map will appear in your default web
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Transferring a Person from the White Pages

The White Pages wizard allows you to locate a person and add them to your database. You’ll find this wizard
in the Internet submenu of the Wizard menu.

® O M White Pages

We’re looking for Mr. or Mrs. Furnare somewhere in the Palm Springs area (California).

> &
&,y Clear
. KN ol

First I I Last | Furnare |
City

State Zip Code | |

Press the Search button to see the results.

® O M White Pages

First I I LastlFurnare |
City
state [ | 2ip Code | |

+ ,:' r

NSDIV] e
nayiliy o

Furnare, Charl
11221 Vintage Dr
Rancho Cucamonga, CA 91737
-7704

Furnare, Leonard

2884 W Benjamin Holt Dr
Stockton, CA 95207-3216
(209) 472-1334

Furnare, Pat

40210 Baltusrol Cir

Paim Desert, CA 92211-9269 R
(760) 345-4890
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There’s a Pat Furnare in Palm Desert. To verify that he’s the one we’re looking for we can display a map.

\ZUY) 47Z-130%

Furnare, Pat
40210 Baltusrol Cir

Palm Desert, CA 92211-92
(760) 345-4890 J Select This Name
Select This Name & City

Display Map
Open Web Map

Dial Phone

Copy Label
Copy VCard
Export VCard...

T —_—_—"

This wizard displays the map in Panorama itself instead of in your web browser.

® O ) Pat Furnare, 40210 Baltusrol Cir, Palm Desert, CA 92211-9...

Pat Furnare ;
40210 Baitusrol Cir ﬁ"’mx’s‘:‘: @ (760) 345-4890
Palm Desert, CA 92211-9269 N

& - i) |
b NPW‘—sT 3 s ‘L‘anrelo't Ct

oW l_)_r,

=
oaﬁod" Dr__Bishop!Pl '- |
Q ’:o %J |
& ) i oS
C!’]’San r 18 g—x‘
\ Few,tm (o !m = :
-5? 4 Ay 3 %--E <
,.ég' LE o & \§.§‘ 'Spln'ngﬁeld Ln
P A o |7 ] S|
i “ Country ClubDr__ = ' @—&-QU' Tiry. Club.Dr.
E— 7 o [ — {2 =
Ii Qi?\qyon r :‘ ;:;L = g\&‘ __{
b l l O | s _ Malone Cir
1 S aed Afrow D= A ﬂ . ey Bmus 7 e ) o
ll & ‘% 51 -~.3£‘?‘1 Cr "%, g Cannda ct ’ [
lé-f_ i 3\ v SE— e I Westbfook ct 6.
! ) X ‘ S L { ) & == o |
o B YW B 7 “%% A = Akl:ot Cir Cheviot! btn[
—a 0= @ e Bl 2
'S o 5)-! 5 o B _ 8 | ";é E’, _-4%; _3_~<.‘.}1 Maﬂowe ICh
F Ha farly) DN MBS ) SUSER DL
s o R Ty S o E0Y | _ Ashhery Ct —
bl} Q,t“ 7 =] W , : >
&) i | 5. Voodhaven DrN
_ | S )
,r ‘ (e o _.""T'n ve L |
& 2004 MApQuest.com, Ine.; @ 2004 GOT, Ine. | | ossWay
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To add Mr. Furnare to your My Mailing List file drag from the White Pages to the VVCard Wizard.

Displaying 3 of 0 &) mare...,
Furnare, Charles

11221 Vintage Dr

Rancho Cucamonga, CA 91737

s

Furnare, Leonard
2884 W Benjamin Hait Dr O O O VCard Wizard:My Mailing List
Stockton, CA 95207-3216

(209) 472-1334 \ John Kuttel

Furnare, Pat
40210 Baltusrol Cir ~._
f;’g},‘,”s‘ff;'}agg 92211"9269'*\._. @ 16893 Algonquin St

: . "~~.___Huntington Beach, CA 92649-3810

RN
(® Home (714) 846-1378 R

|

| 4 | !/};
T ———

Voila! The new entry has been added to the mailing list.

®0 6 My Mailing List

First Last Address City State Zip Phone 1%

&P v

w=4| Lorraine Ponce 897 W. Cotati Circle Wauwatosa Wl 53213 (414) 310-9096 -~
oz | Kristin McLean 39096 S.W Cameron Pk Chas WY 25304 (304) 823-2415

Paul Steinberg

A Furnare
y

29653 S.\ Taubman Bl Clearmont WY 82835 (307) 729-8985

40210 Baltusrol Cir  Palm Desert CA 92211~ (760) 345-4890

To learn more about this wizard see “White Pages” on page 149.
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Printing the Data Sheet

Before actually printing the data sheet you’ll set up a page header to print today’s date on the top left and the
page number on the top right of each page. To do this choose Headers/Footers from the File menu. This com-

mand opens a dialog that allows you designate headers on the top left, center and right and a bottom cen-
tered footer.

Data Sheet Headers & Footers

— Title Text
Top Left "1
=
Top Center
-
Top Right
b |
Bottom Center
Ly
( Page# j C mm/dd/yy j ( Month dd, YYYY) C hh:mm:ss )
__Title Size
8 Same as Data Sheet, or: pt

(Cancel )( OK )

Start with the top left header. Type in the words Printed on and then press the Month dd, YYYY button.

type Printed on

— Title Text /
Top Left L @«date:Month ddnth, yyyy|
=

Top Center

-

Top Right

Bottom Center
iy

C rage# ) C mm/dd/yy )}Month dd, YYYY ) C hh:mm:ss )

then press button
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Now for the top right header. Type Page and then press the Page# button.

type Page

—_Title Text

Top Left Printed on «date:Month ddnth, yyyy»
Top Center
Top Right ~ (Page }Page#»

Bottom Center

( Page# )C mm/dd/yy )( Month dd, YYYY )C hh:mm:ss )

X

Once both headers are set up press the OK button. (To learn more about the header and footer options avail-
able when printing the data sheet see “Printing Data Sheet Headers & Footers™ on page 1166. When printing
a form you have complete control over the exact layout of headers and footers — see “Custom Reports” on
page 1177.)

then press button

Next, choose the Page Setup command from the File menu. (Before you do this, make sure that the printer
you want to use is connected to your computer and selected.) The exact options available in the Page Setup
dialog depend on the operating system and what kind of printer you are using, but in general you can control
the page size, orientation (tall or wide), and print reduction factor. Here is a typical Page Setup dialog.

Page Setup
Settings: = Page Attributes 4
Format for: ' Any Printer .:,;!
Paper Size: ' US Letter 49

8.50inx 11.00 in

Orientation: ri- 'E

e e a0

Scale: | 100 | %

@ ( Cancel ) € 0K )
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Select the printing options you want to use and press the OK button. To actually print the data sheet choose
Print from the File menu. The printing dialog will appear. The exact options available in this dialog depend
on the operating system and what kind of printer you are using, but in general you can control which pages
to print, how many copies to print, and whether you want to manually feed the paper. Here is a typical Print
dialog.

Print
Printer: ' LaserWriter 12/640 PS 4
Presets: ' Standard 5
' Copies & Pages 4
Copies: 1 _ # Collated
Pages: @ All
O From: 1 to: 1

@ % :’gﬁ" Fax... )

|
|
y

( Cancel ) ( print )

For the exact details on the operation of this dialog see the documentation that came with your printer. Press
the Print button to print the data sheet. Panorama will automatically print as many sheets as necessary.

Printed on October 21st, 2000 Page 1
First Last Address City Stat Zip Phone
Donald Leach 16376 E Evans Rt Fairbanks AK 99707 (907) 442-7203
Henry Burger 25063 S Leith Ave  Conway AR 72032 (S01) 216-1936
Derrick Bryan 526 W Mohawk Court  Fayetteville AR 72703 (S01) 937-3922
Michelle Hutchinson 939 S Bonner Drive Little Rock AR 72223 (S01) 899-8962
Norrman Brazelton 2958 S. Portage Blvd  Chandler AZ 85244 (602) 680-0751
Renée Lindsay 2428 SE. Utica Trail Flagstaff AZ 86002 (602) 991-5127
Herbert Matthews 14244 N Yalencia Rt Higley AZ 85236 (602) 635-3865
Richard Cormnminges 838 E. Hill Ct Peoria AZ 85381 (602) 698-0222
Betty Curry 120 S. Hall Street Phoenix AZ 85015 (602) 741-0954
Phillip YWong 2765 S.E. 16Th Street Riviera AZ 86442 (602) 699-9355
Sharon Blair 28071 S Cordova Bl Acton CA 93510 (205) 901-9201
Harry Kowalski 33153 N Waverly Blvd  Arcata CA 95518 (707) 218-8647
Harry Gonzalez 937 E. Frederick Ln Arcata CA 95519 (707)897-5532
Evelyn Lawler 579 5.\ Sequoia Cir Berkeley CA 94701 (415) 670-5367
Cheryl Scholl 440 N.W. Baker PI Beverly Hills CaA 90211 (310) 828-9677
Leonard Phelps 746 East Tremont Trai California City CA 93505 (805) 985-4299
| Kathleen  Bills 7930 E. Brown St Colusa CA 95932 (916) 582-2423

If you want to print only a portion of the database, use the Select button in the Find/Select dialog to select
the data you want before printing the database (see “Selecting Instead Of Finding” on page 24). Only the vis-
ible records will be printed.
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Creating a Form for Printing Mailing Labels

Now let’s create a mailing label. Many types of peel-off labels are available commercially. Panorama already
knows the dimensions of many popular labels and can do most of the work for you. The first step in setting
up a mailing label is to create a form to hold the label. A form is like a sheet of paper that you can draw on
(see “Introduction to Forms” on page 609). You can place graphics, text and data on the form to create labels,
Invoices, statements, or virtually anything else. To create a new form select New Form from the View menu.

File Edit U Fields Text Search Sort Math Setup Wizards

Data Sheet ng List
Design Sheet City

Flash Art Scrapbook  Wauwatesa W1 53213 (414) 310-9096

has WY 25304 (304) 823-2415
Clearmont WY 82835 (307) 729-8985
Huntington Bea CA  92649- (714) 846-1373
fPalm Desert CA  92211- (760) 345-48390

| State Zip Phone
v

New Crosstab. ..
New Procedure...

A dialog box appears asking for more information about the new form you want to create. Type in a name for
the new form (we used the name Mailing Labels, but you can choose any name up to 25 characters long).

Create New Form

New Form Name: __Insert before: k
Mailing Labels ( H

( Cancel ) ( Blank Form) ( Quick Label ) (Quick Report)

The dialog gives you three options when creating a new form — a blank form, a mailing label and a report.
Press the Quick Label button. The Quick Label dialog appears, allowing you to define the dimensions of the
mailing label you want to print on.

Mailing Label Dimensions

Specify dimensions in: ® Inches () Centimeters

B
050
+

" Avery 5266 | %)

~2up l%)

+0.51 -»

o
'ow‘

|4—4.oo —>|

( Page Setup ) ( Cancel )( OK )
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In the center of the dialog is a pop-up menu that lists many popular labels. The most popular label is the
Avery 5160 which contains 30 labels per page in three columns of 10 labels.

Avery 5160 |

Avery 5260
Avery 5161
Avery 5261
Avery 5162
Specify dimensic Avery 5262 timeters
Avery 5162 Old
Avery 5262 Old
Avery 5163
Avery 5164
Avery 5266
Avery 5267
Avery 5293

. Avery 5294
Avery 4013
Avery 4145

I“ Avery 4162
Avery 4163

( Page Setup ) Avery 4146 el OK
. Avery 4604
— Avery 4143

Avery 4144

Avery 4610

Avery 4161

Avery 4166

Avery 4167

Avery 4168

Avery 4169
Chesire

-

H

+ 0,51 -+

o
(o)}
~J

j -
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When you release the mouse the updated label dimensions appear. (You may also see an alert telling you that
the largest possible printable page area must be set in the Page Setup dialog. If you see this message you
should make sure Page Setup is configured to use as much of the page as possible, with the minimum possi-
ble margins.)

Mailing Label Dimensions

Specify dimensions in: ® Inches () Centimeters

?

A 4

R —— f
o 18 [y | Avery 5160 %) L
2up %) 1'0‘1

l4—2.75 %‘

C Page Setup ) C Cancel )( OK )

Press the OK button after the dimensions are set up.

Once the label dimensions are set up, the next step is to set up the text that will be printed on the label. A sec-
ond dialog box will appear with a list of fields on the left. You’ll build the template for your label on the right.

Mailing Label Layout

Double click to copy field to label...
First |
Last
Address
City
State
Zip
Phone

Font: | Geneva #) size: [118) ( cancel )( OK )
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Start by double clicking on the First field, then press the Space Bar.

Double click to copy field to label...
First ><<First»|
Last
Address

==

Now double click on the Last field, then press the Return key.
Double click to copy field to label...

First «F] <Last»
Last
Address

=m

Double click on the Address field, then press the Return key.

Double click to copy field to label...

First «First» «Last»
Last «Address»
Address

City

am

Double click on the City field, then press the comma key and the Space Bar.

Double click to copy field to label...
First «First» «lLast»
Last «Address»
Address g «Cityn, |
City
State k

[eoce]

Finish the label by double clicking on the State field, pressing the Space Bar and then double clicking on the
Zip field.

Double click to copy field to label...

First «First» «Last» I
Last «Address» i
Address «City», «State» «Zip»l

City ///'
State /
Zip R

Phone
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You can choose the font and size you want to use now or later.

Last «Address»
Address «City», «State» «Zip»
City
State
Zip
Phone
9 point
Font: | Geneva '3 Size:
14
— 18
24
36
48
Up 38
Down 3]
Other...
"

Press OK when the label design is complete.

Panorama now shows you the finished template for the label. The label appears on special “tiles” that control
the size and spacing of the labels (see “Tiles In Action” on page 1192).

My Mailing List:Mailing Labels (100%)
1 2 3 4 = 6 A

Top Margin -
ks T tile

L a
wFirsts «Lasty :

whddress»
;« Citys, «States «Zip»

Data |
t

T T—— 2
ile
tile

o\ m Geneva 12pt (L]« » Y<l» 4
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Previewing the Labels

To see how the page of labels would look before printing, choose Preview from the File Menu. If this is the
first time the labels have been previewed or printed, the Page Setup dialog will appear. If this happens, just
press OK to skip to the preview window. The Print Preview window will show a reduced view of an entire
page of labels.

Print Preview

T T @

. 10—
TETI IVOrRA L. - aeyor
LA 1] A, O

) A | O N
- e L
e -

) s
L 1 COWY? Y 8 I O
LT T L -

ALY D bt
LY a0 r A BECITLY P -
Ry O ece | LI B, O3 OO

VTR ThaT & oraa e Py

e Y
1var aan L) _J
o, O D WA, 0w

2 | .
MAF FWEROr NG LR, N
O OM FP , O KXXIR PR, O Ty

You can click on the magnifying glass tool to see the report life-size, and click on the Next Page tool to pre-
view the next page.

® 06 Print Preview
;-'.1 A
v

Donald Leach Phillip Wong Deborah Wolf
16376 E Evans Rt 3765 5.E. 16Th Street 8503 E. Glenbrook Ave.
Fairbanks, AK 99707 Riviera, AZ 56442 Eureka, CA 95503
Henry Burger Sharon Blair Linda Bischoff
25063 5.W Leith Ave 28071 5.w Cordova Blvd 955 N. Harbor Cir.
Conway, AR 72032 Acton, CA 93510 Fresno, CA 93747
Derrick Bryan Harry Kowalski Darlene Simpson
526 W Mohawk Court 33153 N Waverly Blvd. 37054 South Greene Apt
Fayetteville, AR 72703 Arcata, CA 95518 Industry, CA 91746

When you are done looking at the preview, click on the window’s close box. To learn more about the Print
Preview window see “Print Preview” on page 1174.
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Printing the Labels

To print your mailing labels, first make sure that the correct printer is selected. Make sure the labels are set up
in the printer, then choose Print from the File Menu.

If you don’t want to print all of the labels, use the Find/Select command to select the addresses you do want
to print. Use the Select button so that only the addresses you want to print are visible (see “Selecting Instead
Of Finding” on page 24). Once the correct addresses are selected, use the Print command to print the labels.
After the labels are printed, use the Select All command (see “Selecting All Records” on page 28) to make all

of the addresses visible again.

Switching Between Forms and the Data Sheet

To switch back to the data sheet select Data Sheet from the View menu.

Panorama File Edit _ Arrange Text Graphics Setup Wizards

Data Shee els (100%) 5
14 Design Sheet o Moo B oo B 4

Flash Art Scrapbook 4 i

New Form... m1

| Mailing Labels
. g New Crosstab...
«First»<  Naw Procedure...
whddresss

;«City», «

®06 My Mailing List
| First Last Address City State Zip Phone &

| Lorraine  Ponce 897 W. Cotati Circle  Wauwatosa Wl 53213 (414) 310-9096
s | Kristin MecLean 39096 S84 Cameron Pk Chas WV 25304 (304) 823-2415
| ——1 Paul Steinberg 29653 S Taubman Bl Clearmont WY 82835 (307)729-8985
F! John Kuttel 16893 Algonquin St Huntington Bea CA  92649- (714) 846-1378

. Furnare 40210 Baltusral Cir  Palm Desert CA  92211- (760) 345-4390

)«

203 visible /203 total | «i» RS
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The View Menu lists every possible view of your database, and also allows you to create new views. To
switch back to the mailing label, choose the name of the form containing the label from the menu.

Panorama File Edit BYEVE Fields Text Search Sort Math Setup Wi

806 Data Sheet b
0| First Last j Design Sheet r State Zip  Phone )

Za%| Lorraine  Ponce Flash Art Scrapbook &  wi 53213 (414)310-90%6 .
Kristin  McLean Wy 25304 (304) 823-2415
—! Paul Steinberg___IVeW Form. .. WY 82835 (307) 729-8985
| John Kuttel Mailing Labels N |Bea CA 92649~ (714) 846-1378

| O e CA 92211~ (760) 345-4830
= New Crosstab. ..

New Procedure...
B ——————

:
!
:

Your database can contain many different forms, each displaying the data a different way (see “Introduction
to Forms” on page 609).

Creating a Data Entry Form

A form is not limited to displaying and printing data, it can also be set up for data entry. Using a form allows
you to lay out the fields any way you like. You are not limited to the row and column format used by the data
sheet.

To create a new form view you’ll use the View menu. You’re going to create the form in a new window. To do
this you must hold down the Alt key if you are using a Windows PC, if you are using a Macintosh hold down
the Control key. Either way, select New Form from the View menu.

Panorama File Edit BYEVE Fields Text Search Sort Math Setup Wi

806 Data Sheet

| First Last Design Sheet State Zip Phone 4
2% Lorraine  Ponce | Flash Art Scrapbook &  wi 53213 (414)310-909%6 .
Kristin  McLean WY 25304 (304) 823-2415

—— Paul Steinber WY 82835 (307) 729-2985

= | John Kuttel Mailing Labels Bea CA 92649~ (714) 846-1378

| XS Furnare t  CA 92211~ (760) 345-4890

| = — New Crosstab... .

| 3
i
|

New Procedure...
B ——————

Panorama will ask you for the name of the new form. You can use any name you like up to 25 characters, we
chose the name Entry:.

Create New Form

New Form Name: " Insert before:
‘Entfy{ \ " Mailing Labels p_g_j

( Cancel ) ( Blank Form) ( Quick Label ) (Quick Report)
R ——
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When you press the Blank Form button Panorama will create a new, empty, form. Since you pressed the Alt
key (PC) or the Control key (Mac) when using the VView menu, Panorama creates the form in a new window,
leaving the data sheet also open in the back (see “Opening More Than One Window Per Database™ on
page 351).

My Mailing List
My Mailing List:Entry (100%)

Geneva 12pt (] < » Y< > /I

The tool palette on the left side of the window contains tools for creating and manipulating graphic objects on
the form. The most commonly used tools are shown below.

&z
X

switch between graphics editing and data editing
pointer for selecting graphic objects

turn cross hair on/off (to help alignment)
magnify/reduce

create data cell object (database field)

create text object

create line object

create rectangle object

create rectangle object with round corners
create oval/circle object

iy
L
e

ju]
=

)




Creating Graphic Objects

Before you actually start creating the data entry form let’s practice a bit with using these tools. Start by select-
ing the Oval tool.

My Mailing List:Entry (100%)

Now move the cursor onto the form and drag the mouse across the surface of the form to define the location

and size of the new object (the dragging motion is shown by the dashed arrow in the illustration below). A
gray outline of the new object will follow the mouse.

®0 6 My Mailing List:Entry (100%) |
W]t iieo alb o e B i oo i o B o B

v

...............
.......
N eSS
~"K, S
x
N
.
.
-~ -~
. %

®@06 My Mailing List:Entry (100%)

i z 4 5 Gl & |
JMMMJAMMMMMMMM;

0
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Each time you drag across the form you will create a new shape. Create several shapes as shown below (these
objects are just for experimentation, so don’t worry about the exact position and size).

My Mailing List:Entry (100%) ‘
i 2 i 4 S 6. ] A

Don’t forget to click on the Pointer tool when you are done! If you don’t, the next time you click you will
create another graphic object. To learn more about creating graphic objects see “Creating a Graphic Object”
on page 622.

Selecting and Moving a Graphic Object

To select a graphic object simply click on it with the Pointer tool selected. Four “handles” appear at the cor-
ners to show that the object is selected (see “Selecting a Single Object” on page 629).

®06 My Mailing List:Entry (100%)
! | |1 | |2 | |3 | l4 | IS | |6 A

v

handles mi

click on the object you want to select
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To move an object click on it and drag to the new position (see “Moving a Single Object” on page 636).

My Mailing List:Entry (100%) ‘
i 2 3 4 5 6 . al

For fine adjustments you can use the arrow keys ([<], [=], 1], [1]) to nudge selected objects into position.
Each time you press an arrow key, the object (or objects) moves one pixel in the direction of the arrow (see

“Nudging an Object (or Objects)” on page 637).

Adjusting the Size of a Graphic Object

To change the size of an object, first select the object with the Pointer tool. Then use the mouse to drag one of
the corner handles. As you drag the handle, an outline of the object will follow the mouse.

My Mailing List:Entry (100%)
o oz2 z 4 5 Bl 4
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Release the mouse when the corner is in the correct spot (see “Changing the Size of a Single Object” on
page 641).

® 06 My Mailing List:Entry (100%)

The arrow keys ([<], [=], 1], [1]) usually nudge the entire object. However, after you click or drag a handle,
the arrow keys will nudge just that handle. Each time you press an arrow key the handle will move one pixel
in the direction of the arrow. In other words, each time you press an arrow key the object will grow (or
shrink) one pixel in the direction of the arrow (see “Nudging the Size of an Object” on page 641). You can also
adjust the position and size of the object numerically with a dialog, see “Viewing and Setting Exact Object
Dimensions” on page 640 to learn how.

Changing an Objects Appearance

The new objects you have created are white with a black border. You can change it to Solid (or Hollow) with
the Graphics menu (see “Solid, Outline and Hollow Objects” on page 648).

View Arrange Text Setup Wizards
My Mailing List:
' 4 5. v Outline X B
Hollow

Fill Pattern >
Line Pattern =
Line Width [+

Choose Color...
Palette [+

Copy Color

Paste Color
T ———————
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After you make your selection the object will change to the selected pattern, in this case solid fill.

My Mailing List:Entry (100%)

Geneva 12pt || < » 8 14 » 4,;14;?

current fill pattern (solid)
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Page 56 ]

You can also use the Graphic Control Strip (on the bottom of the window next to the horizontal scroll bar, see
“The Graphic Control Strip” on page 633) to change the appearance of the selected objects. Another way to
change the selected object to solid black is to use the fill pattern menu (see “Fill Pattern” on page 649). This
menu has 40 different patterns to choose from.

50% gray
solid white

transparent solid black
&) / My Mailing List:Entry (100%)

— Riggeal Bt S— — mn

¥

0

N

R
) \ I\ I
AN
o [

-
—

S5od M

I

g
g

- Geneva

=]
£

click to pop-up the fill pattern menu
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To change the color of the selected object use the color menu (see “Color” on page 654).

O 6 My Mailing List:Entry (100%)

A% 0L

T [_ .:_.

= 3—2 | LE-:"
1 | i
= 3 = -
3l ! A l
_-: | v
. D \‘ 4> ,’{.Z!

current color (black) new color (blue)

After you make your selection the object will change to the selected color.

My Mailing List:Entry (100%)
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If you want to choose a color that is not on the palette hold down the Control key while clicking on the color
swatch in the control strip (On PC systems you should Right-Click on the swatch instead of holding down
the Control key). The standard system color dialog will appear.

NONe Colors ()

f (Caijm| [o31ce |We—— = FEEN .-
W | = e e

(Cancel) € oK )

Choose the color you want and press OK.

You can also adjust the line pattern (see “Line Pattern” on page 651) and the line width (see “Line Width” on
page 653) of the selected object(s), and you can copy the color from one object to another (see “Copying and
Pasting Colors” on page 656).

Creating Text Objects

To add a piece of text to your form start by clicking on the Text tool.

®06 My Mailing List:Entry (100%)
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Now move the mouse to the position where you want the text to appear (you can adjust the position later)
and click the mouse.

® 06 My Mailing List:Entry (100%)

llllllllllllllll‘lllllllllllllJlI?llllllllllllllI?llllllllllllJlI?lllllllllllllll?lllllllllllllll?lllll s

0

llllllllll'lllll =

Lll|lllllll|l

click where you want the text to appear

Now use the keyboard to type in the text.

——

As you type each character, the click text object automatically expands. To add another line of text press the
Return key. When you’re done creating text you can click on another spot to create another text object or you
can click on the Pointer tool.

The text object you just created is called click text, because you click to create it. Panorama has another type
of text object called an auto-wrap text object. Instead of expanding automatically as you type an auto-wrap
text object is a fixed size, with the text wrapping inside the object. To create an auto-wrap text object click on
one corner of where you want the object to appear and then drag to the opposite corner.

® 06 My Mailing List:Entry (100%)
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When you release the mouse a dotted box appears for you to type into.

8606 My Mailing List:Entry (100%)

lllllllll'lllll|1llllllll'llllg|?|Illllll'lllll|§|Illllll'lllllI?llllllll'lllllI?llllllll'llllll?llll' 4

0

Whatever you type will wrap inside of the box.

® 06 My Mailing List:Entry (100%)
¥ =211

1lnllllllllllllJlanlélllllllllJ?anlllllllll||J§lnlllnllllll||J?inlllnllllllllj?lnlllnllllllllj?lnlll 4
v

0

This form
§conains three
.ovals|

Illlllllllllllll

—

llllllllllllll

When you’re done creating text you can click or click-drag on another spot to create another text object or you
can click on the Pointer tool.
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Changing the Font and Size

To change the font and size of the selected object you can use the Graphic Control Strip or you can use the
Text menu (see “Text Font, Size and Style” on page 721). The illustration below shows the auto-wrap text
object being changed from 12 point to 9 point.

My Mailing List:Entry (100%)

This form
iconains three
govals.l

10

14
18
24
36
48

N.
11

Up 3£
Down 3] od

nl
lllllllllll‘lll lllllllllll‘l

- Other... r

Geneva

2
m]
s
u

current text size
current font

Here’s the revised text object.

My Mailing List:Entry (100%)
i 2 z _— S 6....lal

This form conains |
three ovals |

Within a single text object all of the text must be the same font, size, style and color. If you want to mix differ-
ent text appearance within a single object you must use Panorama’s Word Processor SuperObiject (see “Word
Processor SuperObject” on page 801).
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Editing a Text Object

To edit a text object simply select the Text tool and click or drag on the object (see “Editing Fixed Text” on
page 718). With this tool you can edit the text object just like any other text - click to select an insertion point,
double click to select a word, etc.

® 06 My Mailing List:Entry (100%)

§This form contains
ithree ovals.

<

Creating Data Cell Objects

Panorama has two different types of objects for editing data (see “Types of Data Editing Objects” on
page 760). Right now you’re going to learn about data cells, which allow data fields to be edited with a pop-
up input box very similar to the data sheet (see “Entering Data Into Your New Database” on page 4 and “The
Input Box” on page 438). To create a data cell start by selecting the Data Cell tool (see “Working with Data
Cell Objects” on page 763).

: OO My Mailing List:Entry (100%)
K

LllllllLlJJLlllzllllllll lJJLlll?llllllLlJJLlll?llllllll lJJLlll?llllllLlJJLlll?llllllll lJJLlll?lllll 4
v |

0

..........

This form contains :

- ovals.
‘Data Cell |
i 3

lllllllllll

Drag the mouse across the form in the spot where you want to create the data cell.

O 6 My Mailing List:Entry (100%)
lIlllllJlllII'I|1l'lllll_ll'glII'I|?|lllllJ1|lIl'I|§||II1L11|IIl'I|?|lllllJl|lIl'Il?llllll_llllll'll?lllll s

0

This form contains
three ovals.
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When you release the mouse the data cell is created. It is automatically assigned to the first field in the data-
base, which in this database is First.

eoe6 My Mailing List:Entry (100%)

This form contains :
three ovals.

Circle

<EBEDPDD

To change the field a data cell is assigned to make sure the Data Cell tool is selected and move the mouse
over the data cell object. When the mouse is over the object the arrow turns into a little menu icon.

E Circle !
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Select the field you want assigned to the data cell from the pop-up menu.

=L

—

[ElC

changed from Address to Phone

@ |

Panorama has another type of graphic object for editing data - the Text Editor SuperObiject. To learn more
about this type of object see “Text Editor SuperObject” on page 767.

Aligning Multiple Objects

| don’t know about you, but those raggedy looking data cells are really bothering me! Fortunately Panorama
has tools that can make this objects nice and neat in a hurry. Start by selecting the Pointer tool.

®06 My Mailing List:Entry (100%)

__IM ‘Pointer ! y

Now start on an empty spot on the form and drag the mouse diagonally across all four objects. The dotted
rectangle should surround the objects.

®06 My Mailing List:Entry (100%)

.........

This form contains
three ovals.

EEBEEEEREERE

When you release the mouse all four objects will be selected (see “Selecting Multiple Objects at Once” on
page 630).
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To align the left and right edges of the objects choose Align Objects from the Arrange menu (see “Aligning
Objects on page 681). The dialog gives you eight different alignment choices — pick Left & Right.

Align Objects

O Top O Bottom () T/B Centers () Top & Bottom
| A 11
O Left O Right ) L/R Centers Left & Right

F T R

( Cancel )( Align )

When you press the Align button the left and right edges of the objects are brought into perfect alignment.

To set the height of all of the objects to 15 pixels choose Dimensions from the Edit menu (see “Setting Exact
Dimensions of Multiple Objects” on page 678). Select the Pixels radio button and type in 15 for the height
(Just 15, not +15).

Set Height/Width of Multiple Objects

Units
C Inches

___________ =

+0
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To vertically space the objects evenly choose the Spacing command from the Arrange menu (see “Adjusting
Spacing Between Multiple Objects” on page 684). Click on the Vertical option and set the spacing you want
between each object (a pixel is one screen dot, or 1/72nd of an inch).

Adjust Object Spacing

__ Direction

/—\ .
@ Vertical  Horizontal

= NN

— Space Between Objects

1 pixels

The data cells are now lined up nice and neat.

2 ECircIe!

Before we call it a day let’s make one final adjustment. Hold down the Shift key and drag the bottom right
handle of the bottom object to the right.

SECD]

SELL]

When you release the mouse all four objects will expand. This feature is called cluster resize (see “Cluster
Resize on page 669 for additional examples) and is very handy for adjusting columns of objects.

Circle

?hﬂné :

In a few minutes you’ll learn a method to create data cell objects in a nice neat column or row in the first
place, making the technique shown above unnecessary. However, you’ll still find the techniques described
above useful in many circumstances.
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Using Data Cells to Edit Data

So far you’ve managed to make four boxes with field names on them — perhaps that doesn’t seem very use-
ful. To activate these cells you must switch the form from Graphic Design Mode to Data Access Mode.

00686 My Mailing List:Entry (100%)

‘mivSwitch'-w Data Access Mode 3 4 .

L v

i oannunnnhy 0
This form contains

4‘%1 :three ovals. :

L

| —; ......................

A=

L;J‘ irst

: 2 ast

‘ *hone

13

In this mode the rulers disappear and the tool palette switches from graphics tools to data navigation tools
(see “Moving From Record to Record” on page 431 and “Browsing the Database With a Form” on page 616).
Most importantly, the data cells now display information from the database itself.

® 06 My Mailing List:Entry
& A
22 v
L This form contains m
- three ovals.
A
¥
b
<
ﬂ Furnare

(760) 345-4890
Palm Desert

database fields
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If you adjust the windows so that you can see both the data sheet and the form you can see that the form is
displaying the same information that the data sheet is displaying.

MM

My Mailing List

First

=4 | Donald
He
Derrid
Michelle
MNorman
Renée
Herbert
Richard
Betty
Phillip
Sharon
Harry
Harry
Evelyn
Cheryl
Leonard
Kathleen
John
Deborah
Linda
Darlene
Melissa
Raymond

Last

Leach
Burger
Bryan
Hutchinagn
Brazelton
hNindsay
Matthews
Comninges
Curry
Wong
Blair
Kowalski
Gonzalez
Lawler
Scholl
Phelps
Bills
Chick
Wolf
Bischoff
Simpson
Wheeler
Hendrickson

TR - |
203 visible {203 total I I <« »ri

Addrass City State Zip Phone a
16376 E Evans Rt Fairbanks AK 99707 (907) 442-7203 h
25063 S Leith Ave  Conwhy AR 72032 (501)216-1936 m
526 %W Mohawk Court Fayefteville AR 72703 (601) 937-3922
939 S Bonner Drive  Little|Rock AR 72223 [S01)899-8962
2958 S. Portage Elvd  Chandler AZ (602) 680-0751
243 SE. Utica Trail  Flagstaff AZ (602) 991-5127
4244 N Valencia Rt  Higley AZ (602) 635-3865
283 E. Hill Ct Peorif AZ (602) 698-0222
12 S Ha" Strpa& Dhaarive A7 YO AL NasA L
Z76RSE. 16T O 6 My Mailing List:Entry
28071\ Col ¢, Al
3153 Wav& DL !
93V E. Froderi 2.6 Y
ST SN Sejua , ) m
440 N . Bakh o | his form contai ‘

746 East Yrem
7930 E. Brown

318 E. Mlant
83503 E. Glenbr
955 N. Harbor —, N
27054 South G %
47677 W Burni O
20953 5. Poy =T

tHree ovals.

onald

Lea

(90 442-7203
Fairbanks vl

203 visible /203 total «» 5 yal»

If you double click on one of the data cells you can edit the data, just as you could in the data sheet (see

“Entering Data Into Your New Database” on page 4 and “The Input Box™” on page 438).

- Yara

My Mailing List:Entry

41

This form contains
three ovals.

| Mark I
L

(907) 442-7203
Fairbanks

203 visible /203 total
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When you press the Enter key the new data will appear in both the form and the data sheet.

& M O My Mailing List

First Last Addrass City State Zip Phone a
—— v
16376 E Evans Rt Fairbanks AK 99707 (907) 442-7203 m

Burger 25063 S\ Leith &ve  Conway AR 72032 (S01) 216-1936
Bryan 526 W Mohawk Court  Fayetteville AR 72703 (S501)937-3922

Michelle Hutchinson 939 S Bonner Drive Little Rock AR 72223 (S501)899-8962

Norman Brazelton 2958 S, Portage Blvd  Chandler AZ 85244 (602) 680-0751

Renée i 248 S.E. Utica Trail Flagstaff A2 86002 (802) 991-5127

Herbert : 14244 N Valencia Rt Higley AZ 85236 (602) 635-3865

Richard Comminges 832 E. Hill Ct Peoria AZ 85381 (602) 698-0222

Betty Curry 120 S. Hall Stre~* Dhmarivs OENIE . {200 741 0asA

Phillip YWong 3765 5.E. 16T O 6 My Mailing List:Entry

Sharon Blair al
Harry Kowalski E
Harry Gonzalez hd
Evelyn Lawler

This form contains

Cheryl Scholl Bde oials

Leonard Phelps
Kathleen  Bills

John Chick
Deborah Wolf g _ ,
Linda Bischoff 955 N. Harbor",j r—

Darlene Simpson 27054 South {

e = I
Raymond  Hendrickson 30953 5. Po
o o O 1 L3 o Leach

203 ViSible('203 total I 4|0 (907) 442-7203%
Fairbanks

203 visible /203 total «»5 R

The same process works in reverse also — any data you enter into the data sheet will also appear in any
forms that are open.

Building the Data Entry Form

Enough practice — it’s time to start building the actual data entry form. Start by switching the form back to
Graphic Design Mode.

®O06 My Mailing List:Entry
@gmcmo«snpmemsigwmdd

This form contains
three ovals.

Leach
(207) 442-7203
Fairbanks

203 visible /203 total <« » 5 4l »

[ [ el b [ e




Page 70 Panorama Handbook

We’re going to start over in this form, so the first step is to erase all of the practice objects you have created. To
do that choose Select All Objects from the Edit menu, then Clear from the Edit menu (or press the Delete
key). Now you’ve got an empty form.

™ & My Mailing List:Entry (100%)

- .
| —
lllllllllllllllll 1

o

Now click the mouse in the upper left hand corner of the form, about 1/16th of an inch from the top and left
hand sides.

® O O My Mailing List:Entry (100%)
| N 1 2 3 al
..... - MMLLMMMLLMH ;j

Now choose the Auto Cell Layout command from the Arrange menu. This command is going to create a neat
column of data cells for us (see “Automatically Creating Rows or Columns of Data Cells or Text Editor Super-
Objects on page 790). This dialog controls how the data cells are generated. Start by pressing the Select All
Fields button. Then set the Spacing (Pixels) option to 1.

Automatic Cell Layout

Line Items ) Layout: || Across _| Same Width
1 Object Height (Lines)

Last
Address Spacing (Pixels)

( Select All Fields )

City Extras: Field Names |_| Boxes
State

Zip SuperObject: | Create SuperObjects™
Phone :

Borders: | ' Top | !Left
I Bottom _ Right
~_!Shadow || 3D
Formatting: ! Wrap at end of line
__ Non-White Background

Term when: \_/Return \_/Tab
' Up/Down Arrows

( Cancel )( OK )
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When you press the OK button Panorama will automatically create a column of data cells (starting at the
point where you clicked the mouse).

® O ® My Mailing List:Entry (100%)

All of the objects are selected. To begin working on the objects separately click on any blank spot to de-select
the objects.

® O O My Mailing List:Entry (100%)

od

Bl ol

Using a combination of dragging and the arrow keys ([<], [=], [1], [2]) move the objects so that the First and
Last name objects are on the same line and the City, State and Zip objects are the same line. Usually the best
technique is to drag the object approximately into place and then use the arrow keys to nudge it exactly into
position. If you need to review the techniques for dragging and nudging objects see “Moving a Single Object”
on page 636 and “Nudging an Object (or Objects)” on page 637. You may also find “Viewing and Setting
Exact Object Dimensions™ on page 640 useful.

When you nudge an object with the arrow keys ([<], [=], 2], [1]) blue lines will appear when the object is
aligned with other objects. When you are finished the result should look like this.

| @ O..@ My Mailing List:Entry (100%)

) N .|.I.|.|.|.~I‘.|.l‘.;-.-l-.|.-|.'§r|.|.|.|?|:;.|.|.|.|.|.-|§|.I.|.|.|.I.|. 8
i 4 I v
s
e
z
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Next drag and nudge the Phone object up under the City, State and Zip objects. When you drag the Phone
object hold down the Shift key so that Panorama will drag the object straight up with no slip to the left or

right (see “Moving a Single Object” on page 636). Then use the and arrow keys to nudge it into final
position.

006 My Mailing List:Entry (100%)

Again holding down the Shift key, drag the lower right hand handle to the right, expanding the width of the
Phone object.

e O 6 My Mailing L L|st Entry (100%)

.—— T : 2 |

Then use the and arrow keys to nudge the width of the object until it matches the combined width of
the City, State and Zip objects. The blue alignment lines appear when the objects are aligned. You may also
find it useful to use the crosshair cursor to check the alignment (see “Nudging to the Crosshair Cursor” on

page 643).

@
2

0 My Mallmg List:Entry (100%)

el bty I 11y |l| Lelets i 11 |l| Lelets I 11y |l| Lelets I Laleds A
v

¢

1l lllllll'lllllll Zl: :

B

Then use the same techniques to adjust the width of the Address cell. Alternatively you can select the
Address and Phone objects (see “Selecting Multiple Objects at Once” on page 630) and then use the Align
command with the Left & Right option to adjust the width. Either way the form should now look like this.

® © © My Mailing List:Entry (100%)
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Drag the mouse around the bottom group of objects to select them (see “Selecting Multiple Objects at Once”
on page 630).

® O ® My Mailing List:Entry (100%)

While holding down the Shift key drag these objects up underneath the First and Last objects. After you’ve
dragged them close use the 1] and arrow keys to nudge the objects into final position.

® O O My Mailing List:Entry (100%)

Finally drag and nudge the width of the Last name object to match the other objects.

O M © My Mailing List:Entry (100%)

o T hlllnl ll"lll ‘llllllllll?lll hlllnl lll?llll‘lllllllll a
¥ v

0

hone

As one last enhancement you’ll set the background color of the form. To do this use the Form Preferences
command in the Setup menu. The background color is set with a pop-up menu at the bottom of this dialog
(see “Form Background Colors” on page 710).

' Fractional Font Widths

' Use Data Style/Color
@ Enable up/down arrows
@ FileGlobal Variables

| Allow Clones

Options: |

—
—

' Use Server for lookup

1 OO0

' 72 dpi Printing

>

Ruler Units: ' Inches l

]
)

“r

Nudge Distance: | 1 pixel 1

Bkgnd Color: |
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Your new form is now complete. Use the Switch To Data Access Mode tool to prepare for displaying and
entering data, and adjust the window size and position so that both the data sheet and form are visible at the
same time.

OEENE

My Mailing List

I~ | First

et | Mark
Henry
Derrick
Michelle
MNorman
Renée

| Herbert
Richard
Betty
Phillip
Sharon
Harry
Harry
Evelyn
Cheryl
Leonard
Kathleen
John
Deborah
Linda
Darlene
Melissa
Raymond

SRR

S2C ek tie . Pl

203 visible /203 total I |

Last Address City

16376 E Evans Rt Fairbanks
Burger 25063 S\ Leith Ave  Conway
Bryan 5926 YW Mohawk Court  Fayetteville
Hutchinson 939 S Bonner Drive Little Rock
Brazelton 2958 5. Portage Elvd Chandler
Lindsay 243 S E. Utica Trail Flagstaff
Matthews 14244 N Valencia Rt Higley
Comminges 838 E. Hill Ct Peoria
Curry 120 5. Hall Street Phoenix
YWaong 3765 SE. 16Th Street Riviera

Blair 28071 S.W Cordova Bl Acton
Kowalski 33153 N Waverly Blvd Arcata
Gonzalez 937 E. Fraderick Ln Arcata
Lawler S79 S Sequoia Cir  Berkeley
Scholl 440 N.%W. Baker PI Bewverly Hills
Phelps T46 East Tremont Trai California City
Bills 7930 E. Brown St Colusa

Chick 313 E. Atlantic Cir Corona Del Mar
Wolf 8503 E. Glenbrook Ave Eureka
Bischoff 955 N. Harbor Cir. Fresno
Simpson 37054 South Greene Ap Industry
Wheeler 47677 W Burnside Dr La Mesa
Hendrickson 30953 5. Poplar Blvd Los Angeles

i! hdo£Sadd Fiold

State Zip

AK 99707
AR 72032
AR 72703
AR 72223
AZ 85244
AZ 86002
AZ 85236
A2 85381
AZ 85015
A2 86442
cCa 93510
cCa 9551

Ch
Ch
Ch
Ch
Ch
Ch
Ch
Ch
Ch
Ch
Ch

oA

—Fairbanks

. (818) 247-5475
(619) 464-29001
(213) 724-2175

FAAED 297 ~oes

T4 >

@ O O My Mailing Lis...

A

0

Phone

(907) 442-7203
(501) 216-1936
(S501) 937-3922
(501) 899-8962
(602) 680-0751
(602) 991-5127
(602) 635-3865
(602) 693-0222
(602) 741-0954
(602) 699-9355
(205) 901-9201

>

116376 E Evans Rt
laK 99707

——

The form window has a tool palette and scroll bars that aren’t really necessary. To get rid of them select the
Window Tweak command from the Form Tools submenu of the Wizard menu (see “Turning Window Com-
ponents On and Off (Window Tweak Wizard)” on page 331). The tool palette and scroll bars are now

removed.

My Mailing List

.| First

| Mark
Henry

1 Derrick
| Michelle
Morman
1 Renée

" | Herbert
y | Richard
| Betty
Phillip
Sharon
Harry
Harry
Evelyn
Cheryl
Leonard
Kathleen
John
Deborah
Linda
Darlene
Melissa
Rayrond

Last Address City State Zip

16376 E Evans Rt Fairbanks AK 99707
Burger 25063 SN Leith Ave Conway AR 72032
Bryan 526 W Mohawk Court  Fayetteville AR 72703
Hutchinson 939 S Bonner Drive Little Rock AR 72223
Brazelton 2958 S. Portage Blvd Chandler AZ 85244
Lindsay 248 S E. Utica Trail Flagstaff A2 86002
Matthews 14244 N Yalencia Rt Higley AZ 85236
Comminges 838 E. Hill Ct Peoria AZ 85381
Curry 120 S. Hall Street Phoenix AZ 85015
“Wong 3765 SE. 16Th Street Riviera AZ  B6442
Blair 28071 S\ Cordova Bl Acton Ca 93510
Kowalski 33153 N Waverly Blvd Arcata CAd 95518
Gonzalez 937 E. Frederick Ln Arcata Ca 95519
Lawler S79 S\ Sequoia Cir  Berkeley Ca 924701
Scholl 440 N.%W. Baker PI Beverly Hills Ca& 90211
Phelps 746 East Tremont Trai California City CA 93505
Bills T930 E. Brown St Colusa Ca 95932
Chick 313 E. Atlantic Cir Corona Del Mar CA& 92625
Wolf 8503 E. Glenbrook Ave Eureka Ca 95503
Bischoff 955 N. Harbor Cir. Fresno Ca 93747
Simpson 37054 South Greene Ap Industry Cha 91746
YWheeler 47677 W Burnside Dr  La Mesa Ca 91942
Hendrickson 30953 S.W Poplar Blvd Los Angeles CAd 90035

<4 »l

2 Cedelin. P .

203 visible /203 total I I

hd.£8add Fiala

-~ A

SAOTE

A

0

Phone

(907) 442-7203
(501) 216-1936
(501) 937-3922
(501) 899-8962
(602) 6280-0751
(602) 991-5127
(602) 635-3865
(602) 693-0222
(602) 741-0954
(602) 699-9355
(Bnm N1 =-92N1

' @ O O My Maili...

16376 E Evans Rt
airbanks  |&K 199707
907) 442-7203

(209) 452-1355

(2818) 247-5475 -
(619) 464-9001 A
(213) 724-2175 %
FA4EN 29T A,

14 » //fgf
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If you ever need to get the scroll bars and tool palette back again (for example to modify the form) simply
select the Window Tweak command again. Another option is to close the form window and then re-open it
with the View menu, which will also restore the tools and scroll bars.

Now that the form is complete be sure to Save your work. (In fact it really would have been a good idea to
save two or three times while you were working on the form. Since Panorama saves so quickly there’s no rea-
son not to save early and often.) Panorama saves the window positions along with the data and graphics
(assuming you checked the Save Window Positions option when you originally saved the file, see “Saving
Window Positions” on page 260), so if you close the file and then re-open it the form window and data sheet
windows will reappear in the same places, ready to go.

The new form you have created only scratches the surface of the capabilities available for building forms. To
see a more sophisticated example use the Favorite Databases wizard to open the 106th Congress database.
This form uses what is called view-as-list mode, which allows a form to display more than one record at a
time (kind of a cross between the data sheet and a regular form. See “View-As-List Forms” on page 1017 to
learn how to create this type of form.

e 06 106th Congress List

Democrat Calnfornla 46th Dlstrlct
BT (202) 225-2965 | (202)225-585% m
Mr. Chrlstopher Cox

California 47th Dlstrlct

E@de (202) 225-5611 (202) 225-9177

Member L ELs] Packard

GENAENY California 42th District

BT (202) 225-3906  (202) 225-0134
N ad Mre. Brian Bilbray

SELNAIGEETY California 49th District

Democrat Caln‘orma SOth Dlstr ict I :

Y
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To see an example of a more traditional form press the Contact Info or Bio button. (See “Push Buttons” on
page 941 to learn how to create a button.) Pressing either button opens a form in a new window.

0

106th Congress:Biography

S e Ms. Loretts Sanchez

(2022fe G = \

B anad California 46th District

e = '- _ Leadership [N
-------- . First Elected BEES LY 2nd

“““““““ — RISEEES Armed Services
3 Education.and the Workforce

, 01/07/1960 44 yrs Lynwood, CA

BS Chapman University, 1982; MBA American

=N OIEEN Stephen Brixey Religion L3t

EOE R Investment Banker GG Santa Ana
: 538w sible/538 tot#i SR IEES no prior elected office

All of these forms use Flash Art to display a photograph (see “Flash Art™” on page 876). You can also show
and play a QuickTime movie in a form (see “Displaying Movies in a Form” on page 938).

Writing a Letter to Someone in the Mailing List

Panorama includes a pre-built database for handling general word processing chores — the Mini Correspon-
dence wizard (see “Using the Mini Correspondence Wizard” on page 855). This database may be used for
general correspondence (letters, memos, etc.) and to create mail merge letters that are customized and sent to
a group of recipients. To write a letter to a person in your mailing list database, first locate and click on that
person.

e 06 My Mailing List

| First Last Address City State Zip Phone y
v
| Richard Comminges 838 E. Hill Ct Peoria AZ 85381 (602) 698-0222 o~

Curry 120 S. Hall Street Phoenix AZ 85015 (602) 741-0954
Wong 2765 SE. 16Th Street Riviera AZ 86442 (602) 699-9355 m

Blair 28071 S.W Cordova Bl Acton CA 93510 (805) 901-9201

Kowalski 33153 N Waverly Blvd Arcata CA 95518 (707) 218-8647

Gonzalez 927 E. Frederick Ln Arcata CA 95519 (707)897-5532

click on the person you want to write a letter to
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Now open the Mini Correspondence wizard.

[ Wizarcs »o DN

Calculations
Developer Tools
Documentation
Form Tools
Guided Tour
Internet

Mini Applications
Preferences
Utilities

Mini Calendar
Mini Contacts
Mini Correspondencer
Mini Statistics
Stopwatch
Task Timer

VVREATY V V VY Y

Live Clairvoyance
Database Information
Favorite Databases
New Database Wizard

The wizard will ask you if you want to create a new letter to Sharon Blair.

Do you want to create a new letter to "Sharon

j Blair"?

ENo ) ( Yes )

Press the Yes button to create the new letter. The wizard will automatically fill in the name and address in the
new letter.

®@06 0 Mini Correspondence:Letter
JELLl Ms. Sharon Blair 09/25/04

e ke by David Architects Services Greeting

Closing

.!*\
5

Yolottorbady>

i

<Insert Body of Letter Here>

“tlotterbodyLetterClosing(Closing Signature)

1

i

i
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At this point all you need to do is type in the body of the letter. Just start typing.

Klettorbody>

We’re holding a spaecial sale at the end of this month that I’m sure you won’t want to miss out on.
Bring the enclosed coupon for an extra 109 savings. Everything in the store will be discounted at
least 209 on the 29th, 20th, and 31st. Don’t miss it!

— “ilottorbodysLetterClosing(Closing Signature)

When you are finished typing in the letter press the Enter key. Panorama will display a preview of the actual
letter, including the address, greeting and salutation.

® OO Mini Correspondence:Letter )
JELCE Ms. Sharon Blair 4

David Architects Services

September 25th, 2004

Ms. Sharon Blair

David Architects Services
28071 S Cordova Blvd
Acton, CA 93510

Dear Ms. Blair,
We're holding a spaecial sale at the end of this month that I’m sure you won’t want to miss out on.
Bring the enclosed coupon for an extra 109 savings. Everything in the store will be discounted at

least 209 on the 29th, 30th, and 31st. Don’t miss it!

Sincerely,

James Rea

:'- T President I 7
d
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If you want to print this letter use the Print This Letter... command in the Letter menu.

File Edit Template Setup Wizards
New Blank Letter... (Sans Serif 9 pt)

New letter to "Sharon Blair" (My Mailing List)
Open Correspondence List Window...
Save

Page Setup...

Print This Letter...

Print 203 Mail Merge Letters (My Mailing List)
T —"

To learn more about editing a word processing document (including setting margins, tabs, fonts, styles and
colors) see “Using the Word Processor’” on page 805.

Printing a Mail Merge Letter

You can take the same letter you just created and send it to multiple recipients — for example we could send
it to everyone in the 619 area code. Start by going back to the My Mailing List database and selecting the
members of congress from California (see “The Find/Select Dialog” on page 497).

Find/Select Data

( Find 3€F ) (Select 385) ( Select Within StL) (Select Additional 88M>

" Phone '4) | Contains '$) ‘7(619)| ‘

and | First | :)

As you can see there are 4 people in this area code in the mailing list.

e 06 My Mailing List
First Last Address City State Zip Phone |4
- § v
) [Melissa  KUias 47677 W Burnside Dr  La Mesa CA 91942 (619) 464-9001 L
oz | Alan Harrison 93 Morton Ter San Diego CA 92123 (619) 783-1965

Sandra Cain 3975 S.W 15t Parkway San Diego CA 92154 (619) 297-5327
Alan Lissner 9997 N Adams Rd Spring Yalley CA 91977 (619) 736-7622 m
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Now go back to the Mini Correspondence database and pull down the Letter menu. The last item in this
menu will print a customized letter to each selected person in the My Mailing List database.

File Edit Template Setup Wizards
New Blank Letter... (Sans Serif 9 pt)

New letter to "Melissa Wheeler” (My Mailing List)
Open Correspondence List Window...
Save

Page Setup...
Print This Letter...

Print 4 Mail Merge Letters (My Mailing List)

The wizard will print 4 customized letters.

October 25th, 2000
Alan Lissner

9997 N &dams Rd
Spring Yalky, CA 91977

October 25th, 2000
Sandra Can
3975 SW 15t Parkway
Con DNiwas T4 Q2154
Ogtober 25th, 2000
#lan Harrison
9 Morton Ter
San Diego ,,CA 92123

October 25th, 2000

Melissa Whee ker

47677 W Bumside Dr

LaMesa,Ch 91942

Dear Melissa,

We're holding a special sale at the end of this month that I'm sure you won’t want to miss out on. Bring
the enchsed coupon foran extra 109 savings. Everything in the store will be discounted at kast 20%
on the 29th, 30th, and 31 st. Don ¥ miss it!

Sincerely,

JBmes Rea
President

See “Printing a Mail Merge Letter” on page 860 to learn more about printing mass mailings with Panorama.
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Tidying Up

Your mailing list database is complete, so now is the time to save your work permanently. Choose Quit from
the File Menu (OS 9 or Windows) or the Panorama Menu (OS X). If you have made any changes to your data-
base since the last time it was saved, Panorama will ask you if you wish to save the database. You do, so click
the Save button.

Do you want to save changes made to
_[@ "My Mailing List™

(Don't Save) ( Cancel ) &5’; e )

Congratulations! You’ve successfully created and used your first Panorama database (you were following
along on your computer, right?). Now that you’ve mastered the basics you’re ready to move on to some more
advanced techniques.
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Lesson 2: Building and Organizing a Checkbook

Now that you’ve created your first simple mailing list database, you’re ready to try something more compli-
cated. In this lesson you’ll build and use a database for keeping track of a checkbook. Start by launching Pan-
orama and the New Database Wizard.

Panorama File BRUUFEEGS

Calculations
Developer Tools
Documentation
Form Tools
Guided Tour
internet

Mini Applications
Preferences
Utilities

WY ViV VYT

Live Clairvoyance
Database Information
Favorite Databases
New Database Wizard
Search All Fields
View Wizard

On Windows systems you can do this with the Start menu.

Programs Accessories
Online Services 4
Elgcumerks s Panorama i) Favorite Databases
@ Settings » Startlp » &) Frequently Asked Questions
Stufflt » &) Mini Calendar
(g | Find » L.
(L% @ Internet Explorer a Mini Contacts
W @ Help % Internet Mail @ Mini Correspondence
% - & Intemet News 1 New Database Wizard
o e o W Microsoft NetMeeting
; Shut Down... P ERD I FEE

@ Windows Explorer
ol @ Exploring - F:\Docu...l Q Find: Files named nI |<f]‘ 12:21 PM

The checkbook database will have eight fields — Date, Check, Pay To, Category, Memo, Debit, Credit and
Balance. (See “Fields” on page 375 for a complete explanation of fields.) Type in the name of each field into
the wizard, with each name on a separate line. The four numeric fields have special suffixes. The Check field
has a suffix of # to tell the wizard to create an integer numeric field (1, 2, 3, etc.). The Debit, Credit and Bal-
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ance fields have a suffix to create a 2-digit numeric field (12.34, 813.94, 8.43 etc.). (Note: These suffixes are
only used when creating databases with the New Database Wizard (see “Creating Numeric and Date Fields”
on page 252). When creating fields with the Add Field command (see “Add Field” on page 377) or the Design
Sheet (see “The Design Sheet” on page 380) you can use any field name with any field type you like.)

®o N New Database Wizard
Fields Notes/ Instructions
- A
Number of Line Item (€2) Fields: | | New Database Wizard
v
Date . : A || Tocreate a new database, simply enter the names of the fields you want to create O
Ched # for mteger fields '« | | in the box to the left, one field per line. You can start with the blank form shown
Pay To here, or start by selecting a pre-built template from Template menu (at the top
Categor} m of this window). After the fields names are entered press the Make New
Memo . Database button.
Dett$) $ for money fields
Credi ’ Importing a Text File
Bala To create a new database from a tab or comma delimited text file, press the
Import Text File button and select the file. The first line of the file will appear
in the box to the left - one field per line. If the first line of the text file contains
the field names, just press the Make New Database button to create the
database and import the data. If the first line contains data, simply replace each
| | data item with the name you want to use for the field. Don't add or remove any
A || lines. You can also add suffixes for numeric fields, default values and calculations
v | | (see below). A
v
Import Text File... Make New Database Adjusting Field Widths
i ) C § | Adjusting P

When you press the Make New Database button the wizard will create a new database for you. The database

is displayed using a row and column format called the data sheet. The new database contains one blank
record (line) and eight fields (columns).

®06 Untitled
Date Chec Pay To Category Memo Debit Credit *

v

1 visible/1 total |« » & Yeal». /
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The eighth column, Balance, is not visible. To make it visible reduce the text size to 9 pt.

rama File Edit View Fields Search Sort Math Setup Wizards D_ =
19686
~ .| Date Chec Pay To

T

Debit  Credit *

v

Down 3] >
1 visible/1 total 1« »&E Yl 4
- = Other... »
Now all of the columns are visible within the window.
'®0 6 Untitled
Date Checl Pay To Category Memo Debit Credit Balance 1%
] &
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Loading the Data

To demonstrate Panorama’s organizational features you’ll need to type in a bunch of data. That doesn’t
sound like much fun, does it? Didn’t think so. To help you out we’ve created a database that is programmed
to automatically fill your new checkbook database with sample data. Start by choosing Favorite Databases
from the Wizard menu (see “The Favorite Databases Wizard” on page 237). The database you need is called
Sample Checkbook. To locate it, type sample into the search area a the top of the window, then click on Sam-
ple Checkbook.

® 00 Favorite Databases

Q sample &) Winame (Folder (JInfo
Favorites (7 visible! 72 total} info  Location Fields Forms @ Procedures
Q] Music Video Samples Folder: Sample Dats

ij Mu Samele Kivoices Created: Mon, Ot 30, 2000 @ 5:32 AM
y =amp Modified : Thu, Jan 25, 2001 @ 5.09 AM
ij Sample Alerts Size: 7,940 bytes (65 records)

i] Sample Checkbook
@ Sample Dialogs

«r» (B

. . Description
@ Sample Price List - -
) This database is part of the Panorama Step-by- *
ij Trigger Samples Step twdorizl. After you have created your Y

tutorial price list database you can open this
database fo awlomatically fill your price list
with sample data. If the database fields do not
matoh you will be asked it you want to adjust
the fields. If this question appears make sure o
double check the database narme betfore
oroceeding. -

| Double click o open database, control-click for context menu. y
e ——

(2

Double click on the Sample Checkbook file to open it. A small window will appear briefly. The database has
been pre-programmed to automatically transfer one year’s worth of sample checkbook data into the new
database you have created.

®O06 Untitled
| Date Checl Pay To Category Memao Debit Credit Balance 4
J§ 01701798 OPENING BALAN DEPOSIT 12,7390 12,7390 M
01701792 100 Sparkletts Dffice Supplies 14.20 12,724 8 m;
- 01/01/98 101 Blue Cross Insurance Health Insurance group XBG-87. 975.00 11,7498
S| 01701792 102 VYalley Gas Utilities Heating 42.90 11,6999
: 01701798 103 AT&T Telecorn Long Distance Phone Servyice 236.24 11,4636
— 01/01/92 104 SurfNetworks Telecom DSL S0.00 11,4136
| 01701798 105 United Security Utilities Alarm 30.00 11,3836
01/01/98 106 UPS Shipping 144 .02 11,2396
1 01/01/98 107 Edison General Utilities January Electric 115.55 11,124.1
01701798 1028 City Services  Utilities Water 54 .39 11,0697
01/01/98 109 Pacific Properti Rent January Rent 1,580.00 9.,489.71
017017928 110 VYalley Bell Telecom Local Phone Service 136.95 935276
01/01/98 111 General Casualt' Insurance Property Insurance policy YX4Z 187.50 9,165.26
01701798 112 Hamilton Davis Insurance Worker's Comp policy 81722-1 92.00 9,073.26 2
01/02/98 DEPOSIT DEPOSIT 5,98582 15,0590 v
515 visible/S1S total || < » J<|» /|
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You may want to adjust the widths of some of the columns (see “Adjusting Column Widths, Font and Size”

on page 14).
®@O06 Untitled
Date Checl Pay To 3> Category Memo
01/01/98 OPENING BALANCE DEPOSIT |
01701798 100 Sparkletts Office Supplies
01701798 101 Blue Cross Insurance Health Insurance group XE

3

md dme dan LRt R B N e PlLAIIIAI L o LB PSS § S

Debit ¥ -Credit “® Balance 4

12,739.00 12,739.00
14.20 12,724 .80
975.00 11,749.80

A& S5 44 oo an

A
v

Before continuing you should use the Save command in the File menu to save your new creation. The first
time you save any file Panorama will ask you to give it a name. You’ll also want to check the Save Window
Positions option (see “Saving Window Positions” on page 260). When everything is set up press the Save but-
ton. (To see what this dialog looks like on the PC see “Saving Your Work” on page 8.)

type in name of file select folder you want to save file in

\ / Save
X /

=

Save As: My Checl;?@ok!

4| Date Modified

Ll Fire Jaguar

£l Fire Panther

L7 Fire Classic

£l Fire Alaska

| iSightWeb ... &

| CocoaGest... & &

[ Desktop

| 7 Operations
4 Applications -
& jimrea

s Nnarumantc

‘<> (=|m! |7 Tutorial 44
@ Network a | Name
:a'_é Jaguar Y aj My Mailing List
= Classic
=i Panther
=) Alaska

Today

@ Panorama () Text Only ( Set

| Automatic save after 20  minutes
_! Keep backup copy (.b) of database

|
|

g Save wind%ar{sitions "' No windows

( New Folder)

tell Panorama to save window positions
CCancel )

AN

You may also want to add your new file to the Favorite Database wizard. See “Adding A Database To Your

List Of Favorites” on page 29 for a refresher on how to do this.
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Analyzing the Checkbook

In the next few sections you’ll learn several techniques for extracting useful information from any database.

Selecting Data

To select all office supply expenditures, click anywhere in the Category column.

e 06 My Checkbook
I~ | Date Checl Pay To Category Memo Debit Credit Balance “
m 01701792 OPENING BALANCE DEPOSIT 12,739.00 12,739.00 1
01701792 100 Sparkletts Office Supplies 14.20 12,724 .80 m
1 01/01/98 101 Blue Cross M-}! Health Insurance group XE  975.00 11,749.80
| 01701792 102 Valley Gas Utilities Heating 43.90 11,699.90
01701798 103 AT&T Telecom Long Distance Phone Sery 236.24 11,463 66
1 01701792 104 Surf MNetworks Telecom DSL S0.00 11,413.66
* | 017017928 105 United Security Utilities Alarm 30.00 11,383.66
y | 01701798 106 UPS Shipping 144 .02 11,239.65
= 01/01/92 107 Edison General Utilities January Electric 115.55 11,124.10
01701792 108 City Services Utilities Water 54 .39 11,069.71
01701792 109 Pacific Properties Rent January Rent 1,580.00 9,429.71
01701798 110 VYalley Bell Telecom Local Phone Service 136.95 9,352.76
01701792 111 General Casualty Insurance Property Insurance policy 187.50 9,165.26
01701792 112 Hamilton Davis Insurance Worker's Comp policy 81° 92.00 9,073.26 £

Next, choose Find/Select from the Search menu. (You can also open the Find/Select dialog by clicking on the
number of records in the lower left hand corner of the window). Type office supplies.

Find/Select Data

C Find %F) CSelect 385) CSeIect Within 38L) CSeIect Additional 86M>

' Category %) | Contains %) Office Supplies|

and | Category o [ s

When you press the Select button (or the Enter key) Panorama will select the 73 checks for office supplies in
the database. All of the other checks will become temporarily invisible.

e O6 My Checkbook
| Date Checl Pay To ' Category Merno Debit Credit Balance 4
==u| 01/01798 100 Sparkletts Office Supplies 14.20 12,724.80 M
01705792 113 Office Max Office Supplies 17047 14,882.62 m
01/05/98 116 Kinko's Office Supplies 50.03 12,834.90
| 01719798 131 Staples Office Supplies 126.83 11,121 .61
01/19/98 133 Costco Office Supplies 207.23 10,742 .59
= 01/26/98 135 Kinko's Office Supplies 45.24 15,152.15
| 02/02/798 150 Sparkletts Office Supplies 13.98 15,438.93
02/09/98 153 Fry's Electronics  Office Supplies 192.48 15,619.94
4 02/09/98 156 Office Max Office Supplies 129.61 14,249.99
02/09/98 160 Costco Office Supplies 20860 11,31452
02/16/98 161 Fry's Electronics  Office Supplies 166.74 16,391 .84
02/16/98 169 Kinko's Office Supplies 52.23 9,793.32
02/23/98 172 Kinko's Office Supplies 133.51 12,664.95
02/23/98 175 Staples Office Supplies 41.30 12,533.02 *
03/02/98 179 Staples Office Supplies 82.76 17,02283 v 1
73 visible /515 total | RALa J<|»
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To select only the office supply expenditures in October 1998, re-open the Find/Select dialog. Use the pop up
menus to change the second line to Date and Equal, then type in oct 98. When you want to select an entire
month you must spell out the month, for example nov 02 or january 1997. You can also select a single day, for
example 3/7/96 or August 15, 2001 (see “Locating Dates by Month, Quarter, or Year” on page 501).

Find/Select Data

and
and
and
and

and

Cancel

( Find %8F ) (Select 35S ) ( Select Within 3L ) ( Select Additional %M )

(

Category 4] | Contains

— ‘4] | Equals
Check N )
Pay To B ( 3)
Category _ _
Memo = +)
Debit e [ $)
Credit

%] Office Supplies
#) loct 98

_

Press the Sel ect button (or the Enter key) to see the 8 checks for office supply expenses in October 1998.

® 06 My Checkbook
I | Date Checl Pay To Category ‘Memo Debit Credit Balance *
S=te| 10/01/98 453 Sparkletts Office Supplies | 12.20 17,730.80
o | 10/05/98 465 Kinko's Office Supplies 135.46 17,173.39
1 10/12/98 463 Fry's Electronics  Office Supplies 133.27 20,504.09
| 10712798 469 Office Max Office Supplies 2203 20,482.06
| 10712798 472 Kinko's Office Supplies 89.03 17,620.87
10/19/98 473 Costco Office Supplies 169.71 21,157.41
10/19/98 476 Office Max Office Supplies 68.18 19,131.77
10/26/98 485 Staples Dffice Supplies 162.37 18,702.39
a
‘V
8 visible/S15total || < » ¢ Yalr s

When you want to see all of the checks again, choose Select All from the Search menu. You can also undo the
sixteen most recent selections with the Undo command in the Edit menu (see “Undo Select” on page 506).




Page 89

Calculating the Grand Total

To calculate the grand total of all the checks in the database start by clicking anywhere in the Debit column.

e 06 My Checkbook
| Date Checl Pay To Category Memo Debit Credit Balance “
s Q v
m 01701798 OPENING BALANCE DEPOSIT 12,739.00 12,739.00
01701798 100 Sparkletts Office Supplies 14.20 12,724 .80 m
01/01/798 101 Blue Cross Insurance Health Insurance group XE m 11,749.80
01701798 102 VYalley Gas Utilities Heating 49.90 11,699.90
01/01/798 103 AT&T Telecom Long Distance Phone Sery 236.24 11,463 .66

Next, choose the Total command from the Math menu. Panorama will add a new record to the end of the
database. This new record is called a summary record (see “Summary Records” on page 371), and it contains

the grand total for all the checks.

12/25/98  DEPOSIT  DEPOSIT 7 5,26490 1894936
12/28/98 S60 VYalley Publications Advertising 963.57 17,985.80
12728798 561 Poly Payroll Servii Payroll 1,749.38 16,236 .42 m
- A
v
516 visible /516 total | RALA () y< > 4
ummary records displayed in bold with blue background grand total

As you can see the column isn’t quite wide enough to display the entire grand total. You can drag on the col-

umn name to adjust the width (see “Adjusting Column Widths, Font and Size” on page 14).

®O6 My Checkbook
I [~ | Date Checl Pay To Category Memo & -~ Debit Credit Bala 4
. 12721798 A 551 Coast General Purchases Invaice 61471 279.72 A 1?,960;.:
12/21/98 552 0Office Depot Office Supplies 7246 17,888
= 12/21/98 553 Staples Office Supplies 74 .81 17,813
S| 12/21/98 554 Century Equipment Fixed Assets 1,063.20 16,749
12/21/98 555 Stamford Mfg Purchases Invaice 19188 472 .37 16,277
12/21/98 556 Post Office Shipping 204 .62 16,072
12721798 557 Power Printing Advertising 542.50 15,530
| 12721798 558 Poly Payroll Servic Payrall 1,656.55 13,873
12721798 559 Fry's Electronics  Office Supplies 189.22 13,684
12/25/98 DEPOSIT DEPOSIT 5,264.90 18,249
12/28/98 S60 VYalley Publications Advertising 963.57 17,985
12/28/98 S61 Paly Payroll Servic Payroll 1,749.38 16,236@
mm A
v
. :
516 visible/516 total /] </ » | () Ry

When you are finished looking at the grand total use the Cut Record tool to delete it (or press the Delete key,

see “Deleting a Record” on page 435).
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Calculating Subtotals

To calculate the grand total you created a single summary record at the end of the database. To calculate sub-
totals you must create a summary record for every category you want to subtotal. This is done with the
Group Up command in the Sort menu. As an example you’ll create subtotals for each month, and sub-subto-
tals for each category within each month. Start by clicking anywhere in the Date column and choosing Group
Up from the Sort menu.

ﬂg’ Panorama File Edit View Fields Text Search Math Setup Wizards

|® 66 My Checkbook
| Date Checl Pay To Category ‘Memo
~=| 01/01/98 OPENING BALANCE DEPOSIT
2 01701798 100 Sparkletts Office Supplies
— 01/01/92 101 Blue Cross Insurance Health Insurance group KE
J 01701798 102 Valley Gas Utilities Heating
: FRFEEE 103 ATET Telecom Long Distance Phone Sery
= 01/01/98 104 Surf MNetworks Telecom DSL
£ | 01/01/92 105 United Security Utilities Alarm
01701798 106 UPS Shipping
01/01/98 107 Edison General Utilities January Electric
01701798 108 City Services Utilities Water
01/01/98 109 Pacific Properties Rent January Rent
01701798 110 Valley Bell Telecom Local Phone Service
01701798 111 General Casualty  Insurance Property Insurance policy
01701798 112 Hamilton Davis Insurance Worker's Comnp policy 81°
01/02/98 DEPOSIT DEPOSIT
515 visible/S15total ||| <« » &

Sort Up U

Sort Up Within

Sort Down
Sort Down Within

J 1) J
Group Down
Group

Sort by Color
Group by Color

Qutline Level...

Remove Summaries...
Remove Detail...

Toggle Summary Level

L

- —

Since the field being grouped contains dates, Panorama will ask what time period you want to use. The
Month option is already selected, so just press Group.

Group by

O Day

) Week
® Month
O Quarter
C Year

( Group )
( Cancel )
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At first it may appear that nothing has happened. However, if you scroll the database down you will see that
Panorama has created a summary record after each month. It also creates an extra summary record at the bot-
tom of the database for the grand total. You can identify summary records easily because— 1) they are bold,
and 2) they have a little plus sign to the left of the first column.

® O 6 My Checkbook
! Date Checl Pay To Category Memo Debit Credit Bal 4
v

01/26/98 135 Kinko's Office Supplies 45.24 15,15,
01/26/98 136 Poly Payroll Servin Payroll 1,793.43 13,35
01/30/98 DEPOSIT DEPOSIT 4 66434 18,02
01/30/98
02/02/98) 137 City Services Utilities Water 43.99 17,97
02/02/98 \ 138 Valley Gas Utilities Heating 47.99 17,92
02/02/98 139 UPS Shipping S7.08 17,86

summary record for January 1998

02/23/93 175 Staples Office Supplies 41.30 12,53 l
02/27/98 DEPOSIT DEPOSIT 5,22299 17,75
02727798

03/02/9 176 ATE&T Telecom Long Distance Phone Sery 257.15 17,49
03/02/93 177 General Casualty  Insurance Property Insurance policy 187.50 17,31

summary record for February 1998

e e o e e e e e mem— e s S
03/30/98 219 Post Office Shipping 305.84 14,26
03/30/798 220 Airborne Shipping Invoice 84971 33.19 14,23
03730798

04/01/98) 221 City Services Utilities “Water 4965 14,18
04/01/98"\ 222 Surf MNetworks Telecom DSL S0.00 14,13

summary record for March 1998

12/21/798 559 Fry'sElectronics  Office Supplies 189.22 13,68
12/25/98 DEPOSIT DEPOSIT 5,264.90 18,94
12728798  S60 Valley Publications Advertising 963.57 17,98
12728798 561 Poly Payroll Servii Payroll 1,749.38 16,230
12728798 ‘;
- ;

summary record for April 1998

summary record for grand total
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Now click anywhere in the Category column, then choose Group Up from the Sort menu. Panorama will cre-
ate a summary record after each category within each month.

® O 6 My Checkbook
L | Date Checl Pay To Category Memo Debit Credit Bal 4
m 01/19/98 130 FedEx Shippin Invoice 75951 160.97 11,24 l
01/19/98 132 Champion Trucking Invoice 26309 171.79 10,94
‘ Shippin m
| 01701798 103 AT&T Telecom Long Distance Phone Servy 236.24 11,46
01/01/798 104 Surf Networks Telecom DSL S0.00 11,41
= 01/01/798 110 Valley Bell Telecomn Local Phone Service 136.95 9,35
! Teleco
y | 01/01/98 102 WYalley Gas Utilities Heating 43.90 11,69
—| 01/01/928 105 United Security Utilities Alarm 20.00 11,38
----- 01701798 107 Edison General Utilities January Electric 11555 11,12
_____ 01701798 108 City Services Utilities Water 54.39 11,06
Utilities
01730/9 »
02/09/98 154 VYalley Publications Advertising 923.74 14,69
02/09/98 \ 159 Power Printing Advertising 654.04 11,52 v

summary record for January 1998

i | o2/02/98 141
02/02/98 145

c | 02/02/98 137
y | 02/02/98 138
=1 02/02/98 142
02/02/98 149

0272779
03/02/98 ) 190

03/02/98 193

03/02/98 183
03/02/98 185
03/02/98 191
03/02/98 197

03/30/98

summary record for March 1998

12/01/98 534
12/01/98 535

12/01/98 526
12/01/98 532
12/01/98 533
12/01/98 537

I:f28!§

ATET
VYalley Bell

City Services
Valley Gas
United Security
Edison General

Yalley Publications Advertising

Valley Bell

Valley Gas
Edison General
United Security
City Services

Valley Bell
Surf Networks

Edison General
Valley Gas

City Services
United Security

summary record for grand total

659 visible /659 total

Telecom
Telecom
Teleco
Utilities
Utilities
Utilities
Utilities
Utilitie

Telecom
Telecom
Utilities
Utilities
Utilities
Utilities
Utilitie

04713793 K 241 Foundation Web Ser Advertising

Telecom
Telecom
Teleco
Utilities
Utilities
Utilities
Utilities
Utilitie

summary record for December 1998

Long Distance Phone Serv
Local Phone Service

“Water

Heating

Alarm

February Electric

summary record for February 1998

Local Phone Service

Heating

March Electric
Alarm

Water

Loc;I Phone Service
DSL

December Electric
Heating

Water

Alarm

251.56 17 .46\
112.05 17,04
48.99 17,97
47.99 17,92
20.00 17,43
109.06 15,45
1,051.99 10,57

147.80

2423
105.50
30.00
49.23

702.99

123.25
S50.00

94 .07
39.59
97.52
20.00

summary records for categories within January

summary records for categories within February’

10,21

13,88
13,71
10,54

9,32

N—

15,41 4

summary records for categories within March

summary records for categories within December
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Once the summary records are set up, you’re ready to actually calculate the subtotals. Click anywhere in the
Debit column and choose Total from the Math menu. The Total command will calculate a grand total, subto-
tals for each month, and subtotals for each category within each month.

® O 6 My Checkbook
I~ | Date Checl Pay To Category Memo Debit Credit Bal 4
v
m=| 01719798 130 FedEx Shipping Invoice 75951 : 11,24 .
) 01719498 132 Champion Trucking Shipping Invoice 26302 Jan shipping 171.79 10,94
- Shipping 4039 m
| 01701798 103 AT&T Telecom Long Distance Phone Serv 236.24 11,46
01/01/798 104 Surf Networks Telecom DSL S0.00 11,41
1 01701798 110 Valley Bell Telecom Local Phone Service 136.95 9,35
! Telecom 23.19
, | 01701798 102 Valley Gas Utilities Heating Jan telecom 49.90 11,69
—{ 01/01/798 105 United Security Utilities Alarm 20.00 11,38
| 01701798 107 Edison General Utilities January Electric 11555 11,12
01/01/798 108 City Services Utilities Water g 54.39 11,06
, Utilities Jan utilities .04
| 01730798 17,202.48 -
02/09/98 154 Valley Publications Advertising 23.74 14,69 *
02/09/98 159 Power Printing Advertising 54.04 11,52 v
subtotal for January 1998
1 02702798 141 AT&T Telecom Long Distance Phone Serv 251.56 1?:46
| 02/02/98 145 Valley Bell Telecom Local Phone Service 113.05 17,04
: Telecom ’51 4.61
1 02/02/98 137 City Services Utilities Water Feb telecom 48,99 17,97
| 02/02/98 1328 Valley Gas Utilities Heating 47.99 |7y ek
02/02/93 142 United Security Utilities Alarm 30.00 17,43
1 02/02/93 149 Edison General Utilities February Elec! op tilities 109.06 15,45
Utilities 36.05
02727798 19,773.29
03/02/93 190 Yalley Publications Advertising 1,051.99 10,57
subtotal for February 1998
03/02/98 193 Valley Bell Telecom Local Phone Service 147.280 10,21\
— Telecom ’454.94
| 03/02/98 183 Valley Gas Utilities Heating Mar telecom 24.23 13,88
03/02/938 185 Edison General Utilities March Electric 105.50 13,71
—{ 03/02/98 191 United Security Utilities Alarm 30.00 10,54
03/02/938 197 City Services Utilities Water g 49.23 9,32
Utilities Mar Utiities —m »og 95
03/30798 21,908.19
04713798 241 Foundation Web Ser Advertising 702.99 15,41 \;
subtotal for March 1998
X | 12/01/98 534 Valley Bell Telecomn Local Phone Service 123.25 16,40
'.’ 12/01/798 535 Surf Networks Telecom DSL S0.00 16,35
- Telecom ’449.00
Ly | 12/01/98 526 Edison General  Utilities December Elec DEC Telecom 94.07 18,26
m 12/01/798 532 Valley Gas Utilities Heating 3959 16,58
=2 12701798 533 City Services Utilities Water 57.52 16,53
M| 12/01/98 537 United Security  Utilities Alarm Dec utilities 30.00 14,74
m Utilities 22117 m
2| 12728798 8,053.95
subtotal for December 1998 225 677.47 B
v
659 visible /659 total <> (&) <> 4

Grand Total
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Hiding and Showing Detail

It’s difficult to get a feel for the subtotals when they are mixed in with the raw data. To collapse the database
so that only the monthly totals are visible, choose the Outline Level command in the Sort menu.

_File Edit View Fields Text Search [Tl Math Setup Wizards [ & |

®O06 My Sort Up BU N
| Date Checl Pay To Category Sort Up Within Credit  Bal*
12/14/98 549 Post Office Shipping 15,90
w= | 12721798 556 Post Office Shipping Sort Down 16,07
: _ Shipping
| 12701798 s27 ATET Telscom Sort Down Within 17,99
12701792 534 Valley Bell Telecom 16,40
12/01/98 535 Surf Networks Telecom Group Up 16,35
Telecom
12/01/98 526 Edison General  Utilities Group Down 18,26
12401798 532 Valley Gas Utilities Group 16,58
2| 12701798 533 City Services Utilities - 16,53
| 12/01/98 537 United Security  Utilities 14,74
' Utilities Sort by Color q
R gl . Group by Color i
659 visible /653 total Outline Level...

Remove Summaries...
Remove Detail...

Toggle Summary Level
T —

The Outline Level dialog shows how you have grouped the data. At the top is the raw data, all 515 records.
The next level is the Category, then the monthly summaries. At the bottom level is the grand total. To collapse
the database so that only the monthly totals are visible, press the 2 button.

Qutline Level

Cancel

515 records
Category 131 records

a Date (by month) 12 records
3 ) GRAND TOTAL 1 record




Page 95

When you press the button the database collapses so that only the twelve monthly totals and the grand total
are visible. Everything else is hidden. You can quickly see that March was the month with the highest spend-
ing and July the month with the lowest spending.

®O6 My Checkbook
|
I I | Date Checl Pay To Category Memo Debit Credit Bal,‘
| 01730798 17,202.48 ¥
| 02427798 19,773.29
03730798 21,908.19
| 04727798 17,708.77
* | 05729798 20,072.21
~| 06729798 18,958.28
| 07731798 15,803.58
08731798 21,410.34
— 09728798 16,210.08
'i| 10730798 17,991.62
xzz| 11730798 20,584 .69
4 12728798 |'8l053.95 m
A

13 visible /659 total >4 (=)

Why was the spending almost 22,000 dollars in March? To find out, click anywhere on the March summary
record.

13 visible /659 total

® O 6 My Checkbook
7 | Date Checl Pay To Category Memo Debit Credit Bal 4
22| 01730798 17,202.48 3
v | 02727798 19,773.29
03/C /98| 21,908.19
| 04727798 17,708.77
* | 05/29/98 20,072.21 m
— 06729798 18,958.28
Now click on the Expand tool.
® OO My Checkbook
|
I | Date Checl Pay To Category Memo Debit Credit Bal,‘
2% 01730798 17,202.48 ¥
Wi | 02727798 19,773.29
- 21,908.19
| 04727798 17,708.77
& | 05/29/98 20,072.21 m!
— 06729798 18,958.28
| 07731798 15,803.58
, | 08731798 21,410.34
=—aataalog 16,210.08
J;'g 2 o 17,991.62
= 11730798 20,584 .69
12728798 18,053.95 |
225,677.47 Yy




Page 96 Panorama Handbook

The Expand tool reveals the next level of detail, in this case the Category summaries for the month of March.

®O6 My Checkbook
L | Date Checl Pay To Category Memo Debit Credit Bal 4
=h| 01730798 17,202.48 b
02727798 19,773.29
» Advertising 2,202 67
DEPOSIT 0.00
Fixed Assets 1,363.94 m
Insurance 1,254.50
Office Suppli 1,043.33
Payroll 9,123.23
Purchases 3,447.93
Rent 1,580.00
Shipping 1,228.69
: Telecom 454 94
» " Utilities 208.95 -
03730798 | ' 121,908.19 3
04/27/98 17,708.77 v
24 visible /659 total Ja|(» g

To see the actual checks that make up a particular category, just click on the category and then choose the

Expand tool again.

®06 My Checkbook

A | Date Checl Pay To Category Memo Debit Credit Bal 4
=| 01730798 17,202.48 3

02727798 19,773.29

. Advertising 2,202.67
DEPOSIT 0.00 w

Fixed Assets 1,363.94

Insurance 1,254.50

Office Suppli 1,043.33

Payroll 9,123.23

[Purchases | 5,447.93

Rent 1,580.00

Shipping 1,228.69

Telecom 454 94
Utilities 208.95 -
03730798 ' '21,908.19 2
04727798 i'?f_,?@,ﬁ.?? L 4
24 visible /659 total Rl
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Now the actual checks are visible for each purchase in March.

®O6 My Checkbook
| Date Checl Pay To Category Memo Debit Credit Ba *
Payroll 9,123.23 ,I
| 03/02/98 178 Oregon National En¢ Purchases Invaice 64191 205.77 17,10
- 03/02/98 181 Tech Media Purchases Invoice 8910 956.72 15,49
| 03/02/98 194 Precision Plastics Purchases Invoice 104823 492 49 9,72
03/09/98 198 Clark Supply Purchases Invoice 47372 31844 13,33
= 03/09/92 200 Telon Productions Purchases Invaice 26984 26512 12,95%
| 03716798 206 Clark Supply Purchases Invoice 73927 328.26 14,34
03/16/98 207 Oregon National En¢ Purchases Invoice 73173 336.09 14,00
-| 03/30/98 214 Telon Productions Purchases Invoice 18763 326.98 17,20
=2 03/30/98 215 Precision Plastics Purchases Invoice 42862 411.58 16,79
1z2| 03/30/98 218 Miller Industries  Purchases Invoice 47187 200.48 14,56
- Purchases 3,447 .93
Rent 1,580.00
Shipping 1,228.69
Telecom 454 .94
Utilities 208.95
03/30/98 21,908.19 -
04727798 17,708.77 13
05729798 20,072.21 Y
34 visible /659 total |« » )4 (>
If you want to hide the detail again use the Collapse tool.
®O6 My Checkbook
Date Checl Pay To Category Memo Debit Credit Ba *
P Payroll 9,123.23 ,I
o | 03/02/928 178 Oregon National En¢ Purchases Invoice 64191 205.77 17,10
\ [T 03/02/98 181 Tech Media Purchases Invoice 8210 296.72 15,49
' 03/02/98 194 Precision Plastics Purchases Invoice 104823 492 49 9,72
03/09/98 198 Clark Supply Purchases Invoice 47372 31844 13,33
5 03/09/928 200 Telon Productions Purchases Invaice 26984 26512 12,95%
' 03/16/98 206 Clark Supply Purchases Invoice 73927 328.26 14,34
| 03/16/98 207 Oregon National En¢ Purchases Invoice 73173 336.09 14,00
=| 03/30/98 214 Telon Productions Purchases Invoice 18763 326.98 17,20
Z| 03/30/98 215 Precision Plastics Purchases Invoice 42862 411.58 16,79
Az 03/30/98 218 Miller Industries Purchases Invoice 47187 200 .48 14,56
2o = Purchases 3,447 .93
)| Collapse ! Rent 1.580.00
: Shipping 1,228.69
Telecom 454 .94
Utilities 208.95
03/30/98 21,908.19 -
04727798 17,708.77 13
05729798 20,072.21 Y
34 visible /659 total | RARa Y| >

To learn more about expanding and collapsing summaries see “STEP 3 - OUTLINE” on page 537.
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Sorting Summaries by Value

Summary records are normally sorted alphabetically by category, but you can resort them by value to pro-
duced a ranked list from highest to lowest. As an example we’ll sort the Category subtotals within each
month to find out the highest spending categories in each month. Start by choosing the Outline Level com-
mand from the Sort menu, then press the 1 button.

Qutline Level

Cancel

515 records

( 1 Q Category
Date (by month)

GRAND TOTAL

131 records
12 records

1 record

Now both the monthly and category summaries are visible, but the raw data is not visible. The category sum-
maries are sorted alphabetically within each month (the window has been expanded to show three months
worth of data).

®O6 My Checkbook
\ | Date Checl Pay To Category Memao Debit Credit Bal: 4 [
g 1,114.85 h :
DEPOSIT 0.00 m
Insurance 1,254.50 '
Office Suppli 614.01
Payroll 7,319.30
Purchases 4,106.41
Rent 1,580.00
Shipping 540.39
Telecom 42319
Y utitities 249 .84
| 01730798 17,202.48
Advertising 3,874.92
DEPOSIT 0.00
Fixed Assets 1,974.81
Insurance 1,254.50
Office Suppli 938.45
Payroll 6,966.12
Purchases 2,135.08
Rent 1,580.00
Shipping 298.76
v Telecom 514.61
' Utilities 236.05
02727798 19,773.29
Advertising 2,202.67
DEPOSIT 0.00
Fixed Assets 1,363.94
Insurance 1,254.50
Office Suppli 1,043.33
Payroll 9,123.23
Purchases 3,447 .93
Rent 1,580.00
Shipping 1,228.69
v Telecom 454 .94 -
Utilities 208.95 A
03/30/98 21,908.19 i
Advertisina 2.631.00 A
144 visible /659 total I ERE l4 > ’
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Now click anywhere in the Debit column, then choose Sort Down from the Sort menu. We’re using Sort
Down instead of Sort Up because we want the largest values at the top.

View Fields Text Search Math Setup Wizards = O = 4)

1966 | SortUp ®U | |
7 Checl Pay To . Sort Up Within “ Debit Credit ~ Bal* 5
0.00 4
% Sort Down Within e 0
1 Group Up . 4,106.4

! 1,580.00

| Group Down | 540.39

| 249 84

click on Debit field before sorting

Within each month, the Category subtotals are now sorted by value from highest to lowest. Now you can eas-
ily see that payroll is the largest spending category in each month. Rent and advertising are consistently near
the top, while telecom and utilities are consistently near the bottom.

® OO0 My Checkbook
\ | Date Checl Pay To Category Memo Debit Credit Bal: 4 i
: |
Payroll A 4
Purchases 4,106 .41 m
Rent 1,580.00
Insurance 1,254.50
Adrvertising 1,114.85
Office Suppli 614.01
Shipping 540.39
Telecom 423.19
Utilities 249 84
DEPOSIT 0.00
| 01730798 17,202.48
: Payroll 6,966.12 A
Advertising 3,874 .92
Purchases 2,135.08
Fixed Assets 1,974 .81
Rent 1,580.00
Insurance 1,254.50
Office Suppli 938.45
Telecom 514.61
Shipping 298.76
Utilities 236.05
' DEPOSIT 0.00
02727798 19,773.29
Payroll 9,123.23 A
Purchases 3,447.93
Adrertising 2,202.67
Rent 1,580.00
Fixed Assets 1,363.94
Insurance 1,254.50
Shipping 1,228.69
Office Suppli 1,043.33
Telecom 454 .94
Utilities 208.95
DEPOSIT 0.00 A
03/30/98 21,908.19 ;
; Pavroll 6.726 .87 Yl
144 visible/659 total é
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If you’d like to see more detail about a particular summary just click on it and press the Expand tool.

01730798

When Panorama sorted the summary records by value it also moved the corresponding data records so that
you can expand to see the detail. Within each summary the data records have not been sorted by value, they

Payroll
Advrertising
Purchases
Fixed Assets
Rent
Insurance
Telecom
Shipping

are still sorted in their original order (by date).

17,202.48

6,966.12
3,874.92
2,135.08
1,974 .81
1,580.00
1,254.50
938.45
514.61
298.76

W

To learn more about sorting summary values see “Sorting Within Groups” on page 549.

® 06 My Checkbook
\ | Date Checl Pay To Category Debit Credit Bal: 4 ;
Insurance 1,254.50 Z
Advertising 1,114.85
Office Suppli 614.01
Shipping 5940.39
Telecom 42319 ‘
Utilities 249 .84 m
DEPOSIT 0.00 !
01/30/98 17,202.48
Payroll 6,966.12
Advertising 3,874.92
Purchases 2,135.08
Fixed Assets 1,974.81
Rent 1,580.00
Insurance 1,254.50
02702798 150 Sparkletts Office Supplies 13.98 15,43¢
02/09/98 153 Fry's Electronics  Office Supplies 192 .48 15,61¢
02/09/98 156 Office Max Office Supplies 129.61 14,24¢
02/09/92 1860 Costeo Office Supplies 20860 11,31¢
02/16/98 161 Fry's Electronics  Office Supplies 166.74 16,391
02/16/98 189 Kinko's Office Supplies 5223 9,752
02/23/98 172 Kinko's Office Supplies 133.51 12 ,66¢
02723798 175 Staples Office Supplies 41.30 12,532
(Office Supplil 938 45
Telecom S514.61
Shipping 298.76
Utilities 236.05
DEPOSIT 0.00
02727798 19,773.29
Payroll 9,123.23
Purchases 3,447.93
Adrvertising 2,202.67
Rent 1,580.00
Fixed Assets 1,363.94 -
Insurance 1,254.50 Al
Shipping 1,228.69 i
Office Sunpli 1.043.33 )/
152 visible /659 total 1
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Removing Summary Records

Summary records are designed to be temporary. When you are done examining the summary records you
need to remove them to restore the database to it’s original state. To do this choose the Remove Summaries
command from the Sort menu. As you can see from the illustration, it doesn’t matter whether the summary
records are expanded or collapsed when you choose this command. The Remove Summaries dialog allows

you to delete some or all of the summary records in the database.

Remove Summaries

Warning: No Undo!

( Remove ALL Summaries ) ( Cancel )

Debit

131 records
12 records

1 record

Since you want to remove all of the summary records press the Remove All Summaries button (or press the
Enter key). This removes all of the summary records and leaves only the original data records. (If you want to
learn how and why you would delete only some of the summary records see “Getting Rid of Summary
Records” on page 549).

J

®O6 My Checkbook

\ | Date Checl Pay To Category Memao Debit Credit Bal: 4 ‘l

- ‘v |

| 01705798 114 Poly Payroll Servi (N3] 1,817.32 13,071 b I

01/12/98 123 Poly Payroll Servic Payroll 1,833.80 11,686 |
01/19/98 127 Poly Payroll Servi Payroll 1,874.76 11,632
01/26/98 136 Poly Payroll Servic Payroll 1,793.43 13,35¢
01/05/98 115 Oregon Mational En¢ Purchases Invoice 35661 186.36 12,88¢
1 017054928 117 Boston Direct Purchases Invoice 57540 185.96 12 ,64¢
01/05/98 118 Precision Plastics Purchases Invoice 60632 459.86 12,18¢
01/05/92 119 Tech Media Purchases Invoice 48536 336.67 11,852
= 01/05/98 120 Miller Industries  Purchases Invoice 90513 361.90 11 49C
; 01/05/98 122 Anderson Manufact Purchases Invoice 17730 627.98 9,745
; 01712798 124 Anderson Manufact Purchases Invoice 79066 251.22 11,135
} 01/12/98 125 Clark Supply Purchases Invoice 91494 387 A5 10,745
' 01/19/98 126 Tech Media Purchases Invoice 77138 350.01 13,508
‘ 01/19/98 129 Clark Supply Purchases Invoice 13589 160.71 11 ,40¢
01/26/98 134 Stamford Mfg Purchases Invoice 98266 498.59 15,19%
01/01/98 109 Pacific Properties Rent January Rent 1,580.00 9.,48¢<
01/01/98 101 Blue Cross Insurance Health Insurance group XE 975.00 11,74¢
\ 01/01/98 111 General Casualty  Insurance Property Insurance policy 187.50 9,165
' 01/01/98 112 Hamilton Davis Insurance Worker's Comp policy 81 92.00 9,07z
01/05/98 121 Cool Creek Studiic  Advertising 1,114.85 10,37¢
01/01/98 100 Sparkletts Office Supplies 14.20 12,72¢
‘ 01/05/98 113 Office Max Office Supplies 170.47 14 ,88¢
' 01/05/98 116 Kinko's Office Supplies 50.03 12,83¢
01/19/98 131 Staples Office Supplies 126.83 11,121
; 01/19/98 133 Costco Office Supplies 207.23 10,74%
} 01/26/98 135 Kinko's Office Supplies 45.24 15,152
' 01701798 106 UPS Shipping 144 .02 11,23
01/19/98 128 Airborne Shipping Invaice 16582 63.61 11,57C
‘ 01/19/98 130 FedEx Shipping Invoice 75951 160.97 11,24¢
01/19/98 132 Champion Trucking Shipping Invoice 26309 171.72 10,24<
| 01/01/98 103 ATE&T Telecom Long Distance Phone Sery 236.24 11 463
' 01/01/98 104 Surf Networks Telecom DSL S0.00 11,413
01701798 110 Malley Bell Telecom Local Phone Service 136.95 9,352

01/01/98 102 Valley Gas Utilities Heating 49.90 11,698 :
01/01/98 105 United Security Utilities Alarm 30.00 11,383 -
‘ al Utilities January Electric 115.55 11.12¢ 7 |
515 visible /515 total 4/|»{ é B RE S

=1
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Although the summary records are gone, the database still isn’t quite back to its original state. Instead of the
entries being sorted by date they are still sorted by category within each month. To get back to the original
order click anywhere in the Date field and choose Sort Up from the Sort menu.

View Fields Text Search Math Setup Wizards = 9 = )

®66 Sort Up N €U L
P | pate Cheel Pay To | Sort Up Within | Debit Credit  Bal 4 |
2| 01/05/98 114 Paly Payroll Ser | 181732 '13,0?1'1
01712798 123 Poly PayrollSet  Sort Down 1,833.80 11,68¢1 |
IPSEYEEN 127 Poly Payroll Ser b 1,874.76 11,6332
01/26/93 136 Poly Payroll Ser Sort Down Within 1,793 .43 13,35¢
| 01/05/98 115 Oregon Mational 186.36 12,88¢<
1 01/05/98 117 BostenDirest |  Group Up 185.96 12 ,64¢
| 01/05/98 118 Precision Plastit 459 26 12,18¢
Ly | 01/05/98 119 Tech Media ; Group Down 336,67 11,852
=1 01/05/98 120 Miller Industries  Group 361.90 11,49C
01/05/98 122 Anderson Manufl 627.98 .74

The database still isn’t quite back in the original order. Originally the check numbers were sorted within each
day.

® O 6 My Checkbook
| Date Checl Pay To Category Memo Debit Credit Bal: 4
o ANAOWE-I 109 Pacific Properties Rent January Rent 1,580.00 9,48¢ 3
01/01/98 101 Blue Cross Insurance Health Insurance group XE 975.00 11 ,745@
1 01701798 111 General Casualty  Insurance Property Insurance policy 187.50 9,165
| 01/01/98 112 Hamilton Davis Insurance Worker's Comp policy 81° 92.00 9,07z
01701798 100 Sparkletts Office Supplies 14.20 12,72¢
1 01/01/798 106 UPS Shipping 144.02 11,235
Pl 01701798 103 AT&T Telecom Long Distance Phone Serv 236.24 11,463
y | 01701798 104 Surf Networks Telecom DSL =0.00 11,41z
— 01/01/98 110 Yalley Bell Telecom Local Phone Service 136.95 9,352
01701798 102 VYalley Gas Utilities Heating 49.90 11,69¢
01701798 105 United Security Utilities Alarm 30.00 11,383
01701798 107 Edison General Utilities January Electric 1| === 11,12¢
01701798 108 City Services Utilities “Water 54.39 11,06¢
01701798 OPENING BEALANCE DEPOSIT 12,739.00 12,73
01/02/98 DEPOSIT DEPOSIT 5,985.82 15,05¢
01/05/92 114 Poly Payroll Servin Payroll 1,817.32 13,071

To fix this problem click anywhere in the Check column and choose Sort Up Within (see “Sorting By Two or
More Fields” on page 18).

View Fields Text Search Math Setup Wizards = 9 = )

866 . Sort Up BU L
Wl Date Checl Pay To W Debit Credit  Bal: * |
. ' =hd

| 01701798 109 Pacific Propertil | 1,580.00 2,48¢,.. |
01701798 101 Blue Cross é Sort Down E 975.00 1,74%m
01/01/98 111 General Casualt PR . 187.50 9,165 )
01/01/38 112 Hamilton Davie, 0Tt DOWN Within 92.00 9,07 |
& | 01/01/98 100 Sparkletts 14.20 12,72¢
= 01/01/98 106 UPS ’ Group Up 144 .02 11,23¢
J 01/01/98 103 AT&T 236.24 11,463
01/01/93 104 Surf Metworks Group Down $0.00 11,413
— 01/01/98 110 VYalley Bell Group 136.95 9,352
01/01/98 102 Valley Gas 4990 11,69¢
01/01/98 105 United Security 30.00 11,382
01/01/98 107 Edison General Sort by Color 115.55 11,12¢
01/01/98 108 City Services 54.39 11,06
01/01/98 | OFPENING BALANI Group by Color 12,732.00 12,73¢
01/02/98 DEPOSIT | 5,985.82 15,05¢
01/05/98 114 Poly PayroliSet  Qutline Level... 1,817.32 13,071
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Now all of the data is back to its original order.

® O 6 My Checkbook

\ | Date Checl Pay To Category Memo Debit Credit Bal: 4 ‘,

o ‘|

| 01701798 [ OPENING BEALANCE DEPOSIT 12,739.00 12,735

017017928 100 Sparkletts Office Supplies 14.20 12,7244 )
01/01/98 101 Blue Cross Insurance Health Insurance group XE a75.00 11,74<
017017928 102 Valley Gas Utilities Heating 49.90 11,69¢
01701798 103 AT&T Telecom Long Distance Phone Sery 236.24 11 463
1 01/01/928 104 Surf Networks Telecom DSL S50.00 11,413
01/01/98 105 United Security Utilities Alarm 20.00 11,383
01/01/92 106 UPS Shipping 144.02 11,23¢
— 01/01/98 107 Edison General Utilities January Electric 11555 11,12¢
01/01/928 108 City Services Utilities Water 54 .39 11,06<
; 01/01/98 109 Pacific Properties Rent January Rent 1,580.00 9,43¢
i 01/01/98 110 Valley Bell Telecom Local Phone Service 136.95 9,352
' 01/01/98 111 General Casualty  Insurance Property Insurance policy 187.50 9,165
‘ 01/01/98 112 Hamilton Davis Insurance Worker's Comp policy 81° 92.00 9,07z
01/02/98 DEPOSIT DEPOSIT 5,985.82 15,05¢
01705792 113 Office Max Office Supplies 170.47 14,88¢
01705798 114 Poly Payroll Servin Payroll 1,817.32 13,071
\ 01/05/98 115 Oregon National En¢ Purchases Invaice 35661 186.36 12,88¢
. 01/05/98 116 Kinko's Office Supplies 50.03 12,83¢
01/05/98 117 Boston Direct Purchases Invoice S7540 185.96 12,648
01/05/98 118 Precision Plastics Purchases Invoice 60632 459.86 12,18¢
’ 01/05/98 119 Tech Media FPurchases Invaice 48536 33667 11,852
' 01/05/98 120 Miller Industries  Purchases Invoice 90513 361.90 11 ,49C
01/05/928 121 Cool Creek Studiio Advertising 1,114.85 10,37¢
; 01/05/98 122 Anderson Manufact Purchases Invoice 17730 627,98 9,745
i 01/09/98 DEROSIT DEPODSIT 3,77242 13,52C
' 01712798 123 Poly Payroll Serviv Payroll 1,833.80 11,68¢
01/12/98 124 Anderson Manufact Purchases Invaice 79066 551.22 11,138
‘ 01/12/98 125 Clark Supply Purchases Invoice 291494 38715 10,745
01/16/98 DEROSIT DEPDSIT 3,11056 13,858
| 01/19/98 126 Tech Media Purchases Invoice 77138 350.01 13,508
' 01/19/928 127 Poly Payroll Servit Payroll 1,874.76 11,632
01/19/98 128 Airborne Shipping Invoice 16582 63.61 11,57C

01/19/98 129 Clark Supply FPurchases Invaice 13589 160.71 11,405 ,

01719798 130 FedEx Shipping Invaice 75951 160.97 11,24¢ t

01/19/98 131 Staples Office Supplies 126.83 111217 ,

515 visible /515 total 4 > é )4 | » ;,_-'E

With a little bit of advance preparation you can make it much simpler to restore the original database order
after grouping summary records (assuming that you care what order the records are in — in many cases you
won’t. One technique would be to Save the database just before using the Group command, and then use the
Revert to Saved command when you are done (see “Revert to Saved” on page 261). Another technique
would be to create an extra field and fill the field with a numeric sequence (1, 2, 3, etc.) using the Sequence
command (see “Automatic Numbering” on page 592). After you remove the summaries you can simply sort
by this numeric field to restore the original order.
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Automating Tasks with Procedures

Right out of the box, Panorama is a very flexible program. Its built in menus and tools bring incredible power
to your fingertips. Even better, you can easily create your own commands that can be activated with a menu
or button. You can create these commands (called procedures) using Panorama’s built in programming lan-
guage or simply by recording each step with the built in recorder. To start recording a procedure just click on
the Record Procedure tool. The wheels of the recorder will start to spin to let you know that Panorama is
recording your actions (see “Creating a Procedure with the Recorder” on page 1476).

SHaNE) My Checkbook
1P| pate Checl Pay To Category ‘Memo Debit Credit Balance *
. " ' H
28| Record Procedure Y paance peposiT 12,739.00 12,739.00 ..
oeth 01701798 100 Sparkletts Office Supplies 14.20 12,724.80 [T
01701798 101 Blue Cross Insurance Health Insurance group XBG- 975.00 11,742.80 W
| 01701798 102 Valley Gas Utilities Heating 49.90 11,699.590

Your job is to create procedures that automate the summary process you just learned. With the recorder run-
ning (make sure the reels are spinning) perform the following steps (the same steps you just performed, see

“Calculating Subtotals” on page 90).

Step

Action

1

Click on the Date field.

Choose Group Up from the Sort menu.

Choose the Month option.

Click on the Group button.

Click on the Category field.

Choose Group Up from the Sort menu.

Click on the Debit field.

Choose Total from the Math menu.

O oI N OO Bl W| DN

Choose Outline Level from the Sort menu.

(BN
o

Click on the 2 button.

When you’ve finished with these steps press the Record Procedure tool again. This stops the recording.

®O6 My Checkbook
| Date Checl Pay To Category Memao Debit Credit Balance * |
22| Record Procedure ! Y|
ot 02/27798 19,773.29 '
03/30/98 21,908.19 m
04727798 17,708.77 ‘
05729798 20,072.21
— 06/297/98 18,958.28
07731798 15,803.58
08731798 21.,410.34
—1| 09/28/98 16,210.08
-=| 10730798 17,991.62
== 11730798 20,584.69
1 12728798 18,053.95
225,677.41

13 visible /659 total

e
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After you stop the recorder a dialog box will appear. Type in the name of the new procedure (in this case
Month & Category Totals) and press the Save Procedure button.

Save Recording

New procedure name...

Month & Category Totals|

C Cancel ) C Save Procedure )

Next you’ll create another procedure to remove the summaries and restore the original order of the data (see
“Removing Summary Records” on page 101). Start by turning the recorder back on again.

® 06 My Checkbook

Date Checl Pay To Category Memao Debit Credit Balance *
‘£%{ Record Procedure | | [ 17,202 48| ' X
| Qg 02{27198 19,773.29
—— 03/30/98 21,908.19 m
With the recorder running perform the following steps.
Step Action
1 Choose Remove Summaries from the Sort menu.
2 Click on the Remove ALL Summaries button.
3 Click on the Date field.
4 Choose Sort Up from the Sort menu.
5 Click on the Check field.
6 Choose Sort Up Within from the Sort menu.
When you’ve finished with these steps press the Record Procedure tool again to stop the recording.
®06 My Checkbook
WP Date Checl Pay To Category Memo Debit Credit Balance *
s ‘ dure L., siudiio Advertising 1,114.85 10,375.66
o | 01/05/798 122 Anderson Manufact Purchases Invoice 17730 627.98 2,747.68
o 01712798 123 Poly Payroll Servi Payroll 1,833.80 11,686.30 m

Panorama will ask you to give this procedure a name of its own.

Save Recording

New procedure name...

Restore Original Data

( Cancel ) ( Save Procedure )

Before you go any further you should Save your database with the new procedures you just created.
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Using the Action Menu

If you look closely you’ll see that a new menu has appeared — the Action menu. This menu contains the two
procedures you just recorded.

View Fields Text Search Sort Math Setup Wizards © . <)
O 6 My Checkbook . Month & Category Totals
Date Checl Pay To Category Memao | Restore Original Data !

—

B UL 0 L T -

Pl e e T DA SN

01/05/98 Cool Creek Studiio  Advertising

md e dam 47" Aedeiaa. = RMecmicfanld Mceabhcmaa leiialae 47N

When you choose a command from this menu it replays the steps that were recorded in the procedure.
Choose the Month & Category Totals command now. Panorama replays the 10 steps in this procedure as fast
as it can — zip zip zip.

®O6 My Checkbook
|| Date ' Checl Pay To Category Memo Debit Credit Balance ‘ |
| 01730798 X
02727798 19,773.29
03730798 21,908.19 m
04727798 17,708.77
* | p5/29/98 20,072.21
= 06729798 18,958.28
07731798 15,803.58
08731798 21,410.34
09728798 16,210.08
10730798 17,991.62
== 11730798 20,584 .69
{ 12728798 18,053.95
225,677.47 -
A
v
13 visible /659 total (=) A

Now choose the Restore Original Data command to quickly remove the summary records and restore the
original data order.

®O6 My Checkbook
| Date Checl Pay To Category Memao Debit Credit Balance * |
| 01701798 | OFPENING BALANCE DEPOSIT 12,739.00 12,739.00 M
01/01/98 100 Sparkletts Office Supplies 14.20 12,72480 [ |
01/01/98 101 Blue Cross Insurance Health Insurance group XBG- 975.00 11,749.80
01/01/928 102 Valley Gas Utilities Heating 43.90 11,692.90
01/01/98 103 ATET Telecom Long Distance Phone Serwvice 236.24 11,463.66
1 01/01/98 104 Surf Networks Telecom DSL 50.00 11,413.66
01/01/98 105 United Security Utilities Alarm 30.00 11,383.66
01/01/98 106 UPS Shipping 144.02 11,239.65
= 01/01/98 107 Edison General Utilities January Electric 115.55 11,124.10
01/01/928 108 City Services Utilities Water 54.39 11,069.71
01/01/98 109 Pacific Properties Rent January Rent 1,580.00 9.,489.71
01/01/98 110 Valley Bell Telecom Local Phone Service 136.95 2,352.76
01/01/98 111 General Casualty  Insurance Property Insurance policy Y 187.50 9,165.26
01/01/98 112 Hamilton Davis Insurance Waorker's Comp policy 8172 92.00 2,073.26 A
01/02/98 DEPOSIT DEPOSIT 5,985.82 15,05%.08 «
| 515 visible/S15 total ] < » ¢ (=) REW,

To learn more about the Action menu see “The Action Menu’ on page 1586.
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Editing a Procedure

To see what is inside a procedure open the procedure with the View Menu.

File Edit U Fields Text Search Sort Math Setup Action Wizards O [

3= Data Sheet “heckbook -
Design Sheet Memo Debit Credit Balance *
Flash Art Scrapbook i | 12,729.00 12,739.00 o
. 14.20 12,724.80
New Form... ‘Health Insurance group XBG- 975.00 11,742.80
New Crosstab. .. ‘Heating 49.90 11,699.90
d Long Distance Phone Service 236.24 11,463 .66
New Procedure... DSL 50.00 11.413.66
Month & Category Totals . e AL00 1558856
— ; 144.02 11,239.65
Restore Original Data January Electric 11555 11,124.10
Water 54.39 11,069.71
perties Rent January Rent 1,520.00 2,429.71

The window switches from the Data Sheet to show the procedure. Each command you recorded appears in a
simple English-like format.

®0 6 My Checkbook:Month & Category Totals

) | Field "Date" A
_ » | GroupUp by Month v
ae| Field "Category" m|

GroupUp
[
x| Field "Debit"

Total

28| outiineLevel ol
A |
v |
Ly |
rY -
A
| ' v
Procedure opened. « >l Jair g

Panorama has hundreds of commands that can be used in a procedure — in fact, it has a complete program-

ming language. The fundamentals of this programming language are described starting with “Introduction
to (Panorama) Programming” on page 1467.
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When you used the Month & Category Totals procedure you may have noticed that the screen flashed over
and over again as the commands were performed. By editing the procedure to add two new commands you
can eliminate the extra unnecessary flashing. Edit the procedure to add the two new commands shown in the
illustration below.

®06 My Checkbook:Month & Category Totals

'ﬁl Field "Category"
GroupUp

= Field "Debit"
X Tota
Aderarosnon
OutlineCevel "2"

&

Procedure OK. <« )alr»r 4

To try out the revised procedure you’ll need to use the View menu to switch back to the Data Sheet.

Filei Edit BMUEYE Search Mark Commands Fields Functions Setup Debug__ Wizards

BCNSN: Data Sheet lonth & Category Totals
bk [ nosh  Design Sheet
> E'::ﬂ Flash Art Scrapbook
: Fielq' New Form...
== Groy New Crosstab...
S Field New Procedure...

-—

e Tota Month & Category Totals
endn Restore Original Data
Outhi

To try out your revised procedure choose it from the Action menu.

ile Edit View Fields Text Search Sort Math Setup Wizards ) [w.

106086 My Checkbook Month & Category Totals

| Date Checl Pay To Category Memo J Restore Original Data ‘
28| 01/01/92 I OPENING BALANCE DEPOSIT ' ' 275000 12,759.00
lowes| 01701798 100 Sparkletts Office Supplies 12.724.20

You’ll notice that the procedure now runs with a minimum of extra flashing. (Actually, on a fast machine it
may be a bit difficult to tell the difference for a procedure as short as this, but it can make a big difference with
a slower machine or a longer procedure.)

Before moving on to the next step in the tutorial you choose the Restore Original Data command and then
the Save command in the File menu to save the revised procedure.
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Analyzing Data with a Crosstab

In addition to the Group command Panorama has another powerful tool for summarizing data — crosstabs.
For your next trick you’ll create a crosstab table that displays spending by category vs. month. To create a
new crosstab view you’ll use the View menu. If you are using a Windows PC hold down the Alt key, if you
are using a Macintosh hold down the Control key. Either way, select New Crosstab from the View menu.

-

—

lle Edit WYENE Fields Text Search Sort Math Setup Action Wizards QJ
Data Sheet Checkbook
Design Sheet Memo Debit Credit  Balance 4
Flash Art Scrapbook i ~ 1,11485 10,37566
Invoice 17730 627.98 2.,747.68
New Form. 2 3,77242 13,520.10
New Crosstab... I 1,833.80 11,686.30
Invoice 79066 551.22 11,135.09
New Procedure... Invaice 91494 387.15 10,747.94
Month & Category Totals = 3,110.56! 13,858.91
4553 . Invoice 77138 350.01 13,508.50
Restore Original Data 1,874.76 11,633.74
Invoice 16582 6361 11,570.12
Invoice 13589 160.71 11,409.41

Type in the name of the new crosstab, in this case Monthly Spending, and then press the OK button.

Create New Crosstab

New crosstab name: __!Insert before:

r

Monthly Spending

’_:_J

( Cancel )C OK

)
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Panorama will create the new crosstab window, and then immediately open the Crosstab dialog. This dialog
contains a list of the database fields on the left hand side. On the right hand side is a list of fields in the
crosstab and a diagram of the crosstab layout (both empty to start).

Crosstab Design

Database Fields Crosstab Fields
Date < »Copy»

Check
Pay To
Category
Memo
Debit Date Formatting

i Period: [ Day "e'!

Balance
Pattern:

([ Remove )

_Crosstab Preview

- diagram of
crosstab layout

O Total
™ Count

( Cancel ) ( OK )
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To tell Panorama to list months across the top of the crosstab click on Date and then press the »Copy» button
(or double click on Date).

Crosstab Design

Database Fields Crosstab Fields
Date ——Copp——Date

Check 3

Pay To (_Remove )

Category

Memo

Debit Date Formatting

Credit ... [ Da e
Balance Period: YaY H
attern:

_Crosstab Preview x

Date

O Total
® Count

( Cancel ) ( OK )

To separate the crosstab into one month per column use the pop-up menu to switch from Day to Month.

Crosstab Design

Database Fields Crosstab Fields
Date ( »Copy» ) Date
Check
Pay To (_Remove 7
Category
Memo
Debit Date Formatting
Credit
Period: Day
Balance Week
Pattern:
uarter
_Crosstab Preview Q g
Year

Date "

O Total
® Count

( Cancel ) ( OK )
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Next you need to specify the field that will appear down the left hand side of the crosstab table. Click on Cat-
egory and then press the »Copy» button (or double click on Category).

Crosstab Design

Database Fields
Date

Check

Pay To

Memo
Debit
Credit
Balance

Next you must specify what goes in the middle of the crosstab table. Click on Debit and then press the

»Copy» button (or double click on Debit).

(_ »Copy» )

_Crosst

Category

Preview

Crosstab Fields
Date

| e
Category S

Date Formatting
Period: ZMO“th H‘]

Pattern: | IMon yy \

Date

O Total
@ Count

Crosstab Design

( Cancel ) ( OK

Database Fields

Date
Check
Pay To

Debit

( »Copy» )

([ Remove |

Crosstab Fields
Date
Category

Debit
Category
Memo

ate Formatting

gﬁffrﬁ: Period: . Month |3
Pattern: | Mon yy \
_ Crosstab Preview
Date
Category ebit
O Total
® Count
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Finally, click the Total radio button so that the crosstab will add up the checks instead of counting them.

_Crosstab Preview

Date

Category Debit

)

Press the OK button. Panorama will think for a few seconds, then the crosstab table will appear in a new win-
dow slightly below and to the right of the data sheet window (see “Opening More Than One Window Per
Database” on page 351). The crosstab table displays a summary of the information in the database, showing
categories down the left hand side and months across the top (see “Crosstabs™ on page 561).

OESNS My Checkbook
NSNS My Checkbook:XTABS:Monthly Spending

SA8H| xtab Jan 98 Feb 98 Mar 98 Apr SB May *
P Y
L) 1,114.85 3,874.92 2,202.67 2,631.00 2,396'@‘
m DEPOSIT 0.00 0.00 0.00 0.00 0
=== Fixed Assets 1,974.81 1,363.94 727.11 2,828
: "!
3 Insurance 1,254.50 1,254.50 1,254.50 1,254.50 1,254
L&
22| Legal 282.44
kx| office Supplies 614.01 938.45 1,043.33  752.83 321
% | Payraoll 7,319.30 6,966.12 9,123.23 6,726.87 7,172
Y
|_A: Purchases 4,1706.41 2,135.08 3,447.93 1,961.64 2,380
| Az Rent 1,580.00 1,580.00 1,580.00 1,580.00 1,580
iy, | Shipping 540.39 298.76  1,228.68 1,106.24 1,486 a
=== Telecom | 423.19 514.61 454.94 451.65 417 v

13 visible /13 total

Just as with the Data Sheet you can adjust the text size and column widths of the crosstab table (see “Adjust-
ing Column Widths, Font and Size” on page 14).

e e My Checkbook:XTABS:Monthly Spending
"A xtab Jan 98 Feb 98 Mar 98 Apr 98 May 98 Jun 98 Jul 92 A |
5.9‘, Advertising 1,114.85 3,874.92 2,202867 2,631.00 2,396.43 2,653.66 1,1928.08 b
4| DEPODSIT 0.00 0.00 0.00 0.00 0.00 0.00 0.00 ml'
- Fixed Assets 1,974 .81 1,363.94 T27.11 2,828.50
C Insurance 1,254 .50 1,254 .50 1,254.50 1,254.50 1,254 .50 1,254 .50 1,254.50
Legal 282.44
=1 Office Supplies 514.01 93245 1,04333 75283 32154 421 .47 &690.04
2= | Payroll 7,319.30 6,966.12 9,123.23 6,726.87 T,17242 2,966.83 6,956 .52
Purchases 4,106 .41 2,135.08 3,447.93 1,961 64 2,380.31 2,567.58 2,264.56
- Rent 1,580.00 1,5280.00 1,580.00 1,580.00 1,580.00 1,580.00 1,580.00
Shipping 540.39 298.76 1,22869 1,106.24 1,426.10 83582 1,136.65
z| Telecom 42319 514.61 454.94 451 65 417.80 402.95 530.83
=1 Utilities 24984 236.05 202.95 234 .49 234 61 21548 192.41
====| TOTAL 17,202.48 19,773.29 21,908.19 17,708.77 20,072.21 18,958.28 15,803.58 2 .
A
v

13 visible /13 total <> 8
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You can split the window into two separate panes by dragging the splitter to the right. The splitter is the
small black rectangle to the left of the horizontal scroll bar (see “Splitting a Window” on page 326).

866

My Checkbook:XTABS:Monthly Spending

Jan 98 Feb 98 Mar 98 Apr 98 May 98 Jun 98 Julgg A
Advertising 1,114.85 3,874.92 2,20267 § 2,631.00 2,396.43 2,653.66 1,1928.08 M
)| DEPOSIT 0.00 0.00 0.00 § 0.00 0.00 0.00 0.00 mf
1 Fixed Assets 1,974 .81 1,363.94 § 72711 2,828.50
Insurance 1,254 .50 1,254 .50 1,254.50 § 1,254.50 1,254.50 1,254.50 1,254.50
Legal . 28244
Office Supplies 514.01 93845 1,043.33 § 75283 32154 421 .47 690.04
Payroll 7,319.30 6,966.12 912323 § 6,726.87 T,17242 8,966.83 6,956.52
y | Purchases 4,106 .41 2,135.08 344793 ¢ 1,961.64 2,380.31 2,567.58 2,264.56
1 Rent 1,580.00 1,580.00 1,580.00 § 1,580.00 1,580.00 1,580.00 1,580.00
Shipping 540.39 298.76 1,22869 & 1,106.24 1,426.10 83582 1,136.65
!;E Telecom 42319 514.61 454.94 ; 451 65 417.80 402.95 530.83
oo Utilities 24984 236.05 20895 § 234 .49 234 61 21548 192.41
17,202.48 19,773.29 21,908.19 7,708.77 20,072.21 18,958.28 15,803.58 2 .

Once the window has been split in two you can horizontally scroll each pane separately. If you scroll all the
way to the right you will see the overall totals for each category.

totals for each category

e O 6 My Checkbook:XTABS:Monthly Spending
xtab Jan 98 Feb 98 Mar 92 Oct 98 TOTAL ‘
Advertising 1,114.85 3,874.92 2,20267 341608 2,60 20,0113 M
)| DEPOSIT 0.00 0.00 0.00 0.00 0.00 mf
1 Fixed Assets 1,274.81 1,363.94 10,222.66
Insurance 1,254.50 1,254.50 1,254.50 1,254.50 1,254, 15,054 .00
Legal 410.02 1,015.09 2,89363
Office Supplies 514.01 93845 1,043.33 792.24 415. 7,42549
Payroll 7,319.30 6,966.12 9,123.23 7,29366 918931 92,219.14
y | Purchases 4,106 .41 2,135.08 3,447.93 1,881.39  2,p30. 29,666 .43
1 Rent 1,580.00 1,580.00 1,580.00 1,580.00 1,580.00 18,960.00
Shipping 540.39 298.76 1,22869 72299 438 11,183.63
Telecom 42319 514.61 454.94 44513 5,450.39
1 Utilities 24984 236.05 208.95 195.59 2,590.70
TOTAL 17,202.48 19,773.29 21,908.19 || 17,991.62 20 58 .95 225,6774
A
v

13 visible /13 total

To learn more about crosstabs see “Crosstabs” on page 561.

«»
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Auditing the Crosstab Table

As you examine a crosstab you may find that you need to check out the backup detail behind a certain num-
ber. Doing this is easy—just click on the number and then click the Select Original Data tool. For example,
suppose you want to see the individual checks written for purchases in November of 1998. Simply click on
the Nov 98 Purchases cell and click on the tool.

& OO My Checkbook
Date ‘Checl Pay To Cateqory Memo Debit Credit Balance *
Jevw| 01/01/98 [ OPENING BALANCE DEPOSIT 12.739.00 12,739.00 |
01/01/98 100 Sparkletts Office Supplies 14.20 12,724.80
1 01/01/798 101 Blue Cross Insurance Health Insurance group XBG- 975.00 11,749.20
01/01/98 102 Valley Gas Utilities Heating 49.90 11,699.20
01/01/98 103 AT&T Telecom Long Distance Phone Service 236.24 11,463.66
01/01/98 104 Surf Netwaorks Telecom DSL S0.00 11,413.66
| 01/01/98 105 United Security Utilities Alarm 20.00 11,383.66
, | 01/01/98 106 UPS Shipping 144 .02 11,239.65
— 01/01/98 107 Edison General Utilities January Electric 115.55 11,124.10
01/01/98 108 City Services Utilities Water 54.39 11,069.71
01/01/98 109 Pacific Properties Rent January Rent 1,580.00 9.,489.71
gljg}ﬁg; e 06 My Checkbook:XTABS:Monthly Spending
‘ | xtab Jan 98 Feb 98 Mar 98 Oct 98 Nov 98 Dec 98 TOTA
Advertising 1.114.85 3,874.92 2,20267 3,416.08 260782 2,52852 30,0113
— Select Ori¢ Dats 0.00 0.00 0.00 0.00 0.00 0.00 0.0
S RS SE 1,974.81 1,363.94 1,063.90 10,2228
| Insurance 1,254.50 1,254.50 1,254 .50 1,254 .50 1,294.50 1,25450 15,0540
| Legal 41002 1,015.09 28936
Office Supplies 614.01 932.45 1,043.33 T92.24 5.42 34914 77,4254
3| Payroll 7,319.30 6,966.12 9,12323 7,293.66 9 31 7,021.21 92,2191
p | Purchases ———— 4 H064+—2713508— 544793 5 : 2,901.53 29,6664
Rent 158000 1,58000  1,580.00 1,58000 1,580.00 1,580.00 18,960.0
Shipping 540.39 298.76 1,228.69 T22.99 93868 1,08498 11,183%6
4 z| Telecom 42319 S14.61 454 .94 44513 462.80 449.00 5,450.3
=1 Utilities 24984 236.05 20895 19559 184.14 22117 2,590.7

TOTAL

17,202.48 19,773.29 21,908.19

13 visible /13 total

17,991.62 20,584.69 18,053.95 225,677.
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After you click on the tool the data sheet shows the detail for the crosstab cell you clicked on, in this case the
nine checks made for purchase in November of 1998.

SESEE

My Checkbook

Date 'Checl Pay To Category Memo Credit Balance *
Wl 11709798 [ Clark Supply Purchases Invoice 34449 18.856.74
11/09/98 502 Anderson Manufact Purchases Invoice 56817 18,439.55
1 11/02/98  S06 Telon Productions Purchases Invoice 6559 16,083.23
11/16/98 508 Miller Industries  Purchases Invoice 85486 21,224.25
11/23/98 515 Miller Industries  Purchases Invoice 89312 19,362.53
11/22/98 517 Clark Supply Purchases Invoice 243243 18,996.02
| 11/23/98 519 Stamford Mfg Purchases Invoice 11089 16,778.81
| 11430798 521 Anderson Manufact Purchases Invoice 38234 20,159.40
—~ 11/30/98 524 Coast General Purchases Invoice 19839 19,375.48
e 06 My Checkbook:XTABS:Monthly Spending

xtab Jan 93 Feb 98 Mar 98 Oct 92 Nov 98 Dec 92 TOT

Advertising 1,11485 3,87492 220267 341608 | 260782 252852 30,011.

DEPOSIT 0.00 0.00 0.00 0.00 0.00 0.00 0.

Fixed Assets 1,974.81 1,363.94 1,063.90 10,222,

| Insurance 1,25450  1,25450  1,25450 1,25450 | 1,25450 1,25450 15,054

Legal 41002 | 1,015.09 2,893,

= Office Supplies 614.01 932.45 1,043.33 T92.24 41542 342.14 7,425,

| Payroll 731930 696612  9,12323 729366 V918931 702121 92,219,

| Purchases 4,106 .41 2,135.08 3,447 938 1,881.39 2,501.53 29,666,

Rent 158000  1,58000  1,580.00 1,58000 1,580.00 1,58000 18,960.

Shipping 540.39 20876  1,22869 722.99 93368  1,08493 11,183,

Telecom 42319 S14.61 454 .94 44513 462.80 449.00 5,450,

—-| Utilities 24984 236.05 20895 19559 184.14 22117 2,590,

=| TOTAL 17,202.48 19,773.29 21,908.19 | 17,991.62 20,584.69 18,053.95 225,677

13 visible /13 total

Yalr[ii<l»t
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You can use the Select Original Data tool with any cell in the crosstab. In this illustration it has been used to
select all Fixed Assets regardless of month.

13 visible /13 total

~Yeld My Checkbook
Date ‘Checl Pay To Cateqory Memo Debit Credit Balance ,f
| 02/16/98 Century Equipment Fixed Assets 1,974 .81 14,417.04
03/23/98 211 SunComputers  Fixed Assets 1,363.94 15,765.11
1 04/06/98 239 Matrix Office Furn Fixed Assets 72711 10,592.89
05/04/98 274 SunComputers  Fixed Assets 1,223.27 14,13763 |
05/18/98 287 Century Equipment Fixed Assets 1,055.48 13,727.62
05/25/98 291 SunComputers  Fixed Assets 549,75 14,626.05
| 08/17/98 401 Micro Discount War Fixed Assets 1,076 67 16,802.99
028/24/98 410 Century Equipment Fixed Assets 984 38 17,146.72
09/21/98 440 Matrix Office Furn Fixed Assets 20335 21 ,235.48
12/21/98 554 Century Equipment Fixed Assets 1,063.90 16,749.72
e 06 My Checkbook:XTABS:Monthly Spending
xtab Jan 98 Feb 98 Mar 98 Dct 98 Nov 98 Dec 98 TO
= S| Advertising 1,11485 387492 220267 341608 260782 252852 30,011
| £0| DEPOSIT 0.00 0.00 0.00 0.00 0.00 0.00 £
Fixed A: 1,974 .81 1,363.94 1,063.90 10,222
g Insurance 1,25450 1,25450 1,25450 1,25450 1,25450 1,25450 15,054
Legal 41002  1,015.09 2,893
Office Supplies 614.01 93845  1,04333 792.24 415.42 34914 7425
| Payroll 731930  6,966.12  9,12323 7,29366 918931  7,021.21 92.21¢
Purchases 4,106 .41 213508  3,44793 1,881.39 293092 250153 2966¢
{ Rent 1,58000  1,58000  1,580.00 1,58000 1,580.00 1,580.00 18,96C
Shipping 540.39 29876  1,22869 722.99 93368  1,08498 11,182
Telecom 423.19 514.61 454,94 44513 462.80 44900  5,45C
== Utilities 249 .84 236.05 208 .95 195.59 184.14 22117 2,59C
=| TOTAL 17,202.48 19,773.29 21,908.19 | 17,991.62 20,584.69 18,053.95 225,67
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If you click on one of the cells in the bottom line and use the Select Original Data tool Panorama will select
an entire month of checks, in this case all 43 checks written in February of 1998.

& OO My Checkbook
.| Date Checl Pay To Category Memo Debit Credit Balance *
| 02/02798 [ER City Services Utilities Water 48.99 17,974.06
02/02/98 138 Valley Gas Utilities Heating 47.99 17,926.07
02/02/98 1329 UPS Shipping 57.08 17,868.98
02/02/98 140 Surf Netwaorks Telecom DSL S0.00 17,818.98
| 02/02/798 141 AT&T Telecom Long Distance Phone Servics 351.56 17,46743
1 02/02/98 142 United Security Utilities Alarm 30.00 17,437.43
| 02/02/98 143 Hamilton Davis Insurance Worker's Comp policy 8172 92.00 17,345.43
02/02/98 144 General Casualty  Insurance Property Insurance policy Y 187.50 17,157.93
02/02/98 145 Valley Bell Telecom Local Phone Service 113.05 17,044 88
02/02/98 146 Blue Cross Insurance Health Insurance group XBG- 975.00 16,069.88
02/02/98 147 Champion Trucking Shipping Invoice 67943 151.04 15,918.83
gﬁ’;gﬁﬁgg; e 06 My Checkbook:XTABS:Monthly Spending

gg;ggﬁg; sctab Jan 98 Feb 98 Mar 98 Oct 98 Nov 92 Dec 98 TOTA
; 2ol S| Advertising 1,11485 387492 220267 341608 260782 252852 30,0113
| £ DEPOSIT 0.00 0.00 0.00 0.00 0.00 0.00 0.0

— Fixed Assets 1,974.81 1,363.94 1,063.90 10,2226
Insurance 1,25450  1,25450 1,25450 1,25450 1,25450 1,25450 15,0540
| Leqal 41002  1,015.09 28936
== 0ffice Supplies 614 .01 93845  1,043.33 792 .24 415.42 34914 74254
3| Payroll 731930  6,966.12  9,12323 729366 918931  7,021.21 92,2191

| Purchases 410641  2,13508  3,447.93 1,881.39 293092 250153 29,6664
Rent 1,58000  1,580.00  1,580.00 1,580.00 1,58000 1,58000 18,960.0
Shipping 540.39 29876  1,22869 722.99 93368 1,083498 11,1836
Telecom 42319 514.61 454 .94 44513 468.80 44900 54503
== Utilities 249.84 23605 208.95 19559 184.14 22117 25907
223 TOTAL 17,202 .48 21,908.19 || 17,991.62 20,584.69 18,053.95 225,677.

13 visible /13 total * PSP

When you are done with the crosstab close the window and, if necessary, use Select All in the Search menu to
make all the records in the data sheet visible again (see “Selecting All Records’ on page 28). You can open the
crosstab again later using the View menu. If the data has changed use the Calculate Crosstab tool to re-calcu-
late the table values.

®O6 My Checkbook:XTABS:Monthly Spending
xtab Jan 98 Feb 98 Mar 98 Apr 98 May 98 Jun 98 Jul 98 .
P o« o - - LS =, 9 1 '
| Calculate SHaD %4055 z87492 220267 263100 239643 265366  1,19808 .
-y | peposIT 0.00 0.00 0.00 0.00 0.00 0.00 0.00
| Fixed Assets 1,97431  1,363.94 72711 2,82850
Insurance 1,25450 1,25450 1,25450 1,25450 1,25450 1,25450 1,254.50
| | Legal 28244
— Office Supplies 614 .01 93845  1,04333 752.83 32154 481 47 £90.04
Payroll 7,319.30  6,966.12  9,12323  6,72687  7,17242  8,96683  6,956.52
y | Purchases 4,10641 213508 344793 1,96164 2,38031 256758 2,26456
1 Rent 1,580.00 1,58000 158000 1,580.00  1,580.00  1,580.00  1,580.00
Shipping 540.39 29876  1,22869  1,10624  1,486.10 83582  1,13665
Telecom 42319 51461 454 .94 451 65 417.80 402.95 530.83
1 Utilities 249 .84 2%6.05 208.95 234 .49 234 61 21548 192.41
| TOTAL 17,202.48 [EREEFE] 21,908.19 17,708.77 20,072.21 18,958.28 15,803.58 2
A
v
12 visible/13 total  [I] <« » ¢ (=) R

To learn more about crosstabs see “Crosstabs” on page 561.
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Making a Bar Chart

Someone once said that a chart is worth a thousand numbers. Ok, that’s not quite what they said, but let’s
create a chart anyway. Charts are usually displayed from summary records in the database (see “Calculating
Subtotals” on page 90). These can be created with the Group and Total commands you learned about before.
They can also be created with the Summary & Outline Wizard. To open this wizard choose Summary &
Outline Wizard from the Utility submenu of the Wizard menu. The wizard contains eight pop-up menus that
allow you to specify how to summarize the database.

OO0 My Checkbook
Date Checl Pay To Category Merno Debit Credit Balance “
v

o1/01/92 | OPENING BALANCE DEPOSIT 12,739.00 12,739.00
01/01/98 100 Sparkletts Office Supplies e S
01/01/98 101 Blue Cross Insurance Health Insurance group XE e O f\ Summary:My Checkbook
01/01/798 102 Valley Gas Utilities Heating | Database Template |
01/01/798 103 AT&T Telecom Long Distance Phone Ser
01/701/98 104 Surf Networks Telecom DSL Group || ~|
01/01/798 105 United Security Utilities Alarm
01/01/98 106 UPS Shipping | =
01/01/98 107 Edison General Utilities January Electric | v|
01/01/798 108 City Services Utilities Water
01/01/798 109 Pacific Properties Rent January Rent I ~|
01701798 110 Valley Bell Telecom Local Phone Service | ~]
01/01/98 111 General Casualty  Insurance Property Insurance polic
01/01/798 112 Hamilton Davis Insurance “Worker's Comp policy 21 I =)
01/02/98 DEPOSIT DEPOSIT | ~]

B TV | R = oot o

Summarize | Summ: int ta

We’ll make a chart to display spending per month, so choose Date (by Month) from the first Group pop-up

menu.

® O O Summary:My Checkbook

Database Template

Date (by Day)
Date (by ‘Week) w

Total »
Total »
Total »

QOutline Level

Date (by Quarter’
Date (by Year)

Check
Pay To
Category
Memo

Report Forr
eport Frorm Debit

Credit
Balance
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Using the pop-up menus set the first Total option to Debit and the Outline Level to Date (by Month).

® © M Summary:My Checkbook

Database Template

| Date (by Month) ~|
| d
| d
o [ S
] 3
] 3

Outline Level |Date (by Month) I

When these three options are set up press the Summarize button. Panorama will group, total, and collapse
the database just as if you had performed these operations manually (see “Calculating Subtotals” on page 90
and “Hiding and Showing Detail”” on page 94). To learn more about this wizard see “The Summaries & Out-
lines Wizard” on page 551.

e M 6 My Checkbook
.| Date Checl Pay To Category Memo Debit Credit Balance
| 01730798 X
02727798 19,773.29
03730798 21,908.19 m
| 04727798 17,708.77
05/29/98 20,072 21
-| 06/297/98 18,958.28
| 07731798 15,803.58
' 08731798 21.,410.34
—| 09/28/98 16,210.08
10/30/98 17,991.62
11/30/98 20,584 69
; 12728798 18,053.95
' 225,677 41 ~r
A
v
15D VIS0 eSS drd | RAE 8 J 4>

The next step in building a chart is to create a new form. If you are using a Windows PC hold down the Alt
key, if you are using a Macintosh hold down the Control key. Either way, select New Form from the View
menu (see “Creating a New Form” on page 615).

Data Sheet
Design Sheet

Flash Art Scrapbook

New (rosstab... I !

Monthly Spending

New Procedure...
Month & Category Totals
Restore Original Data
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You know the drill by now — type in the name of the new form (up to 25 characters).

Create New Form

New Form Name: " !Insert before:
Spending Chart ( H

\

C Cancel ) ( Blank Form) C Quick Label ) (Quick Report)
S —

Press the Blank Form button to create the new form.

HCHaNal Mv Checkbook -
1 ®66 | My Checkbook:Spending Chart (100%)
[ 2 2 & 5 :

[
1l
.,.’_(

}
......

v
o\ m Geneva 12pt | x0.00" y0.00" ax0.00" ay0.00" (L] < » Yl 4
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Adjust the window size to approximately the size of the chart you want to make, then click on the Chart tool.

My Checkbook:Spend_ing Chart (100%)
I I I 2 I E I 4 I 5 I B4
|Y

e
i
‘V
Dalr 4

12pt || <« »

- Gepeva

Move the mouse over the form and then drag from corner to corner to create the chart, just as you would to

create a rectangle or a data cell.

@06 My Checkbook:Spending Chart (100%)
2™ bbb Bos o Bross e oo Broo o B 4

N

12pt || <« »

O m Geneva
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Your new chart doesn’t look much like a chart yet, in fact it looks more like a dialog!

O 0 6 My Checkbook:Spending Chart (100%)

4

ol |
1l

L TI-‘:"I"iI‘i'I:il il

1l

§1.  ; ‘

Lol bl alalate]

| Simple chart [up to 50 points] 3

i fl-‘i'l"i trriliands

NS
a2l
NI

Geneva Tazpt [2] «/» Jair

The buttons and pop-up menus in the dialog allow you to configure the chart. At a minimum, you must
select a legend field and at least one value field (see “Setting Up Legend and Value Fields” on page 1116). In
this case the legend field is already set to Date. Use the pop-up menu to set the value field to Debit.

value field

legend field

My Checkbook:Spending Chart (100%)

086

,-3

Date

Check

Pay To 5 R [ \ertical Legen
Category (ml ynnect
Memo | ST

Debit

Credit

Balance
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Switch to Data Access Mode to see the actual chart (see “Form Modes: Data Access vs. Graphic Design™ on
page 613).

®0O6 My Checkbook:Spending Chart
sz R
1 25,000.00 1 v
A W
N
";'” 20,000.00 A
|
A
= 15,000.00
<
=

10,000.00

5,000.00

0.00

01/ 027 03/ 04/ 05/ 06/ 07/ 08/ 09/ 10/ 11/ 12/

elal el elal s ir i elaN Eelal s LI N L el N EelaF e la P ilels !

13 visible /528 total «» 5 y< >
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Customizing the Chart Appearance

Let’s dress up the chart a little bit. To do that switch back to Graphic Design Mode (see “Form Modes: Data
Access vs. Graphic Design” on page 613). Then click on the chart and change the font size to 9 point.

806 My Checkbook:Spending Chart (100%) |

2318 A

7 00 I8 P o v 1R 09 I!;h'l.'«h P ed e 1 I?'t’.il.-«lv. larekets l?h'l.’«h P ed e 1 I?h'l.‘«h arebeds I?h'l.’«h P ed e 1 I?r.’l

Debit

—
11

AU S Lems ] Yo N\'..-.‘ Sy 2
I-nl‘lllln'l-l.ll.rlnl-nl‘lllln'l-l.ll.r

9 po
10 .
Simpl ¥ 12 ints]

14

18

24

36

48

ol
11

Up £
Date Down 38]

m
]
;

Geneva.

N <I>r

Other... wel

7

Now select the Output Pattern command from the Text menu.

Text
Font
Size

v Plain Text *ET
Bold #B

Italic
Underline #EU

Condense
Extended

v Left Justify
Center
Right
Full

vwv

Output Pattern...
Build Formula... 3F
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This command allows you to specify how the dates in the chart legend will be displayed. To display just the
abbreviated month name (Jan, Feb, Mar, etc.) type in Mon (see “Date Output Patterns” on page 423).

\

Data Cell

Output Pattern:
Mon

( Cancel )( OK )

Use the color pop-up menu to select a different color for the chart bars (see “Graphic Attribute Icons” on
page 1135).

Click on the Grid option to display a dotted line from each tick mark.

®06 My Checkbook:Spending Chart (100%) \
o T T - O - A = ST - 6, a

 ; _ i Simple chart [up to 50 points] B

| L L , PR
| B .'I-‘.‘rm Ll .fl."nil'.-'l'n‘l-‘ifl"i Latalonadon .‘I-‘.‘rm Laalonadag .‘I-‘.‘rn Ll il
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To preview the chart’s appearance without going into Data Access Mode click on the preview flap in the
lower left hand corner of the chart object. The preview flap is the small triangle that looks like a turned up
page corner.

My Checkbook:Spending Chart (100%)

22,000.00
20,000.00
18,000.00
16,000.00
14,000.00
12,000.00
10,000.00
£,000.00
6,000.00
4,000.00
2,000.00

preview flap 0.00

Jan Feb Mar Apr May Jun Jul Aug Sep 0Oct Nov Dec

Geneva apt 2] < » yalr 4

When in the preview mode you can use the extra fifth chart handle to adjust the margin where the chart leg-
ends appear.

&,000:00 |
4,000:00 |
2,000:00

000 =

2|«

Geneva
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When the form is switched to Data Access Mode the chart will immediately show any changes made to the

database.
& OO My Checkbook
| Date Checl Pay To Category Mermo Debit Credit Balance *
“an| 01730798 — ' | 17,202 48] ' M
| 02727798 19,773.29
03730798 21,908.19 m
04727798 17,708.77
05729798 20,072.21
06729798 18,958.28
| 07731798 i . 15,803.58 1
08731798 5 .
{ 09728798 ® O My Checkbook:Spending Chart
10/30/98 A A
11/730/98 v
12728798 L2 paa o m
20,000.00
18,000.00
13 visible /528 total

16,000.00
14,000.00
12,000.00
10,000.00
£,000.00
&,000,00
4,000.00
2,000.00

0.00

~
A

Jan Feb Mar  Apr May Jun  Jul  Aug Sep Oct  MNoy Dec

13 visible /528 total <> y< 1> &

.‘,}
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For example if you edit the summary value for March 1998 the chart will immediately update to reflect that
change (of course it usually doesn’t make any sense to edit a summary value like this). In the illustration
shown below the summary value has been increased from 21908.19 to 27908.19.

& MD O

My Checkbook

| 01730798
<| 02727798

| 03730798
04/27/98
05729798
06729798
I* | 07731798
08731798
- 09728798
10/30798
11730798
12728798

Date Checl Pay To

Category Merno Debit Credit Balance *
I : ! ! ] ! v
17,202.48 -

‘ 27908-19 .

/7,70
0,0

72.21
18,958 28

13 vizible /528 total

= - 15,803.58 i
® 06 My Checkb6ok:Spending Chart
- s
30,000.00 —eeeceerreeeene / .............................................................. '
25,000.00 - -vcreeree .

20 ’000 00 admecononnsocces NN . ..... . eeecoeocecacaocsocs NN :.coc000ccccc NN .......

15,000.00

10,000.00

5,000.00
0.00
Jan  Feb Mar Apr May Jun Jul Aug Sep Oct Noy Dec
13 visible /528 total <> )<

S

<>

/

d

We’re finished with the chart, so close the window. Choose Restore Original Data from the Action menu,
then Save the database. To learn more about charts see “Charts” on page 1111.
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Data Entry Helpers

Now let’s switch gears. Before you can analyze data you have to get the data into the database, and that usu-
ally means data entry with the keyboard. This job is never easy, but Panorama does have tools that can make
data entry faster and less error prone. The next few sections will look at how the data entry process can be
improved for each of the fields in the checkbook database.

Dates

The first field in the database contains the check date. You can modify the database to default to today’s date
when a new check is created. Start by clicking anywhere in the Date field and then choose the Field Proper-
ties dialog from the Setup menu (see “Field Properties” on page 378). (You can also open this dialog by dou-
ble clicking on the field name at the top of the column.)

Edit View Fields Text Search Sort Math BSOS Action Wizards 9
e 06 My Checkbook |  Show Record Count -
' | Date Checl Pay To Cateqgory Memao ield : ince o !
28| 01/01/98  OPENING BALANCE DEPOSIT by 00 |
ae| 01701798 100 Sparkletts Office Supplies Add Field... 2o (1]
01701792 101 Blue Cross Insurance Health Insuranc : 80 ™ |
S| 01701798 102 Valley Gas Utilities Heating . Delete Field 90
| 01701798 103 AT&T Telecomn Long Distance P 66
= 01/01/928 104 Surf Networks Telecom DSL Install Custom Menus... £6
= | 01/01/98 105 United Security Utilities &larm 66
| o1/01798 106 UPS Shipping | Default Style & Color... z.es
= 01/01/98 107 Edison General Utilities January Electri .10
i 01/01/98 108 City Services Utilities Water Registration... 71
5 01701798 109 Pacific Properties Rent January Rent .71
: 01701798 110 Valley Bell Telecomn Local Phone Servige 3695 76
; 01701798 111 General Casualty  Insurance Property Insurance policy Y 187.50 9,165.26
. 01701798 112 Hamilton Davis Insurance Worker's Comp policy 8172 92.00 9,073.26 4
f 01/02/98 DEPOSIT DEPOSIT 5,985.82 15,059.08
| 515 visible/S15 total _ [[] <« » €D - BRIy
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The Field Properties dialog allows you to modify many of the attributes of each field. The New Database
Wizard has already set up some of the options in this dialog, including the Field Name and the Type.

Field Properties

_ Name & Data Type

Field Name Date

Type | Date  |%) Digits | 0 %)
( Output Pattern... )

_ Data Entry Options

Alignment | Left %)
Auto Capitalize | Off %)
Duplicates | Yes %)

Clairvoyance = Off lB‘

( Advanced Options. .. )

( Cancel ) ( OK )

To set up the default value for this field press the Advanced Options button in the Data Entry Options area.
The Advanced Data Entry options dialog has several radio buttons for different default values — click the
Today’s Date option.

Advanced Data Entry Options

" _1Same as Tab
"1 Same as Tab when pressed twice

—_ Input Pattern _ Character Range
@ ® Any O Custom
O Alphabetic A 4
__ Default Value O Numeric B M
O AlphaNumeric €
Today D
: :
_ Automatic increment by one F
® Today's Date C
= X
. Ditto H
|
__Space Bar j
K
L
M

alrl

( Cancel ) ( OK )
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After you click this option press this OK button twice to get back to the data sheet. Then press the Add New
Record tool (or select Add New Record from the Edit menu).

®O6 My Checkbook
| Date Checl Pay To Category Memo Debit Credit Balance * |
3 v
| 01701798 OPENING EALANCE DEPOSIT 12,739.00 12,732.00
01/01/98 100 Sparkletts Office Supplies 14.20 12,724 .80 ‘
01/01798 101 Blue Cross Insurance Health Insurance group XBG- 975.00 11,749.80 ‘
102 Valley Gas Utilities Heating 49.90 11,699.90
01701798 103 AT&T Telecom Long Distance Phone Service 236.24 11,463 .66
== 01/01/98 104 Surf Networks Telecom DSL S50.00 11 41366
| 01/01798 105 United Security Utilities Alarm 30.00 11,383.66
1y | : Shipping 144.02 11,239.65
— I OO - on General Utilities January Electric 115.55 11,124.10
7 01/01/98 108 City Services Utilities Water 54.39 11,069.71
] 01/01/98 109 Pacific Properties Rent January Rent 1,580.00 9.,489.71
The new check automatically defaults to today’s date.
12/25/98 DEPOSIT DEPOSIT 5,264.90 18,949.36
12728798  S60 Valley Publications Advertising 963.57 17,985.80
S61 Poly Payroll Servin Payroll 1,749.38 16,236 .42 m
A
v
S16 visible/S16 total ||| <« » € Ry

Smart Dates

Panorama is very flexible about how you type dates. We call this feature “smart dates.” You can enter dates
numerically (for instance 04/09/02 or 4/9/2) or you can spell out the date (for instance April 9th, 1997 or Apr 9
97). You can use any character as a separator between numeric dates, for example 4-9-01 or even 4.9.01.

To enter today’s date, simply type today. You can also enter yesterday or tommorow. Panorama will auto-
matically convert these entries to the correct month, day and year.

If the date is in the current week, you can simply type in the name of the day, for example saturday or tue. To
specify a day in the previous or upcoming weeks add the words last or next, for example next tuesday or last
saturday.

Type... Date Entered

10/26 /00

toda

may 17

esterda

last frida

next wed

Play around with entering different dates, then use the Cut Record tool to delete the new record.
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Check Number

The second field contains the check number. You can modify the Field Properties to automatically add one to
create a new check number each time a new check is created. Click anywhere in the Check column and then
choose the Field Properties dialog from the Setup menu (see “Field Properties” on page 378). (You can also
open this dialog by double clicking on the field name at the top of the column.) The New Database Wizard
has already set up some of the options in this dialog, including the Field Name and the Type.

Field Properties

_ Name & Data Type

Field Name Check

Type | Numeric ['#) Digits | 0 %)

( Output Pattern... )

_ Data Entry Options

Alignment | Right $)
Auto Capitalize | Off B
Duplicates | Yes 4

Clairvoyance = Off lc)

( Advanced Options... )

( Cancel ) ( OK )

To set up the default value for this field press the Advanced Options... button in the Data Entry area. The
Advanced Data Entry options dialog has several radio buttons for different default values — click the
Automatic increment by one option.

Advanced Data Entry Options

__ Input Pattern _ Character Range
@ ® Any ) Custom
() Alphabetic A
__ Default Value ) Numeric v

- , () AlphaNumeric

+1 |

@ Automatic incremgnt by one
_ Today's Date

O Ditto

0

TIOMMON®>
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After you click this option press this OK button twice to get back to the data sheet. Then press the Add New

Record tool (or select Add New Record from the Edit menu).

The new check automatically defaults to today’s date and is assigned the next check number,

12/25/98 DEPOSIT DEPOSIT
12728798  S560 Valley Publications Advertising
12/28/98 561 Poly Payroll Servii Payroll
09/26/04 |14

516 visible/S516 total ||| « » €D

Pay To

963.57
1,749.38

®O6 My Checkbook
\ | Date Checl Pay To Category Memo Debit Credit Balance *
el 01701798 OPENING EALANCE DEPOSIT 12,732.00 12,732.00 M
01/01/98 100 Sparkletts Office Supplies 14.20 12,72420 1]
01/01798 101 Blue Cross Insurance Health Insurance group XBG- 975.00 11,749.80
01701798 102 VYalley Gas Utilities Heating 42.90 11,692.90
01701798 103 AT&T Telecom Long Distance Phone Service 236.24 11,463 .66
== 01/01/98 104 Surf Networks Telecom DSL 50.00 11,413.66
LF | 01/01798 105 United Security Utilities Alarm 30.00 11,383.66
s |-Ac eCOTH Shipping 144.02 11,239.65
— N UTYU - arson General Utilities January Electric 115.55 11,124.10
1 01/01/98 108 City Services Utilities Water 54.39 11,069.71

2,264.90

in this case 562.

18,949.36
17,985.80

16,236.42 m
A

v

The third field contains the name of the person or company the check is made out to. Since you will often
write checks out to the same people over and over again you can take advantage of a very cool Panorama fea-
ture called Clairvoyance®. Clairvoyance automatically finishes your typing for you as soon as it thinks it can
identify what you are about to type based on the previous entries (see “Clairvoyance®” on page 449). Clair-
voyance can be turned on and off with the Field Properties dialog. Click anywhere in the Pay To column and
then choose the Field Properties dialog from the Setup menu (see “Field Properties” on page 378). (You may
have also heard that you can open this dialog by double clicking on the field name at the top of the column.
It’s really true!). The New Database Wizard has already set up some of the options in this dialog, including
the Field Name and Type and Auto Capitalize. Use the pop-up menu to turn on the Clairvoyance option, as

shown below.

Field Propertie

S

_ Name & Data Type

Field Name PayTo

Type | Text

Qutput Pattern

'+ ] Digits

0

_ Data Entry Options

Alignment | Left l
Auto Capitalize | Word l

Duplicates | Yes

Clairvoyance [ Off

gd Options... )
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Press OK to close the dialog. Now try entering Blue Cross into the Pay To data cell. Leave your finger off the
Shift key as you type because Panorama will automatically capitalize the first letter of each word for you! As

soon as you press the letter |, Panorama’s Clairvoyance® feature will complete the entry for you by typing ue
Cross.

B is automatically capitalized for you because of Auto Capitalize option

12728798 S61Poly Payroll Serv Payroll 1,749.33 1
10/26/00  S62

Clairvoyance automatically finishes your typing for you as soon as it thinks it can identify what you are
about to type based on the previous entries. If Clairvoyance guesses wrong (because this is a new entry that
hasn’t appeared before) just keep typing and complete the entry yourself.

Clairvoyance automatically completes the entry for you

Clairrows

When you hold down the Command key (Mac) or Control key (Windows), the up and down arrows on the
keyboard become clairvoyant arrows, or “clairrows.” With the key held down you can use the arrows to scan
through the values that are already in the database. Each time you press Command/Control-Down Arrow
the next value appears, while each time you press Command/Control-Up Arrow the previous value appears.
You can scan through the values until you find the information you are looking for, then press the Enter key
to enter the value. To give the clairrows a head start you can type in the first few letters of the information
you are looking for.

type b 5 ]

| [ciecres |

Cmd/ Ct | - Down Arr Ow [Esstonbirest |

Cmd/ Ct | - Down Arrow | Century Equipmery

Cmd/ Ct | - Down Arrow |Champion Truckin]

Cd/ Ctl-Up Arrow [CenturyEquipmen

Crd/ Ctl-Up Arrow [Esstenbirest ]
Ent er ZEEIIET
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Category

The Category field places each check into one of 11 categories (Rent, Insurance, Telecom, etc.) One way to
handle this field would be to use Clairvoyance® as described for the Pay To field. That way you would only
have to type in the first letter or two of the category. However instead of using Clairvoyance you are going to
set up a palette of radio buttons in the pop-up Input Box (see “The Choice Palette” on page 481). This palette
will have a radio button for each category. To set up this palette you’ll need to use the design sheet. Use the

View menu to switch from the data sheet to the design sheet.

Panorama Handbook

L 6 Panorama File Edit 7 Fields Text Search Sort Math Setup Action

5

[@eo6 Data Sheet b
L L | Date Checl Pay To C Design Sheet N Debit Credit Balance *
| 12/21/98 551 Coast General 3 Flash Art SCI’&DbOOk E27572 17,96090 :
12/21/98 552 Office Depot € 72.46 17,888 .43
= 12/21/98 553 Staples ¢ New Form... I 74,81 17 313.62
2] 12/21/98 554 Century Equipment F spending Chart : 16,749.72
12/21/98 555 Stamford Mfg 5 b 16,277.35
12/21/98 556 Post Office ¢ New Crosstab... 16,072.73
12/21/98 557 Power Printing 3 Monthly Spending 15,530.23
12721798 558 Poly Payroll Servi 13,873.68
12/21/798 559 Fry's Electronics Q New Procedure... 13,684 46
12/25/98 DEPOSIT 5,264.90 18,949.36
12/28/98 560 VYalley Publications Month & C_ategory Totals 17,985.80
12/28/98 561 Poly Payroll Servi | Restore Original Data 16,236 .42 m'
0o/26/04 562 (ETIN TR |
s
v
516 visible/S16 total | REE J4i» g

The design sheet is kind of like a super-duper Field Properties dialog (see “The Design Sheet” on page 380).
It allows you to see and modify all the properties of every field at once. Each line in the design sheet corre-

sponds to a field, with the name and properties listed from left to right.

66

e | Check
- Pay To
| Category
. Memao
= Debit
Credit

| Field Mame

My Checkbook:DESIGN
Type Digits' Align 'Output Pattern Input Pattern Range Choices Link Clair
AN Date [DEICEEENG) Left Any Off
Numeric O Right #*, Any Off
Text 0 Left Any On
Text 0 Left Any Off
Text 0 Left Any Off
MNumeric Float Right #* #*# Any Off
Numeric Float Right #* *# Any Off
Numeric Float Right #* #*¥ Any Off

Balance

Tab

Off
Off
Off
Off
Off
Off
Off
Off

Caps Dup Default Equal®

Off Yes Today
Off  Yes +1
Word Yes

Word Yes

Off Yes

off Yes

Off Yes

off Yes

1Y

)
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To set up the radio buttons click on the Category field name.

My Checkbook:DESIGN

Type Digits Align Output Pattern Input Pattern Range Choices Link Clair Tab Caps Dup Default Equal #
Date n} Left Any Off Off Off Yes Today ,!
Nurmeric 0 Right #*, Any Off Off Off Yes +1
Text n} Left Any On  Off YWord Yes

+ Text 0 Left Any Off Off “Word Yes
Text 0 Left Any Off Off Off Yes
Nurneric Float Right *, #¥¥ Any Off Off Off Yes -

Now choose the Automatic Choices... command from the Special menu. This command will build a list of
the radio buttons from the existing data. If you leave the number at 2 the command will include every cate-
gory that occurs two or more times in the existing data (see “Creating the List of Choices” on page 481).

Automatic Choices

5 Please enter the exception threshold. Any
data that occurs more often than this
threshold will be included in the choice list.

( Cancel ) ( OK )

Press the OK button to create the list of choices. Since the width of the column is too narrow to see much of
the list you can either make the column wider or double click on the list to see the entire list (as shown
below). Notice that when a choice contains a space, for example Office Supplies, the space has been replaced
with an _ underscore character, i.e. Office_Supplies.

® O 6 My Checkbook:DESIGN
| Field Name  Type Digits Align Output Pattern Input Pattern Range Choices Link Clair Tab Caps Dup Default Equai 4
v
| Date Date 0 Left Any off Off Off Yes Today -
Check Numeric O Right #*, Any off Off Off Yes +1
1 Pay To Text 0 Left Any On  Off Word Yes
| Category  Text O Left Any Off Off ‘Word Yes
Memo Text 0 Left Any off Off Off Yes

>

Rent Legal DEPOSIT Payroll Telecom
Shipping Insurance Purchases
Utilities Advertising Fixed_Assets
Office_Supplies

.-

>
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Use the View menu to switch back to the data sheet.

ﬂg Panorama File Edit _ Special Text Security Server Wizards % [[:
[006 Data Sheet

| Field Mame  Type Digits Align Out

Design Sheet

(2| Date Date 0O  Left Flash Art Scrapbook
| Check Nurneric O Right *,
— Pay To Text 0  Left New Form...
Category  Text O Left Spending Chart

& | Memo Text o Left

< Debit Mumneric Float Right * . New Crosstab...

| Credit Numeric Float Right #* . Mon[h|y Spend]ng

| Balance Nureric Float Right *,.

New Procedure...
Month & Category Totals
Restore Original Data

Off Off Yes +1

Off Word Yes

Off Word Yes

f  Off Off Yes
Off Off Yes

- Off Off  Yes
off Off Yes

lair Tab Caps Dup Default Equai ®
ff Off Off Yes Today

-

Before it switches back to the data sheet, Panorama will ask you if you want a “new generation” of your data-
base. What it is really asking you is to confirm the changes you just made to the design sheet (see “Database
“Generations”” on page 380). Press the Yes button.

-

T

Do you want a new generation of
“My Checkbook:DESIGN™?

( Cancel ) ﬁ'ﬁ

Double click on the empty data cell at the bottom of the Category column. The Input Box will appear, but it is
so small you can only see the first button and part of the second.

12/25/98 DEPOSIT
12/28/98 560 Valley Publications Advertising
12/28/98 561 Poly Payroll Servin Payroll

09/26/04 562 Boston Direct |© P!ent @] Leg

DEPOSIT

516 visible /516 total

|«i»(

5,264.90
963.57
1,749.38

18,949.36
17,985.80

16,236 .42 m
A

v

IRILYY
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Move the mouse to the bottom right corner of the Input Box. The cursor will flip over (see “Expanding the
Input Box™ on page 439). Drag the mouse to expand the Input Box.

12/25/98 DEPOSIT DEPOSIT 5,264.90 18,949.36
12728798  S60 Valley Publications Advertising 963.57 17,985.80
12728798 561 Poly Payroll Servii Payroll 1,749.38 16,236.42 m
09/26/04 562 Boston Direct {® Rent- O Lec
el A
......... . :
516 visible /516 total || «|» )4\ >

The radio buttons will automatically flow into the expanded box as you change its shape.

12/25/98 DEPOSIT DEPOSIT 5,264.90 18,94936
12728798  S60 Valley Publications Advertising 963.57 17,985.80
12728798 561 Poly Payroll Servin Payroll 1,749.38 16,236.42 m
09/26/04 562 Boston Direct {®) Rent O Telecom O Utilities
O Legal O Shipping O Advertising A
O DEPOSIT O Insurance O Fixed Assets v
= T T T PaE O Payroll O Purchases (O Office Supplies y<T>

The box can be tall and skinny, short and fat, or anything in between. To select a value just click on the button
and press Enter or Tab, or simply double click on the button. You can also select a value by typing in the first
few letters of the value, for example U for Utilities or Pu for Purchases.

The radio buttons are great if you want to select from one of the predefined categories, but what if you want
to add a check in a new category? To allow this you’ll need to go back to the design sheet (use the View
menu).

®0 6 My Checkbook:DESIGN

| Field Name Type Digits Align Output Pattern Input Pattern Range Choices Link Clair Tab Caps Di 4

| Date Date 0  Left Any Off Off Off Ye.
Check Numeric 0 Right #*, Any Off Off Off Yh
1 Pay To Text 0 Left Any On  Off Word Yv
| Category Text n} Left Any Rent Lec off Off Word Y.
Memo Text 0 Left Any off Off Off i
1 Debit Numeric Float Right *, *¥ Any Off Off Off Yh
" | Credit Numeric Float Right *, *¥ Any Off Off Off Y»

Double click on the list of choices, and then type a space and a dozen underscores at the end of the list. (The
underscore is just to the right of the 0 key, hold down the Shift key and press -).

| Field Name Type Digits Align Output Pattern Input Pattern Range Choices Link Clair Tab Caps Di 4
| Date Date 0 Left Any off Off Off Y-,!
Check Numeric O Right *, Any off Off Off i
1 Pay To Text 0 Left Any On__ Off “Word Y.
| Category Text 0 Left Any Rent Legal DEPOSIT Payroll Telecom 4
Memo Text 0 Left Any | Shipping Insurance Purchases Y
=~ Debit Numeric Float Right *, #*#¥ Any Utilities Advertising Fixed_Assets
" | Credit Mumeric Float Right * *# Any Office_Supplies | ’

p | Balance Nurneric Float Right *, #*#¥ Any
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Press the Enter key and then use the View menu to go back to the data sheet. Double click on the Category

field.
12/25/98  DEPOSIT  DEPOSIT o
12/28/98 560 VYalley Publications Advertising 963.57
12/28/98 561 Poly Payroll Servi Payroll 1,749.38
09/26/04 S62 Boston Direct {0 Rent QO Telecomm O Utilities
O Legal O Shipping O Advertising
O DEPOSIT O Insurance ) Fixed Assets
= e oG Tl O Payroll ® Purchases O Office Supplies

s gm———

5,264.90 1894936
17.985.80

16,236.42 w
A

v

Yalr 4

It looks just the same as before! What’s up with that? To find out, expand the Input Box just a little bit more.

12/25/98 DEPOSIT DEPOSIT
12728792  S60 Valley Publications Advertising 963.57
12728792  S61 Poly Payroll Servii Payroll 1.749.38
09/26/04 562 Boston Direct (O Rent O Shipping (0 Fixed Assets
O Legal O Insurance (O Office Supplies
) DEPOSIT (® Purchases O |
O Payroll O Utilities
O Telecom (O Advertising i
516 visible /516 total | «|»

9,264.90 18,949.36
17,985.80
16,236.42

"

A
v
T4

Now you can see that there is one additional radio button at the end of the list. To enter a new category click
on this radio button and then type in the new category, in this case Auto.

12/25/98 DEPOSIT DEPOSIT
12/28/98 560 VYalley Publications Advertising 963.57
12/28/98 561 Poly Payroll Servi Payroll 1.749.38
09/26/04 S62 Boston Direct {0 Rent O Shipping O Fixed Assets
O Legal O Insurance (O Office Supplies
O DEPOSIT O Purchases (&) [Autd |
O Payroll O Utilities [}
O Telecom (O Advertising
516 visible /516 total | «i»
Press the Enter key when the entry is completed.
12725798 DEPOSIT DEPOSIT
12728792  S60 Valley Publications Advertising 963.57
12728792  S61 Poly Payroll Servic Payroll 1,749.33
09/26/04 562 Boston Direct h
S16 visible/516 total ||| < » ¢ ()

5,264.90 18,949.36

5,264.90 13,949.36
17,985.80
16,236.42

0

A
v
Ja»

17,985.80
16,236.42

0
A
v
/.

T4 »

To learn more about this feature see “Exceptions” on page 482. Before going on to the next step | recommend
that you Save the database one more time.
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Looking Up the Category From a Previous Record

In this database a particular Pay To will almost always go with a particular category. For example the cate-
gory for checks to Blue Cross will always be Insurance, while the category for Staples will always be Office
Supplies. Panorama can be set up to automatically look up the category from the previous record, if any. To
do this you’ll use the design sheet again. Use the View menu to switch to the design sheet again, then double
click on the Equation column of the Category row (see “Automatic Calculations” on page 468).

™ OO My Checkbook:DESIGN
Field Name Type Digits Align 0|| Default Equation Read Write “idth Notes y 4

)4

Date Date 0 Left Today n} 0 8
Check Nurneric O Right *| +1 0 0 3
Pay To Text 0 Left ' 0 0 12
Cateqory Fort— et ||

Merno Text 0 Left
Debit Numeric Float Right 3

Credit Nurneric Float Right
Balance Nurneric Float Right

Now choose lookup(...) from the Functions menu (see “Functions Menu’ on page 1319).

Functions

Operators P lower{text)

Advanced P max{number,number)

Arrays P min{number,number)

?{(cond,truefFormulafalsefFormula) Misc 4

abs{(number) pattern{humber,pattern)

asc(text) rep{text,number)

chr{number) replace(textoldtexthewtext)

city(zip) replacemultiple{textoldtexthewtextsep)

clipboard() rnd{)

county(zip) round{number,step)

Date & Time P sandwich{pretexttextsuftext)

divzero{(humerator,denominator) search(text,phrasetext)

exportcell{field) seq()

extract{text,separator,jtemnum) sizeof(text)

fieldstyle({fieldname) state(zip)

fix(humber) str(hnumber)

fixed(humber) strip(text)

float(humber) stripchar{text,range)

grabdata(file,field) striptonum(text)

Graphics P striptoalpha(text)

import() sum(lineQ)

Info P unigueid{field,root)

int(humber) upper({text)

length(text) upperword(text)

listchoices(field,separator) val(text)
zeroblank{(number)
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Choosing this menu item opens a dialog for setting up the | ookup( function (see “Linking With Another
Database” on page 1400).

Lookup Function Wizard

| want to retrieve information from the | B
(
database using the _lookup '#) function.
The information | want to retrieve is in the | ‘ 3] field of this database.

The information | want to retrieve is in the record where the

field | '#] in the database Untitled

matches the field | | %] in the database My Checkbook.

( Cancel ) ( OK )

Start by selecting the database you want to look up data from, in this case the current database.

Lookup Function Wizard

| want to retrieve information from the eckboo
Summary & Outline Wizard
ZipIinfo_ZipInfo.com

database using the | lookup

The information | want to retrieve is in the ' 3] field of this database.

Next, tell Panorama that if there is more than one match in the database you are interested in the last match
(closest to the bottom), not the first (see “Lookup Variations” on page 1405).

Lookup Function Wizard

| want to retrieve information from the | My Checkbook %)
database using the lookup function.
table
lookuplast

The information | want to '+ field of this database.

Iookupselectd 1
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Now tell Panorama what you want to look up, in this case the Category.

Lookup Function Wizard

| want to retrieve information from the | My Checkbook %)
database using the | lookuplast ' # ) function.
The information | want to retrieve is in the Date | @ field of this database.
Check

Pay To
Category .

The information | want to retrieve is in the

field [ %] intheda Memo  book
- Debit
matches the field i Credit e My Checkbook.
Balance
N
( Cancel ) ( OK )

We want to look up the category in the last record in the database where the Pay To value matches the Pay To
value in the current field. So select Pay To for both of the last two pop-ups.

The information | want to retrieve is in the record where the

field [ Pay To H‘—] in the database My Checkbook

matches the field Date E in the database My Checkbook.
Check
Category (_Cancel ) (oK )

— Memo —

Debit
Credit
Balance
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Here’s the finished dialog with everything filled in.

Lookup Function Wizard

| want to retrieve information from the

" My Checkbook

(
database using the _lookuplast

'+ function.

The information | want to retrieve is in the | Category

'+ field of this database.

The information | want to retrieve is in the record where the

field | Pay To "% ] in the database My Checkbook

matches the field | Pay To % ) in the database My Checkbook.

( Cancel ) ( OK )

Press the OK button to build the formula for looking up the previous category.

Numeric Float Right
Nurmeric Float Right

0

To learn more about how this formula works see “Linking With Another Database” on page 1400. For now
just press the Enter key and use the VView menu to switch to the data sheet. Then start typing Staples into the
Category field.

™ 0O 0O My Checkbook:DESIGN
Field Name Type Digits Align 0|| Default Equation Read Write “idth Notes
Date Date 0 Left Today 0 0 8 /:
Check Nurneric O Right *| +1 0 0 3
Pay To Text 0 Left ) _ _o—__ 0 12
Category Text 0 Left lookuplast("My Checkbook™,"Pay To" ,«Pay
Memo Text 0 Left Tos,"Category™,"",0)
Debit Nurneric Float Right
Credit
Balance

96357
1,749.38

560 WYalley Publications Advertising
561 Poly Payroll Servic Payroll

12428798
12428798
09/26/04 562 %

When you press the Enter key Panorama will automatically look up the appropriate category, in this case
Office Supplies.

12/28/98 560 VYalley Publications Advertising
12728798 561 Poly Payroll Servi Pagroll
09/26/04 S62 BENES Office Supplies

17,985.80
16,236.42

96357
1,749.38

17,985.80
16,236.42

m
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Sometimes the check amount is the same from check to check also, for example a rent or subscription pay-
ment. You can go back to the design sheet and use the same technique to build a formula to look up the previ-
ous check amount. The formula is almost the same as before, but this time it looks up the Debit field and has
a default value of O instead of " (see “Linking With Another Database” on page 1400).

™ 0O 0O My Checkbook:DESIGN
Field Name Type Digits 4| Equation Read “Write Width MNotes .1
Date Date 0 L 0 0 8 :
Check Nurneric O R 0 0 3
Pay To Text 0 L 0 0 12
Category Text n} L|{| lookuplast(“My Checkbook","Pa 0 n} 10
Mermo Text 0 L 0 0 18
Debit Numeric Float Ri| |lookuplast(“"My Checkbook","Pay To" ,«Pay
Credit Murneric Float R||Tos,"Debit”,"",0)
Balance Murneric Float Ri|

M

One potential problem with both of these formulas is that they will stop working if the name of the check-
book file changes — it’s hard coded as My Checkbook. To fix that you can replace "My Checkbook" with
I nf o( " dat abasenane") , as shown below (see “Looking Up Data in the Current File” on page 1413).

® 00 My Checkbook:DESIGN
Field Name Type Digits 4| Equation Read ‘Write Width MNotes Y
Date Date 0 L I )4
Check Nurneric O R 0 0 3
Pay To Text u} L 0 0 12
Category Text u} L|{| lookuplast("My Checkbook","Pa 0 0 10
Memo Text 0 L 0 0 18
Debit Numeric Float Ri| |lookuplast(info(“databasename™), "Pay To" ,«Pay
Credit Nurneric Float R)| | Tos,"Debit”,"",0)
Balance MNumeric Float R|

Press the Enter key, use the View menu to go back to the data sheet, then start typing Pacific Properties into
the Category field.

12/28/98 S60 Yalley Publications Advertising 963.57 17,985.80
12/28/98 S61 Poly Payroll Servin Payroll 1,749.38 16,236 .42
09/26/04 S62 IPacific Proierties IOffice Supplies

0

When you press the Enter key Panorama will look up both the category and the amount from the previous
check to Pacific Properties.

12728792  S60 Valley Publications Advertising 963.57 17,985.80
12/28/98 561 Poly Payroll Servin Payroll 1,749.38 16,236.42
09/26/04 562 m Rent 1,580.00

"

If this isn’t the correct amount you can simply tab over to the Debit field and type in the actual amount. If you
haven’t done so already, Save the database again now.
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Calculating the Checkbook Balance

To calculate the running checkbook balance you’ll need to record a quick procedure. Start by turning the
recorder on (see “Creating a Procedure with the Recorder” on page 1476).

® O 6 My Checkbook
I Checl Pay To Category Memo Debit Credit Balance *
&
= . Supply Purchases Invoice 6387 308.49 18,236.62 :
N 12/21/98 551 Coast General Purchases Invoice 61471 275.72 17,960.90
1 12/21/98 552 Office Depot Office Supplies T2.46 17,888.43
! 3 Staples Office Supplies 74.81 17,813.62
12/21/98 554 Century Equipment Fixed Assets 1,063.90 16,749.72
— 12/21 faa B85 CQtarnfard Mfa Pivehacacs Invaira 19120 472 X7 14 277 28
Scroll over to the Balance field and click somewhere in the field.
® O 6 My Checkbook
I | Date Checl Pay To Category Memao Debit Credit Balance
Y v
=.| 12/21/98 550 Clark Supply Purchases Invoice 6387 30349 18,236.62 .
12/21/98 551 Coast General Purchases Invoice 61471 275,72 17,960.90
1 12/21/98 552 Office Depot Office Supplies T2.46 17,888.43
| 12/21/98 553 Staples Office Supplies 74.81 17,813.62
12/21/928 554 Century Equipment Fixed Assets 1,063.90 16,749.72
1 12/21/98 555 Stamford Mfg Purchases Invoice 19188 472 .37 m-ﬁ
* | 12/21/98 556 Post Office Shipping 20462 16,072.¢3
; 12/21/98 557 Power Printing Advertising 542.50 15,530.23
1 12721798 558 Poly Payroll Servic Payroll 1,656.55 13,873.68
Choose the Formula Fill... command from the Math menu (see “Filling a Field with a Formula” on page 581).
Math
Total #T
Average #)
Count
Minimum
Maximum
Running Total
Running Difference

Formula Fill...
Fill...

Enter the formula Cr edi t - Debi t . You can use the Fields menu to help you type in the field names.

Panorama Edit mmns

O _ Date | M
Check
-~ PayTo E
Category l «Balance»

Memo
Enter the formu Debit

~ Balance = |
| —
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The finished formula should look like this.

Formula Fill «<Balance»

Enter the formula:
Credit-Debit

When you press the OK button Panorama will perform this calculation over and over again for every record
In the database (see “Filling a Field with a Formula” on page 581).

®O6 My Checkbook

| Date Checl Pay To Category Mema Debit Credit Balance *

) : - - : : v
= | 12/21/98 550 Clark Supply Purchases Invoice 6387 308 49 -308.49

| 12721798 551 Coast General Purchases Invaice 61471 275,72 -275.72

1 12/21/98 552 Office Depot Office Supplies T2.46 -72.46
12/721/98 553 Staples Office Supplies 74 .81 -74.81
12/21/798 554 Century Equipment Fixed Assets 1,063,290 -1,063.90
12/21/98 555 Stamford Mfg Purchases Invaice 19188 47237 -472.37
12721798 556 Post Dffice Shipping 204 62 -204 62
12721798 557 Power Printing Advertising 542.50 -542.50 |
12/21/98 558 Poly Payroll Servin Payroll 1,656.55
12721798 559 Fry's Electronics  Office Supplies 189.22 -189.22
12/25/98 DEPOSIT DEPOSIT 5,26490 5,264.90
12/28/98 560 VYalley Publications Advertising 963 .57 -963.57
12728798  S61 Poly Payroll Servin Payroll 1,749.38 -1,749.38
09/26/04 562 Pacific Properties Rent 1,580.00 -1,580.00 4

v
516 visible /S16 total | RERS <|{»

To complete the balance calculation choose the Running Total command from the Math menu (see “Running
Total” on page 532).

Total ET
Average )
Count

Minimum
Maximum

Running Differeke




Panorama Handbook

Page 148

This command will calculate the balance after each check or deposit (see “Using Running Total to Balance a
Checkbook™ on page 532).

Save Recording

Running Balance

New procedure name...

( Cancel ) ( Save Procedure )

Pick a name for the new procedure and type it in, then press the Create Procedure button.

®@06 My Checkbook
] I | Date Checl Pay To Category Memo Debit Credit Balance
| 12721798 550 Clark Supply Purchases Invoice 6387 308 .49 18,236.62
Mo | 12721798 551 Coast General Purchases Invaoice 61471 275,72 17,260.90 |
1 12721798 552 Office Depot Office Supplies T2.46 17,888.43
12/21/98 553 Staples Office Supplies 74.81 17813862
12/21/98 554 Century Equipment Fixed Assets 1,063,290 16,7492.72
12/21/98 555 Stamford Mfg Purchases Invaice 19188 47237 16,277.35
12721798 556 Post Dffice Shipping 204 62 16,072.73
12/21/98 557 Power Printing Advertising 54250 15,530.23
— 12/21/98 558 Poly Payroll Servin Payroll 1,656.55 (13 573 63 |
12721798 559 Fry'sElectronics  Office Supplies 189.22 13,684 46
12/25/98 DEPOSIT DEPOSIT 5,264.90 18,949.36
12/28/98 560 Valley Publications Advertising 963 .57 17,985.80
12728798  S61 Poly Payroll Servin Payroll 1,749.38 16,236.42
09/26/04 562 Pacific Properties Rent 1,580.00 14,656.42 4
v
516 visible/S16 total  [I] </ » ¢ = RN
To finish the recording select the recorder tool again.
® O 6 My Checkbook
Date Checl Pay To Category Memo Debit Credit Balance *
- v
- Supply Purchases Invoice 6387 308.49 18,236.62 ..
N 12/21/98 551 Coast General Purchases Invoice 61471 275.72 17,960.20
12/21/98 552 Office Depot Office Supplies 7246 17,888.43
12/21/98 553 Staples Office Supplies 74.81 17,813.62
12/21/98 554 Century Equipment Fixed Assets 1,063.90 16,749.72
12/21/98 555 Stamford Mfg Purchases Invoice 19188 47237 16,277.35
12/21/98 556 Post Office Shipping 204 62 16,072.73
12/21/98 557 Power Printing Advertising 542.50 15,530.23
12/21/98 558 Poly Payroll Servii Payroll 1,656.55 (13 872 63 |
12721798 559 Fry's Electronics  Office Supplies 189.22 13,684 .46

Now any time you need to update the checkbook balance you can simply select your new procedure from the
Action menu.

Month & Category Totals
Restore Original Data
Running Balance
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If you are curious to see what the code in your new procedure looks like you can use the View menu to open
it (see “Editing a Procedure” on page 107).

006 My Checkbook:Running Balance

) | Field "Balance"
_» | FormulaFill Credit-Debit
a«| RunningTotal

§4I>

Nl

Procedure opened.

Before moving on to the next step it’s a good idea to... you guessed it, Save the database.

Drawing a Check Form

To complete your check database you’ll create a check form that can be used for data entry. If you are using a
Windows PC hold down the Alt key, if you are using a Macintosh hold down the Control key. Either way,
select New Form from the View menu (see “Creating a New Form” on page 615). Type in the name of the
new form (up to 25 characters).

Create New Form

New Form Name: " lInsert before:
Check| ’ " Spending Chart B

( Cancel ) E—Blank—Form? ( Quick Label ) CQuick Report)
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Press the Blank Form button to create the new form, then adjust the window to the approximate size of a
check.

My Checkbook
u Date Checl Pay To Category Memo Debit Credit -
! 12/21/98 S50 Clark Supply Purchases Invoice 6387 30849 1
12721798 551 Coast General Purchases Invoice 61471 275.72 1
12/21/98 552 Office Depot Office Supplies T2.46 1
12/21/98 553 Staples Office Supplies 74.81 1
12721798 554 Century Equipmen’ Fixed R —
12/21/98 555 StamfordMfg  Purc|i— My Checkbook:Check (100%) =
12/21/98 =96 IFask Offlos Shiph | 75 |I|||I||1|I|||I||2|I|||I||3|I|||I||4|I|| &
12“"21 )"98 557 Power Printing Advﬂ N4 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 E
12721798 558 Poly Payroll Serv Payr| L% —
12721798 559 Fry's Electronics  Offic| [l
12725798 DEPOSIT DEPOY p==
12/28/98 560 VYalley Publication: Advel |8
12728798 561 Poly Payroll Serv
515 visible /515 total I ‘l
=
Geneva [ 12pt T «Ji] [ > |~

Now choose the Form Preferences... command from the Setup menu and use the pop-up menu to set the
form’s background color to light green.

Form Preferences

Viewing Format: ® Individual Pages
() View-as-List

Tab Order: 8 Natural
7)) Data Sheet Order
() Back to Front

Options: |__ Fractional Font Widths
! Use Data Style/Color
8 Enable up/down arrows

B FileGlobal Variables

" | Allow Clones

-

! Use Server for lookup
172 dpi Printing

—

Ruler Units: | Inches EX
Nudge Distance: = 1 pixel K3
Bkgnd Color: ‘ ‘ T __1 5 !
i 1]
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Before you actually start building the form you need to customize the graphic tool palette. Use the Tool Pal-
ette command in the Setup menu to open the tool configuration dialog.

é File Edit VYiew Arrange Text Graphics BISJN Wizards Help

My CheckH Rename Form...
m Date Checl Pay To Category Memo Delete Form Credit -
— Rearrange Forms...
s=ul 12721798 550 Clark Supply Purchases Invoic Install Custom Menus... 1
gl 12721798 551 Coast General Purchases Invoic 1
12/21/98 552 Office Depot Office Supplies Tool Palette... 1
12/21/98 552 Staples Office Supplies Form Preferences... 1
12/21/98 554 Century Equipmen: Fixed E—— T -
12/21/98 555 StamfordMfg  Purc Report Preferences... ) B
12/21/98 556 Post Office Shipd | =4 Special Paper Options... T
12/21/98  SS7 Power Printing  Adve{ [=5 Form Comments... S— i
12/21/98 558 Poly Payroll Serv Payr —
12721798 559 Fry's Electronics Offic Field Properties...
12/25/98 DEPOSIT DEPQY == -
12/28/98 S60 VYalley Publication: Advel |8 Add FIEll_]... #N
12/28/98  S61 Poly Payroll Serv ﬁ Delete Field
Convert/Edit Balloon Help
515 visible/515 total L4
=
Geneva [ 12pt [wr] « |‘llﬂ| | P |2
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There are a total of 29 graphic tools available for use in Panorama (shown in the list below on the left). Many
computer screens are not large enough to handle this complete palette of tools (and we expect the number of
tools to increase in future versions). To get around this problem, Panorama allows you to customize the
graphic tool palette on the fly (see “Customizing the Tool Palette” on page 625). You can configure the palette
to contain only the tools that you need right now in any order you want. If your needs change later, you can
simply reconfigure the palette at any time.

Configure Tool Palette

( “Classic” »

Tools... , Current Palette...
14 €

.k Pointer M

st Crosshair Pointer (__Advanced» )

S Magnify (' Programmer » )

oL, Text

W Line

L_J Rounded Rectangle

) Oval

( Move All »
( Move »

A=2 Switch to Data Mode Basic » )
[ged Data Cell
( Reports »
L) Rectangle
e Tile

@ Button
iy Chart

WU Flash Art
& Flash Audio

w2y Auto Grow

w@, Data Button

24 Flash Art Data Button
el Flash Art Push Button

ElList
4B, PopUp Menu
4, Push Button

L )

( Insert »

( Delete
( Delete All

CVACVACVACVACV IR VA Y

Y

( Cancel )( OK )
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On the right is a list of the tools you currently have installed. If this list is empty, Panorama will use the
default tool palette. To move a tool from the left to the right, double click on the tool in the left. Or you can
select the tool (or tools) and press the Move or Insert button. Move the nine tools shown below into the list

on the right.

Configure Tool Palette

Tools...

Current Palette...

| Rectangle
__J Rounded Rectangle

Button
Chart
2 Flash Art
Flash Audio
5 Auto Grow
‘@) Data Button

=p Switch to Data Mode

£ ( Basic » )
“ ( Advanced» )
(' Programmer» )

( Reports» )

( “Classic"» )

PopUp Menu
[ Text Display
=] Text Editor

(" MoveAll» )

When you press the OK button the tool palette in the form will be updated.

My Checkbook:Check (100%) =——— H1 B

N
z

= |o|S INE

1 2 3 4
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Creating the Text Editor SuperObjects

Using the Text menu or the Graphic Control Strip set the text size to 9 points (see “Text Font, Size and Style”
on page 721).

Font 4
: glpoint
v Plain Text %T 10}
Bold %¥B |v 12
Italic 1)
Underline #EU 18
2
Shadowj
Condense 4%
Extended
Up A |
v Left Justify Down ]
Center
Right Other...
Full
Output Pattern...
Build Formula... 3F

With the Pointer tool selected, click the mouse in approximately the location shown below.

My Checkbook:Check (100%) L

1 v 3 4
1llIlllIlllIlllIlllIlllIlllIlllI:‘llIlllIlllIlllIlllllllllllllllllllllllll —
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Now select the Auto Cell Layout command from the Arrange menu (see “Automatically Creating Rows or
Columns of Data Cells or Text Editor SuperObjects” on page 790). You used this command in your My Mail-
ing List database to create data cells, now you’ll use it to create Text Editor SuperObjects (see “Types of Data
Editing Objects” on page 760).

Automatic Cell Layout

( Select All Fields ) ( Line Items) Layout: | | Across || Same Width
Date 1 'Object Height (Lines)
Check —
Pay To 0 Spacing (Pixels)
Category Extras: || Field Names |_! Boxes
Memo
gfeb(;:t SuperObject: ! Create SuperObjects™
Balance Borders: _ Top || Lfeft
__ Bottom __ Right
__!Shadow | | 3D

Formatting: ! Wrap at end of line
__ Non-White Background

Term when: \_/Return \_/Tab
' Up/Down Arrows

( Cancel )( OK )

Start by holding down the Shift key and clicking on each of the first six fields.

Automatic Cell Layout

( Select All Fields ) ( Line |tems) Layout: || Across [ Same Width
Date 1 Object Height (Lines)
Check — . _
Pay To 0 Spacing (Pixels)
Category Extras: || Field Names || Boxes
Memo
gfeb(;tit R SuperObject: ! Create SuperObjects™
Balance Borders: _ Top [ Lgft

__ Bottom __ Right
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Next click on the Create SuperObjects™ and 3D checkboxes.

Automatic Cell Layout

( Select All Fields ) ( Line Items)

Layout: || Across __ Same Width
1 Object Height (Lines)

Date
Check — _ _ |
Pay To 0 Spacing (Pixels)
S Extras: | Field Names [ Boxes |
Memo |
gfebétit SuperObjéct: M Create SuperObjects™
Balance Borders: : op :_
__ Bottom __—Right |
"1 Shad

Formatting: gWrap at end of line
g Non-White Background

Press the OK button to create the Text Editor SuperObjects.

My Checkbook:Check {100%) =
IN lllllllllllllllllllllllllllllllI?lllllllllllllll?lllllllllllllll?llllllll -
= =
= 12728798
= [ — |
= 561=
— Poly Payroll
‘__' Payroll
= 1,74938
5 | ]
o= |
- w
Geneva [ set [w] «Juuf [»]~

Text Editor SuperObjects may be used as an alternative to data cells for editing text within a form. You can
already see one difference between these two types of objects — the Text Editor SuperObject displays data
even in Graphic Design Mode, not the field name. To see the major difference between these two types of
objects switch the form to Data Access Mode (see “Form Modes: Data Access vs. Graphic Design” on
page 613).

My Checkbook:Check

Tl | mm

[12728798
561
Poly Payroll

IPayro Il

1,749.38
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Text Editor SuperObijects allow you to edit text right in the form window—no double click is required. You
can simply click or drag on the text to begin editing. Press Enter when you are finished. The illustration
below shows the effect of double clicking on the word Poly. As you can see, instead of opening an Input Box
this selects the word for editing.

4 [12728798
R 561

Poly Payroll
o [P:Xan
x [

Since the Text Editor SuperObject doesn’t use an Input Box, you cannot expand the size of the editing area
“on-the-fly” the same way you can with data cells. The editing area must be defined in advance. On the other
hand, the Text Editor SuperObject doesn’t require the extra double click, and works more like other standard
applications you may be used to. See “Creating and Modifying Text Editor SuperObjects” on page 767 to
learn more about Text Editor SuperObjects. For now, however, switch the form back to Graphic Design Mode
so that you can continue designing your new form.

Dressing Up the Check Form

Select the Rectangle tool and draw a rectangle next to the check date (see “Creating a Graphic Object” on
page 622).

My Checkbook:Check (100%) B

O
' 1 2 3 4
IN llllllllllllllllllllllllllllllllilllllllllllllllIlllllllllllllllllllllllll
= [ i[12728758
. 561
— Poly Payroll
T [Paserall

Change the Fill Pattern of the rectangle to solid black (see “Fill Pattern” on page 649).

Iill'| »

My Checkbook:Check (100%) =]

O
IN lllllllIlllllll|1lllllllIlllllllIfllllllIlllllllIf’lllllllllllllll‘?llllllll —
1225755
|561
[Poly Payroll
P-J 1 [Paserall

Select the Text tool and create a click-text object that says Date. (see “Fixed Text Objects” on page 715).

O My Checkbook:Check (100%) =

—

llllllllllllllllllllllllllglllllf[llllllllllllll

=
S
11

4
llllllllllllllllllllll

C [12/28798
3 561
- s Poly Payroll
Fj 13 [Pavrall
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Select the Pointer tool and then click on the new text object.

My Checkbook:Check {100%) 8
l lllllllllllllllI1lllllllillllllll?llllllllllllllI?lllllllllllllll?llllllll —
I [ 22555
., = 561
'ch! = Poly Payroll
Baoean

Use the Graphic Control Strip to set the text color to light yellow (see “Color” on page 654).

O My Checkbook:Check {(100%) B
A llllllllllllllll!lllllllllllllll?lllllllllllllll%lllllllllllllll?llllllll :
- (|EEEE
.pate - [S61
- Poly Payroll
|Pawol|
| |1 I..
m
EEE
]
|
m |+
Geneva Spt W < | Il AFZ
Drag the text over the black box.
My Checkbook:Check (100%) s

1 H |Z |3 |4
lllllllllllllllllllllllIlll:lll lllllllllllllll lllllllllllllll lllllllll

mm&eme
S61

Palw Pavrall

lIll'f »

Adjust the black box and the text until they line up with the Text Editor SuperObject as shown below. To
adjust these objects you can drag them (see “Moving a Single Object” on page 636 and “Changing the Size of
a Single Object” on page 641) and nudge them with the arrow keys (see “Nudging an Object (or Objects)” on
page 637 and “Nudging the Size of an Object” on page 641).

— 561

Drag a marquee around these objects to select them (see “Selecting Multiple Objects at Once” on page 630).

ml'__' 12726798
[5et -
[Paly Payroll

a
T
Z]
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Then drag the objects into the upper left hand corner of the form.

My Checkbook:Check (100%) =

—
-

1 2 S 4
llllElllllllllllIlllllllllllllllllllllllllllllllIlllllllllllllllllllllllll

e R

b 2728798 |
561

IPalv Pawrall

Tui[»

Now drag a marquee just around the box and text objects.

My Checkbook:Check (100%) =

2 S 4
111lllllllillllIlllllllllllllllIlllllllllllllllIlllllllllllllllllll lllll

—r

T

o

3]

o

\ —
U

o0
Tui[»

B3

IPalv Pawrall

Hold down the Shift and Option keys on the Mac, or Shift and Alt keys on the PC. With these two keys held
down drag the two objects to the right.

My Checkbook:Check (100%) s
IllIlllIlllIlll|1IllIlllIllléllll|?llIlllIlllIlll|:§llIllllllllllll?llllllll :
k

Holding down the Shift key insures that you drag the objects at 90 degrees, either perfectly up and down or
perfectly left and right (as in this case). Holding down the Option/Alt key tells Panorama to duplicate the
objects. When you release the mouse you’ll have two copies of these objects.

My Checkbook:Check (100%) =
1 2 3 4 a
|l||l||l||l|||l||l||l||l|||l|||l|Illl||l|||l|||l|||l|||l|||l||l||| —
[ Dte [PYZEYCERMN Dote B =

My Checkbook:Check (100%) =]

-

1 : 2 3 4
Ll 111 Ll lllllllllll 1l llllllllllllllllllllIlllllllllllllllllllllllll

[ Date [PFFEYEE !ﬂa&i

= Juf»

Edit the text to say Number instead of Date.

O My Checkbook:Check (100%) =

1 2 3 4
Ll 111 Ll lllllll 111 llillllIlllllllllllllllllllllllllllllllllll lllll

E¥izze5s | Fuumbe

= u[»

Wl
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Select the Pointer tool and adjust the rectangle size to match the new text.

My Checkbook:Check {100%) =

1 2 3 <
llllllllllllllllllllllllllllllllﬁllllllllllllllllllllllllllllllllllllllll

[ Date [FPENER m

lill'| »

|I1| L1,

My Checkbook:Check {100%) =

1 |2 - |3 |4
|l|||l|Illlllllllllllllllllllll |l|i|l|||l|||l| |l|||l|||l|||l| |l|||l|||

[Paly Payroll
[Pavrall

Using the techniques you’ve just learned continue re-arranging the form until it looks like this.

O My Checkbook'Check {100%) =
Ll lll Ll lll lll lll Ll lll lll lllllllllllI?llIllllllllllll?llllllll —
[ Date [PIPEIECRM Murber M Category [ZSEED =

EVREEFPoly Payroll Services n 1,749.38

I
Geneva [ opt |w] <] M [ » |~
Make a copy of the Pay To caption

My Checkbook:Check {100%) =

4
1111 1111111111 111111111111111 11111111111111111111111111111111111111111

| Date [PIFEIECRM Nurber M Category SRR

gow Payroll Services 1,749.38
| ]




Y ST T W Page 161

Change the text to Memo and expand the rectangle to about 1 inch high.

O My Checkbook:Check {100%) =
[ =; IN gllllllllllll11111lllllllllllllll?lllllllllllllll?lllllllllllllll?llllllll =
8| Date [FYPEYEEEM Nurnber E Payroll =
E Poly Payroll Services 1,749.38
...... I
Slide and resize the memo field itself into place.
O My Checkbook:Check {100%) =

1 2 2 4
1111111111111111111111111111111111111111111111111lllnlllnlllnlllnlllnﬂlln

| Date [PIFEIECIM Murber EF Payroll
VAN oy Payroll Services 1,743.38
2

Memo

F
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Text Editor SuperObject
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To add a scroll bar to the memo field double click on the Text Editor SuperObject to open the object properties
dialog. This dialog lets you turn various object options on and off. Click on the Vertical Scroll Bar checkbox.

— Data

@ Field @ () variable () Formula

“Memo
— Display Options — Editing Options
" pPadding Insertion Pt.: | at End 4
™ Wrap at end of line 1Tab = 4 Spaces
™ Non-White Background | | &  Update Variable Bvery Key

croll Bars
" 1 Grow Box

— Borders Terminate when: ™ Return 8 Tab
"1 Top ") Shadow " 1Up/Down Arrows
D Left g cipf e T . e —
_JBottom [JAqua || b e
_JRight [T Focus Ring Auta Caps: (O ()

S 5 | Attach Procedure to Object

( g Vertical |) | Horizontal (

's] [ ..Handler

__Every Key | Most Keys

" I Finished [ _!Focus

( Cancel )( OK )

When you press the OK button the memo field gets a vertical scroll bar.

My Checkhook'Check (100%)

2=

3 L
Ll 111 Ll 111 111 111 Ll 111 111 llllllnllll|llnlllllllnllll|llnlllnl|

| Date [PTFETECIM Nurnber ECEM C

CERLEPoly Payroll Services

1,749.38
.}

Memo
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To actually use the form you must switch into Data Access Mode. Notice that the background of the field
being edited turns white (in this case the memo field).

O My Checkbook:Check

il » | mm

MENLRFP 3 yroll period from 12/14/98 to 12/20/98

NN

515 visible/S15 total | 4 |} [»

Use the Tab key to move from field to field.

(| My Checkbook:Check

[ =4, | Date [PYFEYECRN Murnber EE Jrayroll
& O IR r oy Payroll Services B 17438
MENLEP ayvroll period from 12714798 to 12/20/98 H
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Making the Form Elastic

An ordinary form is fixed — it stays the same no matter what the size of the window is. By adding a single
object to your form you can make it elastic. An elastic form adjusts automatically to fit the window — it
grows when the window grows and shrinks when the window shrinks. Start by switching back to Graphic
Design Mode. Then double click on the memo field to open the object properties dialog.

Text Editor SuperObject

— Data
@ Field ¥B () variable () Formula
IMemo
— Display Options — Editing Options
_l Padding Insertion Pt.: | at End -4
EWrap at ?nd of line ") Tab = 4 Spaces
™ Non-White Background T Update Variable Bvery Key
__ Borders Terminate when: @ Return @ Tab
I Top _ shadow _lUp/Down Arrows
D Left 8 3D = . e
_IBottom [JAqua || e messesees s st e
_JRight [ Focus Ring L —— v
— Scroll Bars | Attach Procedure to Object
W Vertical || Horizontal r ——
— __..Handler
" | Thin Scroll Bars e
gk(;row Box __Every Key _!Most Keys |_!Finished [ Focus
( Cancel ) ( OK >

Turn on the Grow Box option, then press the OK button. The memo field now reserves a spot for the win-
dow’s grow box.

My Checkbook:Check (100%) 08
|l||l||l||l||l||l||l||l||l||l|||l|||l||‘?l|||l|||l|||l||4|'l||l|||A
mufzsfes W =

L] corner reserved
- for grow box
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Using the Rectangle tool draw a box in the spot reserved for the grow box.

JNtMPayroll period from 12/14/98 to 12/20/98 a

Set the Fill Pattern of the new box to solid black (see “Fill Pattern™ on page 649).

[ - s ||

n

Set the color of the new box to the same green color as the background (see “Color” on page 654).

Use the arrow keys to nudge the green box until it covers the white area but leaves the black border.

o . sl

Now to make the form elastic. Start by selecting the Auto Grow tool. (If you can’t find the Auto Grow tool
you need to customize the tool palette. See “Customizing the Tool Palette” on page 625.)

O M’y Checkbook:Check {(100%) =]
IN Wl lll Wl lll lll lll Wl llll;)ll lllIlllIlllIllllllllllllllll?llllllllA
[ Date [PIPEIECRM Murber M Category [ZSEED -

VRN oly Payroll Services n 1,749.38

Payroll period from 12/14/98 to 12/20/92 a
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Starting from the bottom right hand corner of the form, drag the mouse up and to the left. Release the mouse
somewhere between the left edge of the Category field and the right edge of the Pay To field, as shown in the
illustration below. (The blue and green lines in the illustration below have been added to highlight the loca-
tion of these edges.)

My Checkbook:Check (100%) 8
1llIlllIlllIlllHllIlllIlllIlll|?llIlllIlllIlll|?l$§||lllllllllll?llllllll —
[ Date [PIPEIECRM Murber M Category (SRR =

IWECHF oy Payroll Services 1,74938
MNP ayvroll period from 12714798 to 12/ ZOTS

When you release the mouse the Auto Grow configuration dialog appears. The dialog is already filled out for
you except that you need to turn on the Draw Grow Icon checkbox.

Elastic Form Configuration

_Window Size _ Options
— : : : @Master
Minimum Height: 104  Maximum Height: 0 O slave (Horizontal)
Width: | 316 Width: 0 O Slave (Vertical)
_ . = 'tAdj orm
(Match This Object> q g T e
. roc
A ( Cancel ) ( 0K )

Press the OK button to finish creating this object.

My Checkhook'Check {100%) =]

-

2 4
Ll lll Ll lll lll lll Ll lll lll lllllllllllIlllllllllllllllllllllllll

M12f23.f93 W

auto-grow object
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The auto-grow object is covering up some of the memo field. To fix this use the Send To Back command in
the Arrange menu (see “Changing the Stacking Order” on page 697).

O My Checkbook:Check (100%) =
. 1 2 3 <
i llllllllllllllllllllllllllllllllfllllllllllllllllllllllllllllllllllllllll -~
{Im12!28e‘98 3l Cateqory [ENadl =
:: Poly Payroll Services n 1,749.38
NP ayroll period from 12/14/98 to 12/20/98 -
13 = - B
.E j » |}
Tl 3

When you switch the form to Data Access Mode the auto-grow object completely disappears.

O My Checkbook:Check 8

sﬂm w Category [N =

e Poly Payroll Services n 1,749.38 =
MENLEP ayroll period from 12714798 to 12/20/98 a

-]

515 visible/S15 total | 4 Jll) [»]~

But the real fun starts when you adjust the size of the window. The form adjusts automatically to the new
size! See “Elastic Forms” on page 1040 for a complete explanation of how this magic works.

kLY

1

O My Checkbook:Check =
[ Date [PIPEIECRM Murber XM Category (SR

-~

MFoly Payroll Services

MELEP ayroll period from 12714798 t0 12/20/98

1,749.38

- —

515 visible /S15 total

K

g
|

.
w |-

.0
B 01
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To get rid of the extra scroll bars and tool palette choose the Window Tweak command from the Form Tools

submenu of the Wizard menu (see “Turning Window Components On and Off (Window Tweak Wizard)” on
page 331).

O My Checkbook:Check =
[ Date [PIFEIECNM turber EEM Category

R EEFoly Payroll Services n 1,749.38
MNP ayroll period from 12714798 to 12/20/98 a

SIL

In this case you may want to use the tool palette. To get it back uncheck the Tool Palette option in the Window
Tweak window.

® O ) Window Tweak

__ Tool Palette
TweRK Y ¥ Vertical Scroll Bar
¥ Horizontal Scroll Bar

Then press the Tweak button twice. Here’s the final result.

O My Checkbook:Check =]
[ Date [PIFEIECIM Murber SN Payroll
S SIETRENFoly Payroll Services el 1,749.38

Payroll period from 12/14/98 to 12/20/92 a

Oh yeah, one more thing. You have been remembering to Save, right? Well, go for it now, and you’re done.
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Lesson 3: Building an Invoice Database

Now that you’ve mastered basic skills in building databases, forms and procedures you’re ready to tackle a
more complicated task. Organizing invoices (or similar forms like statements, purchases, quotes, expense
reports etc.) is one of the most common jobs performed by database programs. Just as with the other two
databases you’ll start by launching Panorama and the New Database Wizard. Instead of building this data-
base from scratch you’re going to use the pre-built Invoice template in the Template menu.

; Panorama File Editi Wizards

_7 e 6n A
Fields F

Number of Line Item () Fields: £ '

( Irnport Text File... ) ( Make New g

Blank
Ten Generic Fields

Mailing List
Contacts (Basic)
Contacts (Advanced)

Checkbook
Expense Report
Phone Log
To-Do List
Time Card
Time Card 2

Price List
Price List (Discount)

P

g =

_—

L

:.Simple Invoice

invoice database. The name and address are all
2 invoice has four repeating line item fields: Qty,
When the database is generated these will be

tyl, Qty2, Qty3, Item 1, Item2, Item3, ete. You
iterns generated with the box below , the default is

quantity (Qty1, Qty2, Qty3, etc.) a description

%e (Pricel, Price2, etc.). The formulas are set up to
al for each line item (Amount1, Amount2, Amount3
1 grand total. You can enter the shipping manually,

X rate.

|

tabase is very stretched out, so you'll want to make
eqular invoice. For information about how to do this
and Chapter 15 (Displaying and Editing Text) in the

3

b 4

0

.\\_14 R

Parts and Labor Invﬁ!’ce

Product Inventory
Equipment Inventory

Auto Log

Book Collection

CD Collection
Software Collection

Attendance Roster
Test Scores
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When you select this template the wizard will call up a list of definitions for the twenty fields required for an
invoice, including default values and calculations.

e o n New Database Wizard
Fields Notes/Instructions
Mumber of Line Item (€2) Fields: | & | Simple Invoice
Nurn#=+1 A | | This template creates a simple invoice database. The name and address are all O
Date=today 'y | | standard mailing list stuff. The invoice has four repeating line item fields: Qty(y,
Name Itern(}, Price? and Amount). When the database is generated these will be
Company m expanded into multiple fields, Qty1, Qty2, Qty3, Item1, Item2, Item3, etc. You
Address can control the number of line items generated with the box below, the default is
City Six.
State
Zip For each line item you enter a quantity (Qty1, Qty2, Qty3, etc.) a description
Country (ltern1, ltem2, etc.) and a price (Pricel, Price2, etc.). The formulas are set up to
Phone automatically calculate the total for each line item (Amount1, Amount2, Amount3
Memo etc.) and the subtotal, tax, and grand total. You can enter the shipping manually,
Qty® and you can also change the tax rate.
Itern{ -
Priceqy$ 4 | | The data sheet view of this database is very stretched out, so you'll want to make
AmountO$=(Qty I *PriceN)) || a form that looks more like a regular invoice. For information about how to do this 4
I e G A T = LA I ¥ || quickly see Chapter S (Fields) and Chapter 15 (Displaying and Editing Text) in the 3
. Panorama Handbook.

Import T File... M New

( port Text File ) ( ake New Database ) D

By default the wizard will create a database that allows up to six line items per invoice. Let’s increase this to
twelve line items per invoice.

e 6O New Database Wizard
Fields —— Motes / Instructions
- - A
Mumber of Line Item (£2) Fields: Simple Invoice
@ raad 14 ) ; :
Num ®=+1 — 4 || This template creates a simple invoice database. The name and address are all O
Date=today v | | standard mailing list stuff. The invoice has four repeating line item fields: Qty(y,

Press the Make New Database button to actually create the database. The new database has so many fields
that we can only see a small portion of them at once using the data sheet.

®0 6 Untitled |
L | Num Date MNarne Company Address City | State Zip Countr *
vt | RN 05 /27/0¢ | | | ' ' | é
N
A
v

1 visible/1 total

Before going any further you should Save the new database. Give it the name My Invoices and save it in the
same folder as your first two databases. Be sure to check the Save Window Positions option in the Save As
dialog.
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The New Database Wizard invoice template contained 20 fields. However, if you look in the design sheet (use
the View menu) you will see that the database actually contains 64 fields.

806

Untitled:DESIGN

Field Mame Type

L Numeric

Date
MName
Comnpany
Address
City
State

cip
Country
Phone
Memo
Qtyl
Itemi
Price1l
Amount1
Qty2
Itemn2
Price2
Amount2
Qty3
Itemn3
Price3
Armount3
Qty4
Iternd
Priced
Armount4
QtyS

Qty10
Itemn10
Price10
Armount10
Qi1
Itemi1
Pricel1
Armount1 1
Qw12
Item12
Pricel12
Armount12
SubTotal
TaxRate
Tax
Shipping
Total

Date
Text
Text
Text
Text
Text
Text
Text
Text
Text
MNumeric
Text
MNumeric
MNumeric
MNumeric
Text
MNumeric
MNumeric
MNumeric
Text
MNumeric
MNumeric
MNumeric
Text
MNumeric
MNumeric
MNumeric

Nureric
Text

Nureric
Nureric
Nureric
Text

Nureric
Nureric
Nureric
Text

Nureric
Nureric
Nureric
Nureric
Nureric
Nureric
Numeric

Digits Align Output P Input Pattern Range Che Link Clair Tab

0
0
0
0
0
0
0
0
0
0
0
0
0

Float
Float
0
0
Float
Float
0
0
Float
Float
0
0
Float
Float
0

Float
Float

Float
Float

Float
Float
Float
Float
Float
Float
Float

Right
Left
Left
Left
Left
Left
Left
Left
Left
Left
Left
Right
Left
Right
Right
Right
Left
Right
Right
Right
Left
Right
Right
Right
Left
Right
Right
Right

Right
Left

Right
Right
Right
Left

Right
Right
Right
Left

Right
Right
Right
Right
Right
Right
Right

»
’

-

Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any

Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any
Any

Off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
Off

off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off

Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off
Off

off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off

Caps

off
off
Word
Word
Word
Word
all
all
Word
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off

off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off
off

Dup Default Equation

Yes +1

Yes today m
Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes Qty 1 *Price}
Yes

Yes

Yes

Yes Qty 1 *Price}
Yes

Yes

Yes

Yes Qty 1 *Price}
Yes

Yes

Yes

Yes Qty 1 *Price}
Yes

Yes

Yes m
Yes

Yes Qty1APrice)

Yes

Yes

Yes

Yes Qty1APrice)

Yes

Yes

Yes

Yes Qty1APrice)

Yes Armount1+Amount2+Amou
Yes 7.75

Yes TaxRate*SubTotal /100
Yes 5.00

Yes SubTotal+Tax+Shipping

J4 | >

The solution to this is that four of the fields in the template, QtyQ, ItemQ, PriceQ and AmountQ, are actually
a special kind of field called line item fields. The wizard expanded each of these into 12 fields, Qty1, Qty2,
Qty2, etc., Item1, Item2, Item3, etc. This allows the invoice to contain information about up to 12 separate
items. It’s difficult to work with so many fields in the data sheet view, so you’ll create a form that allows you
to display and edit the data in a format that looks like a traditional paper invoice.
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Creating an Invoice Form

You already know how to create a new form, so make one named Order Entry. There’s no need to open itina
separate window, you won’t be needing the data sheet again.

Create New Form

New Form Name: " Insert before:
(Order Entry ’ [ 3]

( Cancel ) ( Blank Form) ( Quick Label ) (Quick Report)
S ——

Using the techniques you’ve learned make the form look like the illustration below. If you need to review
these techniques see “Creating a Data Entry Form” on page 49 and “Drawing a Check Form” on page 149.
You may find it easier to switch the rulers to pixels instead of inches as shown in the illustration below, see
“Rulers” on page 634 to learn how to do this.

rectangle

click text object data cell

/

I -
= My Invoices:Order Entry (100%) ==
el [20 [[40 |60 |20 |100]1 20140 60]1 S0[200]2 20[240[260[280[300[3 20|34 0|36 0|360|400|4 20|44 0|60/ 450/500/5 20[540[560] o

20
40
&0
80
0o
20
40
&0
e0
0o
20

40
BN Geneva pt x0pt wOpt ax0pt ayOpt A 4K »

N
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Adding Line Items to the Form

The heart of the order entry form is the line items. This section of the form will contain 56 objects — 48 data
cells (4 columns by 12 rows) plus 4 text objects and 4 rectangles for column captions. Fortunately the Auto
Cell Layout dialog will create most of these objects for you automatically. You’re going to create the line
items in the blank area to the right of the objects you’ve already created. Start making sure that black is the
currently selected color (see “Color” on page 654), then click the mouse in the upper left hand corner of this
blank area.

2=

O My Invoices:Order Entry (100%)

Invoice ®  Num Date Date
Mame Name

Com pany Com pany

Now choose the Auto Cell Layout command from the Arrange menu. You’ve seen this dialog before. Since
we want to create line items press the Line Items button. This selects all of the line item fields.

Automatic Cell Layout

( Select All Fields ) ( Line Items ) Layout: ™ Across | Same Width
Num |4 1 Object Height (Lines)
Date M S

Name 0 Spacing (Pixels)
Company Extras: M Field Names || Boxes
Address

gtl.?t(e SuperObject: ! Create SuperObjects™
Zip Borders: | ' Top | !Left

Country | Bottom _ Right

Phone ' Shadow __ 3D

Menilo Formatting: ! Wrap at end of line

Qty __ Non-White Background
Iteml

Pricel Term when: 1Return v Tab
Amountl _'Up/Down Arrows

% .

Item2 v ( cancel )( OK )
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You don’t need to change any of the other options, just press the OK button. Panorama will automatically
create all 48 data cells you need in 12 rows by 4 columns.

O My Invoices:Order Entry {(100%) =

Invoice *  Num Date Date
Name Mame .

Compa ompany by N2 ' Armount2
nount3
4| Amountd
)| ArmountS
Country Country 1= Fi Armounts
Phone Phone yjitem ¢ 'rice?) Amount?
ArmountS
Armount?
Armounti
y Arnounti
by ||termn 12 J, Pricel2| Amount1)

Memo
Mermo

Geneva ®0pt ywOpt ax0pt AyOpt

You’ll need to make some adjustments to make the line items look right in your invoice. Start by choosing the
Spacing command in the Edit menu (see “Adjusting Spacing Between Multiple Objects” on page 684).

Adjust Object Spacing

__ Direction

@ vertical O Horizontal

— Space Between Objects

1 pixels
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Click the Vertical option and type in 1 for the pixel spacing. Then press OK to adjust the vertical spacing
between the lines. There is now one pixel in between each line.

O My Invoices:Order Entry (100%) B
x| |20 |40 |60 |20 [100]120]140[160|130|200|220|240[260[280[300[320|340|360|350|4004 20|44 0/460|4 30|500|520/54 0560

Sz-H

k | Invoice *  Num Date Date

Mame MName

IIIL'| »

: a0 Country Country

Phone Phone

00 |
- Py emno ,
| Arount1]
0 1| Amount 1]

60 | Qtyl[tern12 | Price12|Amount1]

Ml =N

Next you’ll want to adjust the width of the columns, starting with the Item column. To adjust the width,
move the mouse over the lower right hand handle of one of the objects in the column, then press and drag to
the right. Hold down the Shift key to make sure that you don’t change the height of the object, only the
width. If you hold down the key (the letter S) you don’t have to exactly press on the handle itself, any-
where close to the bottom right hand corner of the object will do (see “Resizing Without Handles” on
page 644).

O My Invoices:Order Entry (100%) B
20 (40 (60 (20 |100[120]140]160)1 80|200|220/240/260[250[300[3 20[340[360/360/400|4 20|44 0|46 0|380[500/5 20/5 40560

IIIl'| »

Invoice *  MNum Date Date
MName Name
: Com Con y
LA ll40 Address Address 0
‘ ‘ i Amou r|t4:
City |Sta] Zi : e ¥ i n"ﬁl’l'u:-ul'ltfi
Country Country i - T 3
Phone Phone

Memo
M
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When you release the mouse all of the selected objects will adjust to the new width (see “Cluster Resize” on

page 669).
O My Invoices:Order Entry (100%) =
7 FIX I';;'U I4|:l |E-|:| IE:U I1 |:||:||1 '._~;'|:||1 4['[1 f.:»l:||1 E:Ell:;'l:'l:'I:‘_'f‘_'l:ll'::'q|:||:;'6l:'I'.T‘_'E”:ll3|:||:||3';;'l:'[34DIZ-E-|:||33l:'I4|:||:||42':'[44l:|l4f.:»|:||43':"5[:”:'[5:‘_"]'54|:||56C a
Invoice ® Num | Date  Date | [ yer o B B o =

= ? Mame Name
=5 | Company Company
3 |4l:| Address Address

(=)

o City
5 Country Countr
— Phone Phone
B Mo
Ll —on

emo

22U

=

=0

=yl on

=

P
ol

Repeat as necessary until all the widths look the way you want. You can also nudge the widths with the
arrow keys for fine adjustments (after dragging the width, see “Nudging the Size of an Object” on page 641).

Mame Name
Company Company
Address Address

City
Country Country
Phone Phone
Memo
emo

Amount 1:
nount3]

O My Invoices:Order Entry (100%) =
7 FIX I';_'U |4|:| |E-|:| IE?U |1 |:|1:||1 2|:||1 4l:||1 En|:||1 :E:|:||21:|l:||22|:||24|:||';_'E-l:'IZE:':lI-_:'-|:||:||3';_'UI34|:||-_:'-E-l:ll33l:'|4|:|1]‘42|:||441:34En|:||4E:|:||51:|l:152|:||54|:|ISE-I: -
Invoice *  Num Oteidtermy R prs e e =

While holding down the Option key (Macintosh) or Alt key (PC) drag the small purple rectangle next to the

Date cell over the Qty1 text.

— Mame Name

CRRR R

..........

When you release the mouse there will be a new purple rectangle covering the text.

O My Invoices:Order Entry (100%) =
7 FIX I';;'U I4|:| |E-|:| IE:U I1 |:||:||1 '._~;'|:||1 40[1 f.:»|:||1 E:Ell';;'l:'l:'I:‘_':‘_'l:l '._“_'4Eg';;'6l:'I:;'E”:ll3':'|:||3';;'l:'[34|:||3E-|:||3E:l:'I4|:|1:"4'._i'|:||44l:'I4f.:»|:||4E”:llsl:":jfl:‘_'l:lls"-?|:||56C :

O My Invoices:Order Entry (100%)

AP 1 I'Z'l:l [4':' |E-|:| IE”:' [1 |:|l:l|1 2':'11 4l:|[1 E-l:l|1 Eil:llf_"l:ll:llf;'f;'l:l|24|:|I'.-?!':'-l_ll'.-;'izil-ll.-:'-l:ll:l 320[34':1'36':' 35”:'[4':'l:l|4'2|:ll44l:|[4E-|:l|4E:|:l 200 5;7']'54':'156':

....... Date  Date | |
— Mame Name 1‘
-

.............................................

rice2 Amount2
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Adjust this rectangle so that it exactly covers the Qty1 text (see “Nudging the Size of an Object” on page 641).

O My Invoices:Order Entry (100%) i

Invoice ®  Num ! Date Date

Mame Name [ 5 1 v Arnount

Com pany Com pany by .' Sz Price2l Amount2

While holding down the Shift key and the Option key (Mac) or Alt key (PC) drag this rectangle to the right
over the Item1 text.

O My Invoices:Order Entry (100%) B

Invoice * Num | Date Date g
MName Name Qi1 I-+~|[.1'4“ Arounti

Company Company Qty2temn2 Price2l Armount2

Invoice ®  Num ! Date Date
RECARETN

Com pany Com pany

| My Invoices:Order Entry (100%) =]
2280)13001320|1340)1360|320|4001420|440|1450|1420 505] S201540|1560 a '

Invoice *  Num ] Date Date 1
Name Mame Qty1|ltem1 Pricel Arrn:-unt[:}
Company Company by 2lterm2 Price2| Amount2

While holding down the Shift key, click on each of the four purple rectangles you just created. This selects all
four objects (see “Selecting Multiple Objects at Once” on page 630).

hold down SHIFT key and click on each object you want to select

Invoice * Num | Date Date

MName Name [ t eI T F'r'i|::»:-1“ Arru:-untf

Company Company by 2[ltem2 Price2 Amount2

Now choose the Send to Back command from the Arrange menu (see “Changing the Stacking Order” on
page 697).

Arrange

Bring to Front
Send to Back

Group #G6
Ungroup
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Using this command moves the four purple rectangles behind the four text objects, making the text objects

visible again (see “Overlapping Objects” on page 696).

My Invoices:Order Entry (100%)

’ Date

Invoice ¥  Num Date
Mame Name

Com pany Com pany

Qty2/ltem2

1001201401601 20)200|220|240|260|12280)1300|320|240[360

38

T
‘l

Armounti
Amount2

Price2

Because the text objects are black on a purple background they aren’t very easy to see. To change that, start by
clicking on an empty spot on the form. Clicking on an empty spot makes sure that the four purple rectangles

are no longer selected.

Invoice ®  Num ’ Date Date

Mame Name

My Invoices:Order Entry (100%)

HE

click on any empty spot to make sure that no objects are selected

Now hold down the Shift key and click on each of the four text objects. With the four objects selected change
the color to light blue to match the other caption text (see “Color” on page 654).

hold down SHIFT key and click on each object you want to select

20 |40 |60 |20 [100)120)140(160(180)200)220|240|5¢

| g

S

Mum | Date  Date

Mame Name

Invoice *

Address Addres-_-:.

City
Country Country
Phone Phone

Memo

Merno
Qty
Qty1|lterni
Qty1|lteml2

x469pt y3pt AxS0pt ayl2pt

My Invoices:Order Entry (100%)
01320/340/360380[ 40040 44

N

2=

2 "D 420)500|520|540)560

Arnount

Arnount2
Arnount3
Armountd
ArmountS
Amounté
Armount?
Arnounts
Arnount?
Pricel0| Amount10
Pr 1| Amount11
Pricel2| Amountl2

SK

hd R RN
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The text will turn light blue, almost white.

O My Invoices:Order Entry (100%) =

Invoice ® MNum | Date Date [@]itenﬂ ][ F'r'i|::»:-1_][ Ar.'uu:-lJr|t1]

ame MName |:|t_ Iterni Pricel Armounti
Com pany Com pany |:| t W 2lltemn2 Price2 Arnount2

The annoying white border around the text objects is because these are auto-wrap text objects (see “Fixed
Text Objects” on page 715). The border will go away when you switch to Data Access Mode. However, we are
going to convert these objects from Auto Wrap text into Click text. To do this drag the lower right hand han-
dle of the object up over the upper right hand handle (see “Moving and Resizing Fixed Text Objects” on
page 718).

0460420120032

Invoice ¥  MNum Date Date
Marme Name

Invoice MNurn Date Date Qty1|ltem1 Pricel| Amounti

Now select the Text tool and edit the text to remove the 1 from the end of each object.

O My Invoices:Order Entry (100%) =
S| [20 |90 (60 [30 |100]120[140]160)1 30|200[220[240|260280[300[3 20|34 0[360[230|400[4 20[340|460[450[500[6 20| 540560 a

Invoice *  Num Date Date Qty|ltemn F'r'ic:»:-
Armounti %

Marne Narne Qty1|ltern 1 Pricel
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Switch back to the Pointer tool and drag a marquee around all of the line item objects (see “Selecting Multiple

Objects at Once” on page 630). Because of the arrangement of objects in the form it is probably easiest to do
this from the bottom right to the upper left.

O My Invoices:Order Entry (100%) =

P13 20 140 60 120 100120114011 601 201200122 ‘-'-4|:|l‘2f;'.ljllf;':lejll?_'.l:uj 321:|[34|:||?'.F.|‘| 2:::l‘|[4|:u:||4';-_'|:|l44|:|[4f_1.|:||-4:5:|:| S00 5;7_-'|:||5-4|:|155;'.|:

] Qtylitem Armnoun =
: emi Pricel| Amounti
ez Arnount
emn3 Arnount
ermnd Amount

: mS Arnount
20 i JQtyé[ltemé Arount

H - A .1
uugu- 2 H

)

—_~

-

<

)
- |~ =

|

o o ]
.l by
£ |

L)
-~
o
- |~ |=

-

— Itern?
'-'i QtyS/iternd Amount
. B |OtySltems | Priced| Amount

Oty 1|item10 Price10] Amount10

ol *° E Oty 1 fitem11 Amount1 1
&0 Itern12 Price12| Amountl2

Now nudge the objects into alignment with the objects on the left hand side of the form (see “Nudging an
Obiject (or Objects)” on page 637).

O My Invoices:Order Entry (100%) =]
PIX l:"c' |4|:| ]E-':l lE”:' |1 |:||:|I1 2':111 4|:||1 E-|:|I1 E:Dl:"|:||:||:;':;'l:ll':;'4|:'l£""f-|:||:;'E:|:|IS|:“:1 3:;":"341:|ISE-|:1 3E:|:||41:":']42|:|l44|:||4ff-|:|l4:3|:1 S00 52|:|IS4|:115'§-|: A
| Invoice ® Mum | Date Date | | Qtyltem _ |. o Pricel _ Amount =

-2
==
)

dr_m-
-

— MName MName
Company Company
Address Address

City

Country Countr,
Phone Phone

Qi
ty2

. Amounﬂ:

| Price2| AmountZ]
| PriceZ] Amount?]
| Priced| Amountd]
| PriceS| Amounts]
| Price&| Amounté]
| Price?|. Amount7]

¢
U

o - )

(
I‘Dl:. IIDI
vl Ve gl G
AL N

5

T
3
o

— +

==
J

| Memo
ermno

" Amountd)

[, Price 0 Amount1 ]
|._Price1 1] Amount1 1]

1
S !!:
Tzl =

at
o | Yy
31313
e 0

Now you need to create the data cells for the subtotal, tax, shipping and grand total. Start by clicking on an

empty spot on the form (to make sure no objects are selected) and then drag a marquee around the Amount9
through Amount12 data cells.

Qty8|ltemS

Oty 1 Iter 10

Dty 1 Item 1
Oty 1 Item 12
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While holding down the Shift key and the Option key (Mac) or Alt key (PC) drag these four rectangles down
below the other line items (see “Drag Duplicating” on page 689).

em? 'riced  Amountd
y1|ltern10 rice10] Amount10
wl1|ltern11 Fi Arnount1 1
by 1 |ltern12 Pricel2| Armountl2

A Arn‘l‘-'«.'!grnt?.‘;
_Amount1 0]
_ Amount1 1]
| Arnount1 2]

Use the up arrow key to nudge the objects so that they are snuggled up with the Amountl12 cell, then select
the Data Cell tool.

O My Invoices:Order Entry (100%) =
20 |40 |60 120 (100]120)114011601120)200)220|1240|260|280)1300|1320|340|1360)3201400|4 20|44 01460(420|S00)520|1540|560

IIll') »

Invoice *  Num Date Date Qty|ltem rice Amount

Mame Name 1t bern Fi Armounti

. 3 Armount2

Sy | : €3S ess t n3 ' )| Amount3
[i_"!\ . ‘ . ’ < Armountd
& ] City |Sta] Zi It emS ’ AmountS

Countr Y Countr Y Amounté

Phone Phone Amount?

ArmountS

em? ’ 3| Amount?
Qty1|ltem10 Pricel0] Amount10
|:|t'_-,~'1 Iternt i Pricel1| Amounti i
Qty1|lteml2 Pricel12| Amountl2
: Arru:-unt?.{

" Amount 10l

:Arru:-unﬂ 1:

: Arnount1 2:

(OO Geneva Ipt x0pt yOpt AxOpt ayOpt hd RN 4

NK

Move the mouse over the new Amount9 data cell you have created. The mouse arrow will turn into a tiny
menu icon (see “Working with Data Cell Objects” on page 763).

Qty1|ltem1 1 Pricel1]| Amounti1
|:|t'_-,-'1 Item12 Pricel2| Amount12

Armgugtd
Armo ‘ )

Armounti 1
Armountl1 2
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Press the mouse and select SubTotal from the pop-up menu.

Num Item6
O My Invoices:Order Entry (100%) = Date Price6
i 100]120[140[160|120|200|220|240|260|280|300|320|340|360 Name Amounté
Invoice *  Num Qty|ltemn Company Qty7
Mame Mame Address Item?7
Compa City Price?
hddre State Amount?
City Zip Qty8
Country I:h:n;ntr"_-.r COUI’ItI‘Y Item8
Phone Phone Phone Price8
rl11::ll e Memo Amount8
. w1 |+::: 10 Qty1 Qty9
Qtyd ltern 1 1 Item1 Item9
Qty 1 [ltern12 Pricel Price9
Amountli Amount9
Qty2 Qty10
Item2 Iitem10
Price2 Pricel0
Amount2 Amounti0
®0pt ywOpt ax0pt ayOpt Qty3 Qty11 |
Item3 Item11
Price3 Pricell
Amount3 Amountil
Qty4 Qty12
Item4 Iitem12
Price4 Pricel2
Amount4 Amounti2
I SubTotal
Item5S TaxRate
Price5 Tax
Amount5 Shipping
Qty6 Total

When you release the mouse the data cell will be assigned to the SubTotal field.

Qty1|ltemt 1
Qtyl|ltem1 2

Qty1|ltemt 1
Qtyl|ltem1 2

Pricel1

Armounti 1

Amount10
Amounti 1
Amountl 2

Armounti 1

Sh ip p il’lg
Total
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Since you’re pretty much a professional by now you should have no problem finishing up this form so that it
looks like this.

O My Invoices:Order Entry (100%)

20 |40 |60 |20 [100120)140)160120|200)220)240|1260|220|300)320)1340|360|320|40014 20144 0[460|420)500)52(

] > |

Invoice *  Mum l Date Date l | Qty|ltem Price|  Amount]
Nare Mame v 1|lternt Pricel| Amountl |
Company Company Price2 Arru:-unt2|
40 Address Address yw3|ltern3 Price3 An'u:-unt.':'-|
| Qtyd|ltemd Priced| Amountd)

City || QtyS|ltemS PriceS| AmountS)
B Country Country 6 ltemé ricef| Amounté)
| Phone Phone Y7 |ltemnT rice’ f'#rl'xl:lul‘lt_u"|

|

00 |M€'fl'l'3' tem riceS| AmountS)
20 Memo Dty 3|ltem? ¥ ice f"-l'l'u:lul'lt9|
| Qty1Itern 10 Amount10)|
| Oty 1 [ltemn 1 1 Price11| Amount11]
|l:It'_-,.'1 (lterm12 Pricel2| Amounti 2|
| _ Subtotall SubTotall
| Tax Rate| TaxRate Tax T.a:-:|
| Shipping Shipping|

9pt ®0pt wOpt &ax0pt ayOpt 7

Be sure to Save this masterpiece before you go any further.

Entering Data into the Invoice

Before you can enter data into the invoice you must switch to Data Access Mode. You may also want to adjust
the size of the window to match the size of your form.

O My Invoices:Order Entry =
Invoice * | Date \ [ Qtyltem Price|  Amount

Narme
Company
Address

Country
Phone
Memo

Subtota |

Tax Rate[IRESE 7>

Shipping I

Tota I
4

1 visible/1 total [«

As you start typing data you’ll quickly discover a problem. Pressing the Tab key after you enter the name
causes Panorama to tab into the first Qty line item instead of the Company field. Oops!

My Invoices:Order Entry

Invaice * o 1028 /00 Qty|ltem Price] amount|g
VEEN inda Bischoff

Cornpany
Address
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To fix this problem switch back into Graphic Design Mode. While holding down the Shift key click on the
Name, Company, Address, City, State, Zip, Country, Phone and Memo data cells

O My Invoices:Order Entry (100%) ==
4+ s I'}_‘I:l |-‘4l:l |E-I:I IE!IZI |1l:ll:l|1'}_'I:II14|:||1E-;lllE:I:Ilff_'lzlI:||'2f:'l:ll'24I:Ilff_'r':'»lzllZE:EII3I:Il:I132|:||34l:llZE-I:II.E'-E!I:I|-‘4l:ll:l|4'2I:II44|:||4E-l:l|4Ell:lF -
Invoice ¥ Num N Qtylltemn =
el oo | Narme Name A0ty 1|ltern
— MM CompanyTompany  JQty2ltem2
2 |4|:| ddre d Qty3ltern3
CELLH - - |
N Sta QtySfitems
20 0 Qtys|ltems
— Fho Qty7|ltern?
00 " Qty3/lterns i
L] Solakt Qty9literd
) Qty1|ltern10
= Qty1[item1 1 Pricel 1
&0 Qty1]ltern12 Pricel2
— Subtotal b
=0 Tax Rate] TaxRate]  Tax]
p— s 3 ) hd
|:|\l Geneva Ipt x2pt w117pt 4x245pt ay10Spt [ « |1l P |-

Now select the Group command from the Arrange menu.

Bring to Front ¥=
Send to Back 8-
Group #G6
Ungroup

This command combines the nine objects into one combined object (see “Grouping Objects Together” on
page 664). Instead of having handles around each individual object (see illustration above) there are now
only four handles around the four corners of the combined object.

O My Invoices:Order Entry (100%) =]

e 1‘20 |4|:f IE.I:I I:E:D |1|:|1:|I1'2|:|114|:||1E.|:|I1:::l_llzl_ll_llzzl_llz4|_|Ize.|_||z:;:|_|l._7.|:||:|132|:||34|:|I._7.r'_i.|:|13.:5:|:||4|:u:|l4'2|:|l44|:||4»'_:.|:|l4:E:ljls

lill'| »

: Date Dz Otyltem | Price] Amo
2 2 Qty1|lternt rice
OMpa OMpa Qty2|ltemn2
ddre dd Qty3ltem3

Qtyd|lternd

QtyS|itemS

0 Qt'_-,-'6‘|t€'rl'|6
Fhone F Qty7|ltem?
0 Qty3|lterns

Qty9|(ltem

Qtylltern12

Subtotal b

Tax Rate TaxR‘ate

AN | Geneva 9pt tyipt Aax8191pt Ay8191pt W 4l |~
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Now each time you press the Tab key Panorama will advance to the next cell within the group (see “Tab
Order in Forms” on page 798).

My Invoices:Order Entry

PRYEY 10/28/00 Qty|ltem Price|  Amount

REWEN inda Bischoff v

eV 1ark Energy Co *
LU G355 M. Harbor Cir.

Invoice ® 1

IIll'| »

Country
Phone
N ) Memao

0.00
770 0.00

0.00] »

1 visible/1 total

The next tab will bring you to the first line item field. Enter the quantity, item and price.

My Invoices:Order Entry

pPEYCY 10/28/00
REMGN inda Bischoff 12Pencils 0.59 0.00
(B E Ve 1ark Energy Co

PG G w955 N. Harbor Cir.

Invoice ® 1

IIll'| »

resno |ca 93747

When you press the Enter key Panorama will calculate the line item total, subtotal, tax and grand total.

O My Invoices:Order Entry B
d 10/28/00 -
inda Bischoff 12Pencils 7.08

ark Energy Co
55 N. Harbor Cir.

resno | Céa |93?4?

209) 452-1355

7.08
7.79 0.55

7.63
1 visible/1 total [« %

These calculations were set up for you by the New Database Wizard. To learn how to set up or modify these
calculations yourself see “Automatic Calculations” on page 468.
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Lesson 4: Building a Price List

Now that the invoice is complete you will build a price list database and link the price list to the invoice. Start
by launching Panorama and the New Database Wizard. The price list database will have two fields — Item
and Price. (See “Fields on page 375 for a complete explanation of fields.) Type in the name of each field into
the wizard, with each name on a separate line. The Price field will contain money values so it should have a
suffix of $.

e oo New Database Wizard
Fields Notes/Instructions
= A
Number of Line ltem (€2) Fields: | | New Database Wizard
v
Itern A || To create a new database, simply enter the names of the fields you want to create O
Price$ v | | in the box to the left, one field per line. You can start with the blank form shown
here, or start by selecting a pre-built template from Template menu (at the top
m of this window). After the fields names are entered press the Make New
Database button.

When you press the Make New Database button the wizard will create a new database for you. The database
Is displayed using a row and column format called the data sheet. The new database contains one blank
record (line) and two fields (columns).

® 06 Untitled

Item Price

1 visible /1 total

Loading the Data

To use the price list you’ll need to type in a bunch of data. That still doesn’t sound like much fun, so we’ve
created a database that is programmed to automatically fill your new price list database with sample data.
Start by choosing Favorite Databases from the Wizard menu (see “The Favorite Databases Wizard” on
page 237). The database you need is called Sample Price List. To locate it, type sample into the search area at
the top. The wizard will show you a short list of files including the one we want.

e o0 Favorite Databases
@ &' WIName [JFolder (JInfo
Favorites (7 visible! 72 total} info  Location Fields Forms @ Procedures
@J Music Video Samples Folder : Sample Data A
@ Mo Samnle ivolces Crested: Mon, Ot 30, 2000 @ 5:32 AM v
¥ =amp Modified : Thu, Jan 25, 2001 @ 5.09 AM m
6] Sample Alerts Size: 7,940 bytes (65 records) )
A

6] Sample Checkbook
@ Sample Dialogs

v

— Deseription
ij Sample Price List . .
i * This database is part of the Panorama Step-by- *
6] Trigger Samples Step tutorial. After you have created your v

tutorial price list database you can open this

Astshsce Ao sotarnstinzlle £ v Avics Jict
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Double click on the Sample Price List file to open it. A small window will appear briefly. The database has
been pre-programmed to automatically transfer the price list data into the new database you have created.

Untitled

0086

[tem

Hard

. Soft Lead Woot] 1.99

Medium Lead W 1.89

Price

Lead Wooi 1.88

Pencil Cap Eras 0.88
Pink Eraser 0.49
Pink Eraser (La

65

visible /65 total

You may want to adjust the font size and the widths of some of the columns (see “Adjusting Column Widths,

Font and Size” on page 14).

®O0 6 Untitled
I | tem Price 4
Sl Soft Lead Wood Pencils 1.99 z
- | Mediurn Lead Wood Pencils 1.99 mi

< Hard Lead Wood Pencils 1.99

Pencil Cap Erasers 0.89

Pink Eraser 0.49

Pink Eraser (Large) 0.79

Pencil Sharpener 379

y | Drafting Pencil 0.5mm 869

=| Lead Refills 0.Smm 1.09
Drafting Pencil 0.7mm 889
Lead Refills 0. 7mm 109 4

Drafting Pencil Eraser

65 visible /65 total
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Before continuing you should use the Save command in the File menu to save your new creation. The first
time you save any file Panorama will ask you to give it a name. You’ll also want to check the Save Window
Positions option (see “Saving Window Positions” on page 260). When everything is set up press the Save but-
ton. (To see what this dialog looks like on the PC see “Saving Your Work” on page 8.)

select folder you want to save file in , _
type in name of file

A—

Save As\ My Price List B

|
f<|»] E-§| o' "2 Tutorial M

» Network A} Name 4| Dpate Modified
3 Jaguar ¥ a_l My Checkbook Today

=4 Classic @_j My Invoices Today

3 Panther @J My Mailing List 9/25/04

=) Alaska |

|| iSightwWeb ... & t

| CocoaCest... & |

_ '

[@F Desktop "

| 7 Operations
A Applications
& Jimrea

'y Documents
@ Movies

& Music

~ Pictures

wiw Eavnritac

_—

o » E=——

® Panorama ) Text Only () Set

| Automatic save after 20  minutes
| Keep backup copy (.b) of database
" Save window positions __ No windows

\
( New F\glder )

( Cancel )

tell Panorama to save window positions

You may also want to add your new file to the Favorite Database wizard. See “Adding A Database To Your
List Of Favorites” on page 29 for a refresher on how to do this.
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Linking the Price List to the Invoice

The price list is now ready to link to the invoice. The link will be designed to look up a price automatically
when an item is entered into the invoice. Start arranging the invoice and price list windows so that both are
visible, with the invoice window on top (something like the illustration shown below).

O My Invoices:Order Entry =
[ =4+ | Invoice * PRy 10/28/00 Qty[ltem Pricel  Amount

inda Bischoff 12Pencils 0.59 7.08

#5955 M. Harbor Cir.

|ca 93747

Country
IR 209) 452-1355
Memo

7.08
775 0.55
763w
ﬂ Item 1 visible/1 total [« 2
Sehl Soft Lead Wood Pencils =
Mediurmn Lead YWood Pencils 1.99
Hard Lead YWood Pencils 1.99
Pencil Cap Erasers 039
Pink Eraser 0.49
Pink Eraser (Large) 0.79
Pencil Sharpener 3.79
Drafting Pencil 0.Smm 8.69
Lead Refills 0.5mm 1.09
Drafting Pencil 0.7mm 8.69
Lead Refills 0.7mm 1.09 [
Drafting Pencil Eraser 279 |w
65 visible /65 total B Tu]

Using the View menu, switch from the invoice form to the invoice design sheet (see “The Design Sheet” on
page 380).

® O 6 My Invoices:DESIGN

| Field Name Type Digits Align Output|| Dup Defau Equation Read 'Write “Width MNotes r
v

Numeric O Right *, Yes +1 0 0 3
G| Date Date 0  Left Yes today 0 0 & m

1 Mame Text 0 Left Yes 0 0 15

| Company  Text 0 Left Yes 0 0 15

, | Address Text 0 Left Yes 0 0 15

1 City Text 0 Left Yes 0 0 12
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Double click on the Equation cell in the Pricel row.

™ 0O 0O My Invoices:DESIGN
Field Name Type Digits Align Output|| Dup Defau Equation Read Write %idth Notes y
P | Hum Numeric O  Right *, Yes +1 o o0 3 |
Date Date 0 Left Yes today 0 0 [
Name Text 0 Left Yes 0 0 15
Company  Text 0 Left Yes 0 0 15
Address Text 0 Left Yes 0 0 15
City Text 0 Left Yes 0 0 12 m
State Text 0 Left Yes 0 0 4
Zip Text 0 Left Yes 0 0 S
Country Text 0 Left Yes 0 0 10
Phone Text 0 Left Yes 0 0 12
Mermno Text 0 Left Yes 0 0 20
Dty Numeric O  Right *, Yes 0 0 3
Itemn1 Text 0 Left Yes ' 0 0 10
Pricel i i - es
Amountl  MNumeric Float Right #*, *¥|| Yes
Qty2 Nurneric O Right #*, Yes
ltern2 Text 0 Left Yes
Price2 Numeric Float Right #*, #¥|| Yes
Amount2  MNumeric Float Right #*, *¥|| Yes Qty I *Price) 0 0 &
Qty3 Numeric O  Right *, Yes 0 0 3
ltern3 Text 0 Left Yes 0 0 10
Price3 Numeric Float Right #*, #¥|| Yes 0 0 & -
Amount3  MNumeric Float Right #*, *¥|| Yes Qty Y XPrice) 0 0 & .
Qtyd Numeric O Right *, || Yes 0 0 3 v

Now choose lookup(...) from the Functions menu (see “Functions Menu” on page 1319).

Functions

Operators P lower{text)

Advanced P max{inumber,number)

Arrays P min{number,number)

?{cond,truefFormulafalseFormula) Misc 4

abs{(number) pattern{number,pattern)

asc(text) rep{text,hnumber)

chr{number) replace(textoldtexthewtext)

city(zip) replacemultiple{textoldtexthewtextsep)

clipboard() rnd{)

county(zip) round{number,step)

Date & Time P sandwich{pretexttextsuftext)

divzero{(humerator,denominator) search(text,phrasetext)

exportcell{field) seq()

extract{text,separator,jtemnum) sizeof(text)

fieldstyle({fieldname) state(zip)

fix(humber) str(hnumber)

fixed(humber) strip(text)

float(humber) stripchar{text,range)

grabdata(file,field) striptonum(text)

Graphics P striptoalpha(text)

import() sum(lineQ)

Info P uniqueid{field,root)

int(humber) upper(text)

length(text) upperword(text)

listchoices(field,separator) val(text)
zeroblank(number)
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Choosing this menu item opens a dialog for setting up the | ookup( function (see “Linking With Another
Database” on page 1400).

Lookup Function Wizard

| want to retrieve information from the | B
(
database using the . lookup ' # ) function.
The information | want to retrieve is in the | ‘ 9] field of this database.

The information | want to retrieve is in the record where the

field | '#] in the database Untitled

matches the field | ' 9] in the database My Invoices.

( Cancel ) ( OK )

Start by selecting the database you want to look up data from, in this case the My Price List database.

Lookup Function Wizard

| want to retrieve information from the Zipinfo_Zipinfo.com B
. - New Database Wizard
database using the | lookup My Checkbook
My Invoices

field of this database.

The information | want to retrieve is in t
Favorite Databases

The information | want to retrieve is in theW

Now tell Panorama what you want to look up, in this case the Price.

Lookup Function Wizard

| want to retrieve information from the | My Price List '3

database using the | lookup ' #) function.

The information | want to retrieve is in the l ﬂ field of this database.
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We want to look up the price where the Item in the price list matches the Item value in the invoice. So select

Item from My Price List.

The information | want to retrieve is in the record where the

in the database My Price List

') in the database My Invoices.

( Cancel ) ( OK

)

Select Item1 for the last pop-up.

The information | wantl

field [ Item

matches the field

~wvinipany

Address
City
State
Zip
Country

record where the
abase My Price List

in the database My Invoices.

Phone

( Cancel ) ( OK

Memo

)

Qtyl

Pricel
Amountl

Qty2

e cee ™

v
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Here’s the finished dialog with everything filled in.

Lookup Function Wizard

| want to retrieve information from the | My Price List '4)
f
database using the . lookup ' 3] function.
The information | want to retrieve is in the | Price "% field of this database.

The information | want to retrieve is in the record where the

field | Item '#] in the database My Price List

matches the field | lteml "% ] in the database My Invoices.

( Cancel ) ( OK )

Press the OK button to build the formula for looking up the price.

® OO0 My Invoices:DESIGN

Field Name Type Digits Align Output|| Dup Defau Equation Read Write 'Width MNotes |4
Nurn Numneric O Right #*, Yes +1 0 0 3 l
Date Date 0 Left Yes today n} 0 [

Name Text 0 Left Yes 0 0 15

Company  Text 0 Left Yes n} 0 15

Address Text 0 Left Yes 0 0 15

City Text 0 Left Yes n} 0 12 m
State Text 0 Left Yes n} 0 4

cip Text 0 Left Yes n} 0 S

Country Text 0 Left Yes n} 0 10

Phone Text 0 Left Yes 0 0 12

Memo Text 0 Left Yes 0 0 20

Qty1 Nurneric O Right ¥, Yes 0 0 3

Itern1 Text 0 Left Yes 0 0 10

Pricel Numeric Float Right *, *#¥|| Yes lookup( "My Price List","Item" « Itemn1 3 ,"Price"”,0,0)

Amountl  MNumeric Float Right #*, *¥|| Yeg

Qty2 Nurneric O Right ¥, Yes

Itern2 Text 0 Left Yes

Price2 Numeric Float Right #*, #¥|| Yes

Amount2  MNumeric Float Right #*, *¥|| Yes Qty I XPrice) 0 0 &

To learn more about how this formula works see “Linking With Another Database on page 1400. The for-
mula generated by the dialog needs one slight adjustment — | t el must be replaced by | t en?o To type the
%«character use Option-Z on the Macintosh and Alt-0166 on the PC (see “Special Characters” on page 1330
and “Line Item Fields” on page 1326).

Porernew LRT AR - e e - - P

Qty Numeric O Right #*, Yes 0 0 3
Itern1 Text 0 Left Yes 0 0 10
Pricel MNumeric Float Right *, *#¥|| Yes lookup( "My Price List","Item" <« ltern23>,"Price”,0,0)
Amount!  Mumeric Float Right *, *#|| Yes
Qty2 Numeric O Right #*, Yes
ltemn2 Text 0 Left Yes
Price2 MNumeric Float Right *, *#¥|| Yes
Amount2  Mumeric Float Right *, #*¥|| Yeg QtyQY*Price) 0 0 6

Qty3 Nurneric O Right #*, Yes 0 0 3
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Once this adjustment has been made press the Enter key. Panorama will respond with this dialog (see “Mod-
ifying Line Item Fields” on page 393).

Would you like Panorama to apply this change
to every Price field in the design sheet?

G—Veo-; C Yes, and don't ask me again. )

( No ) ( No, and don’t ask me again. )

Press the Yes, and don’t ask me again button. Panorama will update not only the Pricel field definition, but
also Price2, Price3, Price4 etc. You can see this by scrolling down the design sheet. (We’ve split the window
into two panes (see “Splitting a Window” on page 326) and expanded the width of the Equation column to
make this easier to see.)

® OO0 My Invoices:DESIGN
| Field Name Type Digits' Align Output{i Dup Defau Equation Read Write W 4
0| oty Numeric 0  Right #, Yes T M
Wi | Itemni Text 0 Left Yes 0 0
1 Pricel Numeric Float Right #, . ##|| Yes ook Ctemn ™ << lterniy sy, "Price” 0,00 0 0
S| Amount!  Numeric Float Right *, #¥|| Yes Qty QY APrice) 0 0
: Qty2 Numeric O Right #*, Yes 0 0 m
= ltem2 Text 0O Left Yes 0 0
Price2 Mumeric Float Right #* *#*|| Yez (  lookup("My Price List", “"lem" «Item{ys ,"Price”,0,0) ) 0 0
Amount2  Numeric Float Right #*, ##¥|| Yes Vi IRPricel} 0 0
- Qty3 Numeric O Right #*, Yes 0 0
Itemn3 Text 0 Left Yes 0 0
Price3 Mumeric Float Right #* *#*|| Yez (  lookup("My Price List", “"lem" «Item{ys ,"Price”,0,0) ) 0 0
AmountZ  Numeric Float Right #*, #¥|| Yes Vi IRPricel} 0 0
Qtyd Numeric O Right #*, Yes 0 0
Itemn4 Text 0 Left Yes 0 0
Priced Mumeric Float Right #* *#*|| Yez (  lookup("My Price List", "lem" «Item{ys,"Price”,0,0) ) 0 0
Amountd  Numeric Float Right #*, #¥|| Yes Vi IRPFicel] 0 0
QtyS Numeric O Right #*, Yes 0 0
Itemn'S Text 0 Left Yes 0 0
PriceS Mumeric Float Right #* *#*|| Yez (  lookup("My Price List", “"lem" «Item{ys ,"Price”,0,0) ) 0 0
AmountS  Numeric Float Right #*, ##¥|| Yes Vi IRPricel} 0 0
Qtyd Numeric O Right #*, Yes 0 0
Itemns Text 0 Left Yes 0 0 -
Prices Mumeric Float Right #* *#*|| Yez (  lookup("My Price List", “"lem" «Item{ys ,"Price”,0,0) ) 0 0 4
Amounté  Numeric Float Right #, #*#¥|| Yes VIIRPrices} 0 0 v

A

s = PSS () Jale 2

Now click on the Iteml field name (we’ve also unsplit the window and reduced the width of the Equation
column).

® O 6 My Invoices:DESIGN

Field Name Type Digits Align Output F Input Range Choices Link Clai || Dup Defau Equation .
0  Right *, Any off || ves J
0 Left Any off Yes

Pricel Numneric Float Right *, #¥ Any Off || Yes lookup( "My Price List","H

Amountl  Numeric Float Right *, ##¥ Any Off || Yes Qty Y XPrice)

Qty2 Numeric 0 Right #*, Any off Yes m

Itermn2 Text 0 Left Any off Yes

Price2 Numneric Float Right *, #¥ Any Off || Yes lookup( "My Price List","H
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Choose the Set Up Link command from the Special menu (see “Clairvoyance® Across Multiple Files” on
page 451).

Set Up Clairvoyance Link to Separate Field

Choose Database Choose Field
_ChannelLib 4 Jtem
_Databaselib ¥ Price
_DialogAlertLib r
_DiskLib W
_FormLib

_ImportExportLib
_InternetLib
_Menulib

_SpeechlLib

_TextLib

_UtilityLib
_WebContentLib
ZipInfo_ZipInfo.com
New Database Wizard

My Checkbook

My Invoices

My Price List ‘
Favorite Databases A

(Cancel) ( OK )

On the left hand side select My Price List. Then select Item on the right hand side (as shown above).

Press OK to set up the link.

® O 6 My Invoices:DESIGN
Field Name Type Digits Align Output F Input Range Choices Link Clf| Dup Defau Equation n
Qi1 Numeric O Right #*, Any 0f]| Yes ,!
lh Text n} Left Any ( My Price List :ltem) Or| Yes
Pricel Numeric Float Right *, *# Any 0f]| Yes lookup( "My Price List","H
Amount!  Mumeric Float Right *, #*# Any 0f]| Yes Qty QY APrice)
Qty2 Numeric O Right #*, Any 0f]| Yes ml
ltemn2 Text 0 Left Any 0f]| Yes
Price2 Numeric Float Right *, *# Any 0f]| Yes lookup( "My Price List","H
Amount2  Mumeric Float Right *, #*# Any 0f]| Yes Qty QY APrice)
Qty3 Numeric O Right #*, Any 0f]| Yes
ltemn3 Text 0 Left Any 0f]| Yes

The link must be copied to all of the other item fields (Item2, Item3, Item4, etc.) To do this, double click on the
link.

® 0O 0 My Invoices:DESIGN
Field Name Type Digits Align Output F Input Range Choices Link Cl|| Dup Defau Equation

Qiy MNurmeric O Right #*, Any 0fil Yes ,!
Itermn1 Text 0 Left Any My Price List:ltem
Pricel Numeric Float Right *, #*¥ Any
Amountl  Numeric Float Right *, #*¥ Any

Qty2 Nurneric O Right *, Any
tarn? Tawvt n | aft Arnu

lookup( "My Price List","H
QtyQXPrice) m
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When you press the Enter key the link specification will be copied to all of the other Item fields.

®O6 My Invoices:DESIGN
| Field Name Type Digits' Align Output F Input Range Choices Link Cll| Dup Defau Equation 4
o Qi Numeric O Right #*, Any ofl| Yes 4
Itemn1 Text 0 Left Any My Price List:ltem On| Yes
Pricel Numeric Float Right #* *# Any off| Yes lookup( "My Price List","H
S| Amount!  Numeric Float Right *, #*# Any 0ff| Yes Qty I XPricef)
: Qty2 Numeric O Right #*, Any ofl| Yes m
=~ ltem2 Text 0 Left Any (My Price List:ltem) o0f| Yes
Price2 Numeric Float Right #* *# Any off| Yes lookup( "My Price List","H
Amount2  Numeric Float Right *, #*# Any 0ff| Yes Qty I XPricef)
- Oty3 Numeric O Right #*, Any ofl| Yes
Itern3 Text 0 Left Any (My Price List :Item) o0f| Yes
Price3 Numeric Float Right #* *# Any off| Yes lookup( "My Price List","H
Amount?  Numeric Float Right *, #*# Any 0ff| Yes Qty I XPricef)
Qty4 Numeric O Right #*, Any ofl| Yes
Itermnd Text 0 Left Any (My Price List :Item) o0f| Yes
Priced Numeric Float Right #* *# Any off| Yes lookup( "My Price List","H
Amountd  Numeric Float Right *, #*# Any 0ff| Yes Qty I XPricef)
QtyS Numeric O Right #*, Any ofl| Yes
IternS Text 0 Left Any (My Price List :Item) o0f| Yes
' PriceS Numeric Float Right #* *# Any off| Yes lookup( "My Price List","H
AmountS  Numeric Float Right *, #*# Any 0ff| Yes Qty I XPricef)
Qtyé Numeric O Right #*, Any ofl| Yes
Itemné Text 0 Left Any (My Price List :Item) o0f| Yes ‘;
Prices Numeric Float Right #* *# Any ofl| Yes lookup( "My Price List"," =
| Amounté  Numeric Float Right * ## Any 0ff| Yes QtyIXPricef) v
4> () Jal»(|aint & »

Use the View menu to switch back to the Order Entry form. When Panorama asks you if you want to create a
new generation, press the Yes button (see “Database “Generations”” on page 380). Then Save the database
before continuing.

Using the Linked Invoice & Price List

Since you’ve set up a Clairvoyant link between the invoice and the price list you’ll only need to enter the first
few letters of a description.

My Invoices:Order Entry

PN 10728700

inda Bischoff 12| Blue Medium Ball Point Pen
vl 1ark Energy Co

LG w955 N. Harbor Cir.

IIIl') »

resno |ca 93747
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When you press the Enter key Panorama will look up the price from the Price List database. Once the price is
looked up Panorama will then automatically calculate the subtotal, tax and grand total.

O My Invoices:Order Entry s
" d 10/28/00 a
inda Bischoff 12 069 8.28|=

ark Energy Co
55 N. Harbor Cir.

resno |ca 93747

209) 452-1355

8.28
770 0.64

8.92
1 visible/1 total [ « [ »

N

You can enter up to 12 items in each invoice.

O My Invoices:Order Entry s

Invoice * PRYEY 10/28/00 Qty|ltem
REMGN inda Bischoff 12Blue Medium Ball Point Pen 0.69 8.28

vl 1ark Energy Co ZPink Highlighter 1.19 3.57

255 N. Harbor Cir. SMemo Pad 3.39 16.95
12Paper Clips 1.59 19.08
2 2.39 478

|ca 93747

Country
Phone
. Memo

S52.66
770 4.08

56.74
1 visible/1 total [ « [ »

N
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Creating a Procedure to Add an Item

Now you’ll write a very short procedure. Start by clicking on the Price List database.

0 =——MyPricelist=——=—HH
@ Itemn Price |a
s@tll Laser Paper (85 x 11) 22.99
Gtll Laser Paper (8.5 x 14) 26.99
Envelopes (¥10) 4.49
Window Envelopes (¥10) 6.79
Double Window Envelopes 2699 |
Clipboard 1.79 | =
Memo Pad 339
Ly Plastic Paper Clips 1.89
Paper Clips 1.59
Rusber BandBa [P
Thumb Tacks 079 |
Transparent Tape 119 |w
65 visible/65 total 4l 1]~

Use the View menu to create a new procedure named Add Item to Invoice (see “Writing a Procedure from
Scratch” on page 1480). Type in the four lines shown below, exactly as they are shown. (Remember, the Q
character is typed in by pressing Option-Z on the Macintosh or Alt-0166 on the PC. Depending on the fonts
installed on your system the character may not look like Q, but it will work if you press the right keys.)

=— My Price ListAdd tem to Invoice = 1 B

emptyfield "ltemOy" =
Qty=1
Gt Itermn)==grabdata("My Price List","Itemn")

S

Procedure opened. [ 4 |llll| | »

To check your typing use the Check Procedure tool. This tool can spot most typing mistakes (see “Checking
for Mistakes™ on page 1485).

=— MyPrice ListAdd Item to Invoice = F1 &

emptyfield "ltem" =
Qtyi=1
i lterny==grabdata( "My Price List","ltem"j

S

Check Procedure | y IE

Lot

[ »
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Assuming there are no errors use the View menu to switch back to the data sheet. (If there are any errors - fix
them!) Then pick the item you want to add to the invoice and choose Add Item to Invoice from the Action
menu.

é File Edit Yiew Fields Text Search Sort Math Setup FWLE Wizards Help
Add Item to Invoice

My Price List =——HIH
Itern Price |a
o] Invisible Tape 1.89
Bp=d Masking Tape 299
Drafting Tape 1.29
Glue Stick 1.19
2= Glue Pen 2.39
Super Glue 1.79
“White Glue 1.39 [=
Rubber Cernent 369 |=
Postal Scale 19.95
Heavy Duty Letter Folder 19995
Yardstick 219 |
Steel Ruler 299 |w
65 visible /65 total NdJdul D~

The procedure will automatically add the selected item to the invoice.

O My Invoices:Order Entry s
& [ invoice * 1 PELEY 10728700 Qty|ltem Price]  amount)
&9 RENGEN inda Bischoff 12Blue Mediumn Ball Point Pen 069 8.28|=

(B E Ve 1ark Energy Co ZPink Highlighter 1.19 3.57
U (20955 N. Harbor Cir. SMermo Pad 3.39 16.95

12Paper Clips 1.59 19.08
resno |ca 93747 Rubber—Bamd-Ett 9 4.78
Country 1 19.95 19.95

GOELCE 209) 452-1355
T"’1E'r no

Subtotal 7261

Tax Rate Tax m

Shipping
Total 78.24| w

4 J »| 2

1 visible/1 total

To learn more about how this procedure actually works see “Assignment Statements” on page 1496, “Win-
dows” on page 1700 and “Moving Left and Right” on page 1768.

Creating a Price List Form with Buttons

Now you’ll create a price list form with buttons for adding items to the invoice. Start by using the View menu
to create a new form named Add.

[[] = My Price List:Add (100%) =H B

1 2
lllllllllllllll|lllllllllllllll|llllllllllll

Tui|[»
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You’re going to make a View-As-List form (see “View-As-List Forms” on page 1017). To do this start by
selecting the Tile tool. You may need to scroll the tool palette to access this tool (see “Scrolling the Tool Pal-

ette” on page 325).

[0 = My Price List:Add {100%) = HI B

1 2
|llIlllIlllIlllIlllIllllllllllllllllllllllll

Tui[»

N
gl
||
(]
/
L]
%
S

Expand the width of the window slightly, then drag the mouse across the form to create a tile (see “Working
with Tiles” on page 1026).

1llllllllllllll|11llllllllllllll|?llllllllllllll|ll§illll :
E
____________ p
-
=
O]« Jlcf |~
When you release the mouse a new data tile appears.
My Price List:Add (100%) =——HI B
IN lllllllllllllllI]llllllllllllllI?llllllllllllllllllllll —

Illlllllllllllll

—
AN
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Before you continue with the next step you’ll need to customize the tool palette. To do this choose Tool Pal-
ette from the Setup menu and then arrange the tools as shown below (see “Customizing the Tool Palette” on
page 625).

Configure Tool Palette

Tools... _ Current Palette...

&= Switch to Data Mode A ( Basic » ) &= Switch to Data Mode
& Pointer Y & Pointer

i Crosshair Pointer (_ Advanced» ) i Crosshair Pointer
WL Magnify (' Programmer » ) A Magnify

[ged Data Cell o, Text

JE Text ( Reports» ) [ Rectangle

W Line = —= S Tile

Ll Rectangle ( S ) 4 Push Button

L_J Rounded Rectangle gy Text Display
i), Oval ( MoveAll» ) EEText Editor
EETile

& Button ( R )

Press the OK button, then select the Push Button tool (see “Push Buttons” on page 941).

B8

|

[0 = My Price List:Add {100%)

Push Buttonl
EEN_ KD

—
—
—
i

71

w
NE

Now drag to create a button in the upper left hand corner of the data tile.

My Price List:Add (100%) =
llllllllllllélll!llllllllllllll|?llllllllllllll|§llllll —
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Now you’ll need to select three options for the new push button. Using the pop-up menu select the procedure
linked to this button, in this case Add Item to Invoice. (This means that when this button is pressed the Add
Item to Invoice procedure will be triggered, just as if you had selected it from the Action menu.) Type in the
title you want to appear in the button, in this case Add. Click on the button style you want to use, in this case

3D Rounded Rectangle.

Push Button SuperObject

__ Button Title

> oo

_ Style - Color
() Standard Push Button _Title  LJFill
O Transparent " ! Border ! Highlight
O ~ Options
Q ig ;R:?rl:?eded Rectangle) W Standard Font/Size
O Beveled Rectangle =4 DefatiitButton
N~ T 13D Title
O Plain Rectangle ") Hide Title
() Rounded Rectangle M Click /Release

() Plain Circle

— Procedur
" Add Item To Invoice D -4

B ( Cancel ) ( OK )

When you press the OK button the new push button will appear on your form.

[0 == My Price List:Add (100%) =—— =
<1 ll.lll.lll.lll.“l.lll.lll.lll.|?|.I;|.|1|.l||.|§|.I||. —

Illlllllllllllll =

L

Select the Pointer tool and adjust the text size and overall dimensions of the button (see “Text Size” on
page 659).

My Price List:Add (100%) BB
lllllllllllllll|1lllllllllllllll|?llllllllllllll|§llllll —

|
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Now select the Text Editor tool (see “Text Editor SuperObject” on page 767).

[0 =— My Price List:Add (100%) =—— E

1 |2 |3
lllllllllllllll|lllllllllllllll lllllllllllllll el ity

v
SN

S LRASE T )

My Price List:Add (100%) =—— E|

lllllll | lll|1lllllllllllllll|?llllf§lllllllll|§llllll

-’I"“"‘I ---------------- ~ I

When you release the mouse the Text Editor SuperObject configuration dialog appears (see “Text Editor
Options” on page 771). Set the options as shown in the illustration below.

Text Editor SuperObject

— Data
@® Field }B (O variable () Formula

[Item
— Display Options — Editing Options
™ Padding Insertion Pt.: | at End 4
at end of line 1Tab = 4 Spaces
™ Non-White Background 7 Update Variable Bvery Key
_ Borders Terminate whe 8 Tab
" 1Top - Down Arrows
D left (WM3D ) || s - : -
Diieg Pieisd Aepe B
_JBottom [TSAgua || D S mmes—————
_JRight ] Focus Ring LT Gl —— i
_ Scroll Bars | Attach Procedure to Object
" ! Vertical ] Horizontal
= = ( '#] [ ..Handler

"1 Thin Scroll Bars
__ Grow Box __Every Key [_MostKeys [_!Finished [_!Focus
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When you press the OK button the new Text Editor SuperObject will appear.

B8

-~

00 =—— My Price List:Add (100%) =
= 1l|||l|||l|||l|“l.l;l.l;l.lll.|?l|||l|||l|||l||§l||1l|

=
Il?nhhpr Cement -

|lllllllllllllll =

=
|

Select the Pointer tool and adjust the size and position of the new object (see “Nudging the Size of an Object”
on page 641).

|

2=

-~

[0 = My Price List:Add (100%)

1 2 3
lllllllllllllll|lllllllllllllll|lllllllllllllll|lllllll

((Add ][Rubber Cement

Hold down the Option key (Mac) or the Alt key (PC) and drag the Text Editor object to the right (see “Drag
Duplicating” on page 689).

My Price List:Add (100%) =

1
lllllllllllllll|llllllllllllllll?lllllllll"llll e bty

| Add IlRubber Ceni&bber Cement k

Adjust the size of the new object and select the Right command from the Text menu (see “Text Alignment” on
page 722).

|

[0 = My Price List:Add (100%) =]
. 1llllllllllllll|11llllllllllllll|?ll|1lll1llllll|§llllll —

2
([ Add ][Rubber Cement I Rubber

1

Double click on the new text editor object (see “The Object Properties Dialog” on page 662) and change the
field to Price.

Text Editor SuperObject

Data

@ Field Item jable () Formula
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Press OK to update the object.

=——— My Price List:Add (100%) =" 01 B
11 Il | Il | Il | “ | Il | Il | Il | |?l| Il | Il | Il | |?l| Il | :
=
- |
([ Add ][Rubber Cement I 3.69_
NI Dt S
2|

Click in the tiles’ drag bar to select it (see “Working with Tiles” on page 1026).

=——— My Price List:Add {100%) =
lllllllllllllll|1llllllllllllllll?llglllllllllllll?llllll —

((Add ][Rubber Cement )

Use the color menu to change the tile to light gray.

[0 = My Price List:Add (100%) =—=H H
b 11 Il L Il L Il L " L Il L Il L Il L |?l| Il L Il L Il L |§l| Il L :
. =
waed | ((Add ] [Rubber Cement | 369 i
N lfﬁfiE§§§E§E§fﬁf§E§§ﬁE§E§§§E§E§§§E§E§§§E§E§§§E Data iy
N ]
L]
O]
O]
HEC]
= gwNEE I | D7

Drag the lower left hand handle of the tile up until there is an equal margin around the button and text editor
objects.

[0 = My Price List:Add (100%) =]

1 2
lllllllllllllllIlllllllllllllllIllllllllllllllll:‘sllllll —

[E
i 3 Add ] [Rubber Cement

|

S

| »
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The finished form should look something like this.

My Price List:Add (100%) =

Using the Form Preferences dialog in the Setup menu, change the viewing format for the form to View-As-
List.

Form Preferences

() Data Sheet Order
() Back to Front

Press the OK button, then switch back to Data Access Mode.

[0 = My Price List:Add (100%)
t:..{:g Switch to Data Mode
ku

=)=
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Here’s what the form should now look like in Data Access Mode. The graphics on the tile are repeated over
and over again for each record in the database.

[0 ==———MyPrice listAdd=———H E

65 visible /65 total

To add a particular item to the current invoice just click on the Add button for that item.

[0 =——— My Price ListAdd="——=
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Clicking this button will trigger the procedure which adds the item to the invoice.

Invoice

* PRyl 10/28/00

My Invoices:Order Entry

Qty

Item

Price

Amount

(_Add ][Heavy Duty Letter Folder [ 19995

: (_Add J[vardstick [ 219
y | [ Add ] [steel Ruler [ 299
(_Add ][Plastic Ruler [ o079

4

[« ]

65 visible /65 total

Now Save both databases and you are done.

VEGAL inda Bischoff 12Blue Medium Ball Point Pen 0.69
B E W 1ark Energy Co ZFink Highlighter 1.19 .
EGLIEERISS M. Harbor Cir. SMermo Pad 3.39 16.95
12Paper Clips 1.59 19.08
|ca 93747 2Rubber Band Ball 2.329 478
Country 1 19.95 19.95
Phone 1
Memo A
/
7261
775 563
72.24|w
&8 [ Add | [wni 1 visiblesT total »| 2
=R — —
= Add | [Rubber &W | =369
Q Add ||Postal Scale | 1995
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Saving a File Set

Before continuing, make sure that the My Invoice and My Price List files are the only two databases open in
Panorama. Then choose the File Save command from the File menu. Type in the name of the file set you want
to create (in this case Order Entry) and click on the Set option.

Save
Save Am
‘< » ] [=|m! [ Tutorial 4
% Network |4 v—ﬂmt—ﬂﬂ Date Modified i
=) Jaguar Y| | 4] My Checkbook Today
@ Classic i_] My Invoices Today
=4 Panther @J My Mailing List 9/25/04
=) Alaska '@_’ My Price List Today
__liSightWeb ... &
|_| CocoaGest... &
@ Desktop "
|7 Operations
A Applications
& jimrea
'y Documents
& Movies
& Music -
4 Pictures 3

wiw Eavnritac

() Panorama () Text Onl@

__ Automatic save after 20  minutes
__ Keep backup copy (.b) of database
' Save window positions _ No windows

(' New Folder )

AN
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If you are using a Windows PC computer use the combo box to choose the Panorama File Set {*.pnz} option

Y - |

Save in: I {3 Demo Files ﬂ | EFI aac 2
] Action Menu Samples (] Gabreal's Phatos 2 (] Pete's Mexic
|1 Calendar : (] Music Videos (1 Photo Keepr
L_x_l Charts . (] National Parks ] Photo Keep
|1 Custom Menu Editor & (] Nutrition (1 Photos of Jir
| Fresh Fruit £ 0ld Demo Files (1 ProVUE Libr
| Gabreal's Photos (1 Pending Photos (1 PravUE Pro
< | i
File hame: IDrder Entry Save |
Save as type . Panorama Fi Cancel I

7 Automatic save after W minutes

¥ Keep backup [.bak) copy of database

[¥ Save Window Positions ¥ No windows

Press the Save button to create the file set document.

O Gj Step-by-Step 8
Sitems, 204.4 MB available

My Invoices My Mailing List My Price List

NKl

[»

Later if you want to open both the My Invoices and My Price List files together you don’t need to open them
separately. Instead you can simply double click on the Order Entry icon, and Panorama will open both files
automatically. See “File Sets” on page 266 to learn more.
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